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CHAPTER
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Getting Started

with Persuasion

3.0



What's new

in Persuasion 3.0

Persuasion 3.0 is easier to learn and use

ys
Run the online tutorial to view Persuasion’s features and functions in action.

Add text and charts to slides using prompt text and placeholders.

Use icons, buttons, and menus to navigate more quickly between slides and

views.

Find features more easily using the restructured menus.

Use context-sensitive online Help whenever you need more information.

Persuasion 3.0 has been redesigned to make you more productive
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Manipulate text and graphics using floating tools, colors, text, and lines

palettes.

Precisely align objects using ruler guides and nudge controls.

Kern letter pairs automatically.

Edit and customize arrowheads and other endcaps.

Add notes and sketches to Player files during a presentation.

Edit text, graphics, and spreadsheets in your presentations using the

applications they were created in (OLE).

Work with colors in six different color systems (standard (RGB), grayscale,

inverse grayscale, black-and-white, NTSC video, PAL video).

Import color palettes from other presentations.

Choose from a variety professionally-designed AutoTemplates.

Enhance your presentations with selections from over 500 pieces of clip art.



Persuasion 3.0 has powerful charting and table capabilities

e Create and format charts and tables using Aldus Chart and Aldus Table,

and OLE-embed them in Persuasion.

e Present your data in 2d and true 3d charts.

© Get the exact look you want by using 3-axis rotation and movement,

zooming, panning, and perspective control.

© Choose from among approximately 80 chart types and preview the types

before you select one.

e Assign value labels to pie charts.

e Use dashed or dotted lines in line charts.

Persuasion 3.0 turns on-screen presentations into multimedia experiences

© Set timing and transition effects for each layer and slide individually.

e Incorporate sound, animation, and video into your presentations.

e Jump from one slide to another, from one presentation to another, and

even from a presentation to another application.

¢ Apply automatic highlighting and layering to text and organization charts.

e Use the Player to take your multimedia presentations on the road.

Persuasion 3.0 offers a true multiplatform environment

e Transfer presentations and AutoTemplates (including all masters) between

© Move easily between the Macintosh and Windows environments.

| the Macintosh and Windows.
=—"

a
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Before you install

Persuasion 3.0

Before you install Persuasion 3.0:

e Record your serial number and, if

you're installing Persuasion for the

first time, send in your registration

card to take advantage of Aldus’

technical support services and to

receive advance notice about

upgrades.

¢ Turn off virus-protection utilities

and other extensions that can

interfere with installation.

e Make backup copies of your

installation disks. Name each

backup disk the same name as the

original, copying capitalization,

spelling, and spacing exactly.

Where to find your serial number.

If you've purchased Persuasion for

the first time, your serial number is

on the bottom of the Persuasion box

or on installation disk 2. You'll also

find serial number stickers on your

registration card. If you're upgrading

to Persuasion 3.0, your serial number

is the same as it was for the earliest

version you purchased. Persuasion

serial numbers begin with “08.”

How to install Persuasion 3.0.0.0... 8

If you're UPGrading .........eee eeseeeereeees 6
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If your computer is connected to a

local-area network, the ReadMe file

has essential information about

Network Copy Detection (NCD) and

special installation instructions. Do

not attempt to install and use the

program on a network computer

before reading the ReadMe file.

Hardware and software requirements

Component Recommended

~ Computer 68030-based + (Macintosh SE 30 or

higher)

Hard disk requirements approximately 30MB (complete

installation)

| approximately 11MB (basic installation)

’ Disk drives high density

RAM 8MB +

i Operating system System 7*

: Output device driver at least one Chooser driver (for example:

LaserWriter, film recorder)

Other software QuickTime, Adobe Type Manager, or

TrueType fonts

* Persuasion 3.0 runs under System 6 (version 6.0.4 or higher) on computers with at

least SMB of RAM, but OLE, Aldus Chart, and Aldus Table are not supported.

Animation, video, and sound work on all color Quickdraw computers (the Macintosh

SE, Classic, Plus, and Powerbook 100 are not color Quickdraw computers).



To turn off virus protection utilities and extensions

Hold down Shift and restart your

computer.

Note: After installing Persuasion 3.0, Flean0e
restart your computer to turn on virus

protection utilities and extensions.

[--

To make backup copies of your installation disks

4 Insert a blank, high-density disk in

any drive on your computer, and

then choose “Eject Disk” from

the Special menu.

2. Insert a program disk and drag its

disk icon over the icon of the

blank backup disk.

3) Insert disks as requested.

Repeat steps 1 through 3 for each

installation disk.

Note: Since installation disk 2 contains

Network Copy Detection information,

use the original disk, not its backup

copy, when installing Persuasion 3.0.

CHAPTER 1: GETTING STARTED WITH PERSUASION 3.0 5



If you're upgrading

If you're upgrading from an earlier

version of Persuasion, there are some

things to consider before installing

version 3.0.

You'll need a serial number to

install Persuasion 3.0. The serial

number for your new version is the

same as the serial number for the

earliest version you purchased. Look

for the serial number on the bottom

of the box the earliest version of your

software came in. Persuasion serial

numbers begin with “08.”

Before you install Persuasion 3.0 ........... 4

Converting files created in previous

VOTSIONS oo... ccccccesssessessecesecesecseseeeeseceness 10

How to install Persuasion 3.0................. 8

Save Persuasion 3.0 files as

Carlier VEFSIONS .........cccccseeeeeeteeeeeereee 11
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If you frequently use a default

AutoTemplate you designed in an

earlier version of Persuasion, you may

want to continue using it after you

install Persuasion 3.0.

If you keep earlier versions of

Persuasion on your hard disk:

e Keep separate folders for each

version and give them different

names.

e Leave the “Aldus folder” folder in

your System folder because it

contains the default AutoTemplate

and dictionary files that your

earlier version of Persuasion uses.

e Replace the Persuasion 3.0

spelling dictionary with spelling

dictionaries you customized in

earlier versions.

e Save disk space by deleting clip art

and presentations you no longer

need.

If you remove earlier versions of

Persuasion from your hard disk:

e install Persuasion 3.0 before you

remove the earlier version.

¢ Copy to another folder or floppy

disk any AutoTemplates, clip art,

presentations, or customized

spelling dictionaries you want to

keep.

e Discard the Persuasion application

folder for the earlier version.

¢ Discard the “Aldus folder” folder

from the System folder (do not

discard the “Aldus” folder since

other Aldus applications use it).



To use the default AutoTemplate from an earlier version

1

Default AutoTemplatd

Find the file called “Persuasion Prefs” in

the “Aldus folder” folder in the System

folder and rename it “Default

AutoTemplate.”

2

A
An item named “Default AutoTemplate

already exists in this location. Do you

want to replace it with the one you're

moving?

Move the renamed file into the

Persuasion Support folder in the

© Persuasion Support

O Default AutoTemplate .

Open: Original © Copy

In Persuasion 3.0, open “Default

AutoTemplate” to convert it to a

Persuasion 3.0 application folder and, in Persuasion 3.0 AutoTemplate, and

the message box, click “OK” to replace then save it as an AutoTemplate.

the Persuasion 3.0 default AutoTemplate.

Tip: To keep both the earlier and the Persuasion 3.0 default AutoTemplates, name the earlier file something other than

“Default AutoTemplate” before moving it into the Persuasion Support folder in the Persuasion 3.0 application folder.

To replace the Persuasion 3.0 dictionary with an earlier customized one

1

Aldus folder __| [GE Persuasion Support sao

Name Name

D Persuasion 3.0 preferen

7 © Persuasion Dictionaries

D Default AutoTemplate

O Persuasion Help

D engo2.ctx ven

D engi2.c D Engo2 ctx

D eng2s ctx D Engi2.ctx

D Persuasion Help D Eng24 ctx

peBsser] O userd J]

D webster.tex D weosteMex
D Persuasion Prefs is

Gi Bis]

Move the “user1” file from the Persuasion Dictionaries folder

in the “Aldus folder” folder in the System folder into the

Spelling folder inside the Persuasion Support folder in the

Persuasion 3.0 application folder.

2

An item named “user 1” already exists in

this location. Do you want to replace it

with the one you're moving?

In the message box, click “OK.”

CHAPTER 1: GETTING STARTED WITH PERSUASION 3.0 7



How to install

Persuasion 3.0

When you install Persuasion 3.0, you — Persuasion 3.0 installation options

have three options:

e You can have the Aldus Installer/) f f | Option Hard disk requirements. Files Installed
Utili in ne on eetty hing (cor “ ‘ a : Complete approximately 30MB Persuasion 3.0
everything (complete). Player* |

* You can have the Aldus Installer/ Aldus Chart !
ope . . |

Utility automatically install the | Aldus Table

basic things you need to run | all AutoTemplates

Persuasion and create tables and | clip art

charts (basic). ! Tutorial |

¢ You can select which elements ee _. _ _.. Spellingdictionaries =;

you want to install (custom). ' Basic approximately 11MB Persuasion 3.0 |

Player* :

The option you choose depends upon Aldus Chart :

how much hard disk space you have, Aldus Table

and how you intend to use three AutoTemplates
TutorialPersuasion 3.0.

Spelling dictionaries

variable Any combination you check from

the options below the line.

At any time, you can install options Custom

you choose not to install initially. Co :

Double-click the Aldus Installer/Utility *The Aldus tnstaller/Utility installs the Player for the Macintosh. In addition, disk

on installation disk 1, and select the versions of both the Players for the Macintosh and Windows are included with your

options you want. Persuasion 3.0 software.

rc : rr a a an

bea poy te oe boos : ° . Wins

Booval So ea walk oes

Before you install Persuasion 3.0 ........... 4

Decide how new presentations

WII IOOK .....ececscesccessesteceseessesseesseessees 42

If you're UPGradiNg ..........es eeeceeseeeeeeee 6

AutoTemplate Guide
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To install Persuasion 3.0

| Clean Up Window

pe me

shitt

Hold down the shift key and restart

your computer.

=~‘pp‘p. eas|
Basic35

Beach35

Blinds35

Buuk35

Bubbls35

Cnreti3s

Cones35

Diamnd35

| If you've chosen a custom installation,

select the AutoTemplates you want to

install in the 35mm, Screen/Video, and

Overhead “AutoTemplate selection”

dialog boxes.

Please personalize your copy of “Persuasion 3.0”

Name: || |

Company: | |

Serial number: | |

In the personalization dialog box, enter

your name, company name (type at

least a space in these boxes), and your

Persuasion 3.0 serial number (type

dashes but not initial letters), and then

click “OK.”

Aldus Installer /Utility

Insert disk 1 into any floppy drive, and

then double-click the Aldus Installer/

Utility icon.

5

On Screen Size Default .
OQverHeed Size Cefault

oF

In the “Default AutoTemplate Selection”

dialog box, select the medium you want

new presentations to open in by default.

Confirm your personalization information:

Neme: Lauren Epsome UK;

Company: Nimbus [Change|

At the prompt to verify your personal-

ization information, click “Change” to

make corrections, or click “OK” to

continue.

3

Select options to be installed

O Basic

0 Complete

&) Persuasion 3.0

& Cherts 0 Tables

& Tutoriat

& autotemplates

O Clipart

OC) OLE

In the “Select options to be installed”

dialog box, check the installation

option(s) you want, and then click

“Install.”

6

—Hard drive

install in folder:

Aldus Persuasion 3.0

In the “Install Files” dialog box, specify

where you want the Persuasion 3.0 files

installed, and then click “Install.”

Aa Please insert the disk

4

Insert disks as prompted until installa-

tion is complete, and then restart your

computer to turn virus protection

utilities and extensions back on.

CHAPTER 1: GETTING STARTED WITH PERSUASION 3.0 9



Converting files created in

previous versions

In Persuasion 3.0, when you open

presentations and AutoTemplates

created in earlier versions of

Persuasion, you convert them to 3.0

files. A converted file is untitled. Save

it under a new name to keep a copy

of the file in its original version.

If you remove earlier versions of

Persuasion from your hard disk, files

created in these versions will appear

as generic documents. You won't be

able to open them by double-clicking

their icons but you can open them

from within Persuasion 3.0 or by

dragging them onto the Persuasion

3.0 icon.

When you convert a file, most of its

features won't change. For example,

colors and the names of slide masters

stay the same. Charts and tables also

look the same as they did in earlier

versions until you modify them within

Persuasion 3.0.

. Pad

1 ep te Toy SUS WSEAS Te egty Tee

") : ey vod ‘ Pa Woop

vo hes a ae WON ed ee

Adding a chart to your slide...........0... 94

Adding a table to a slide ................... 110

If you're UPQFAadING 0... eee eece eee 6
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When you click a converted table to

modify it:

e The data sheet, which is no longer

necessary, is lost, but the table

data is retained.

e Table appearance may change as

the table converts to Aldus Table

format.

When you click a converted chart to

modify it:

e The chart type, size, and colors

stay the same.

e The data used in the chart

converts to an Aldus Chart data

sheet.

e Overlays convert to the same chart

type as the rest of the chart.

e You may need to reapply or

reformat the chart title and

legends.



Save Persuasion 3.0 files as

earlier versions

You can save Persuasion 3.0 presen-

tations and AutoTemplates so they

can be opened in any earlier version.

Because Persuasion 3.0 includes

features not available in earlier

versions, when you save your files to

an earlier version, these features are

not retained:

° Autojumps, automated high-

lighted layers, animation, and

transition sounds

e Ruler guides and zero point

settings to anything other than

the upper left corner

© Custom line endcaps and hairline

rules

e Auto kerning

© Graduated fills other than top to

bottom, left to right, and radial,

and some patterns

e Title, page numbers, and any slide

thumbnails beyond six on handout

masters

° Text and object shadow offsets

and some text shadow colors and

object shadow patterns and

backgrounds

¢ Custom slide and layer transition

times and custom layer visual

effects

If You're UPGFAdING .........eeeseeeeseeeeeeseee 6

e Chart data sheets and placehold-

ers (charts and tables are con-

verted to PICT graphics)

e Links to the source applications of

OLE-embedded objects

e Color systems other than standard

(RGB). All color systems convert to

standard for display and output.

To save Persuasion 3.0 files as earlier versions:

4. Choose “Save as..." from the File

menu.

2 Inthe dialog box, select the

version of Persuasion in which

you want your file saved in the

“Format” popup menu.

3 Locate the folder or disk where

you want to save your file, select

either “Presentation” or

“AutoTemplate,” type a name for

your file, and click “Save.”

CHAPTER 1: GETTING STARTED WITH PERSUASION 3.0 11
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v Persuasion 2.1

Persuasion 2.0

Persuasion 1.0

Interchange file

@ Presentation

© AutoTemplate
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CHAPTER

2
©)

Three Steps

to Preparing a

Presentation



Three steps to a

presentation

Step @ Choose your final output and design

Decide what your final output will be (for

Click here for title i example, 35mm slides or an on-screen

coe : presentation) and how you want your

presentation to look.

Next, add text and graphics to your slides.

= Commodo consequat Nimbus

= Duis Autem vel céees
| Caeliim aether.

© Caelum Aether

© Iriure doior in hendrerit

= Velit esse consequat

© Dignissim qui praesent

5 | © Reipublicae forma

© Praefectus

© Rector

© Eques

+ Ihre doforin hendrerit

+ Velit esse consequat

* Dighissim qui praesent

Save your work frequently, and when

you've finished your presentation, proof it
Nimbus :

cbse to make sure the content and the design
Caejiim aether,

are accurate.

+ Iriure doljorin hendrerit

+ Velit esse consequat

+ Dignissim qui praesent
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Choose your final output

and design

Your output choices are overheads,

35mm slides, or screen (on a

computer monitor or projector). Your

design choices are unlimited.

Whenever possible, choose your final

output before you design your slides.

Since output determines slide

dimensions, if you design your slides

first and then change your output,

you may have to rearrange your

content to accomodate a larger or

smaller slide size.

By providing you with a variety of

AutoTemplates, Persuasion makes it

easy to choose a design suited to

your final output. Each AutoTemplate

is formatted for a particular output

and comes with design decisions

(such as text formatting and place-

ment) already made.

Design and format with

To choose your final output and design

1

Create presentation

Open presentation... _

Design AutoTemplate ~

Help _| Tutorial

Quit Persuasion

Double-click the Persuasion 3.0 icon,

and then click the “Open presenta-

tion..." button on the Persuasion 3.0

startup screen.

Preview

& Show

Check “Show” to preview the

AutoTemplates, and then click “Open”

to open a copy of the AutoTemplate

you select.

2)
& Autotemplates v

© On Screen/Video

© Overhead

In the open dialog box, locate and

open the AutoTemplates folder in the

Persuasion 3.0 application folder, and

then open the folder for the final

output you want.

If you choose 35mm slides as your

final output, you need to select a film

recorder as the output device in the

Chooser and/or enter custom slide

dimensions in the “Presentation setup”

dialog box.

AULOTEMPIAteS ecsseccpersierevsesecryemeeirees 40

Setting up for 35mm output ............. 204

AutoTemplate Guide
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Enter content

To enter text on a slide

Click the prompt text and type the

title, subtitle, and body text on your

slide.

Note: To turn off prompt text, choose

“Placeholder” from the Show menu,

and then uncheck “Prompt text” and

“Boundaries” in the submenu. Even

when prompt text is visible on your

slides, it doesn’t show up during a

slide show.

To add a new slide

4 Display the slide you want the

new slide to follow.

2 Click the “New slide” button in

the lower-left corner of the

window.

Adding a chart to your slide... 94

Adding a table to a slide

Drawing basics

Enter text in the outline or on slides

Outline your presentation to

SAVEITING?..ssreencrszrsnsevsnernestesnstepesacsorenstn 62
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Tip: The fastest way to enter text is

to use Persuasion’s outline. Text

you type in the outline appears as

title, subtitle, and body text on

your slides formatted as defined on

slide masters. To enter text in the

outline, click the outline icon in the

upper-right corner of the slide.



To put a graphic on your slide

4 2

D Graphic

D Logo

D tabula.ps!Import ——
Graphics...

Text...

Sounds...

Movies...

& Presentations v

O Donatio d

Tip: You can also use Persuasion’s

drawing tools and color palette to

create your own graphics.

Choose “Import” from the File menu,

and then choose “Graphics...” from

& Show preview

In the dialog box, select the graphic you

want to import and click “Import.”

the submenu.

To put a chart on your slide

1

Advolare’

Click the Chart tool in the tool palette,

and then draw a rectangle on your slide

the size you want your chart to be.

(serie | tile +] futose
Show title H

~_| Advolere 1
1338)

Advolare 2 | Advolare 3__

30 a

In the data sheet, enter your data over the sample data, clear

any extra sample data, and then choose “Edit chart” from the

Edit menu.

In the new chart dialog box, click the

chart type you want from the Standard

gallery, and then click “OK.”

In the Aldus Chart window, click the

data sheet button in the control

palette.

Advolare

Choose “Quit and return to untitled Aldus chart...” from the

File menu to exit Aldus Chart, and then click “Update” in the

alert box to view the chart on your Persuasion slide.

CHAPTER 2: THREE STEPS TO PREPARING A PRESENTATION 17



Proof and save

By proofing your presentation, you

can discover errors in spelling,

punctuation, and syntax, organiza-

tion, and design. Persuasion offers

you three ways to proof. Each way

gives you a different perspective on

your presentation.

Checking your spelling

Edit your presentation in the

slide sorter

Outline your presentation

to save time

Preparing your on-screen

presentation

“Save and proof” in Online Help

18 ALDUS PERSUASION 3.0 USER MANUAL

Proof your design and slide order

view

Outline

Slide >

Note >

Slide:sorter

li Presentation « ott =f]

e View thumbnails of your slides.

¢ See both slide content and design.

e Rearrange and delete slides easily.

e Apply different slide masters.

Tip: If you want Persuasion to

remind you to save, choose

“Preferences” from the File menu,

check “Save reminder” in the

“Preferences” dialog box, and

specify the number of minutes

between reminders.



Proof your content and organization

Views

Outline

Slide

Note

Slide sorter

Slide show

Outline

Slide

Note

Slide sorter

Slide show

7 Presentation « Outline Sa

@ Donatio

© Pen

Baetl

nse

Te feugait nulla factitst

Dolore magna aliquam erat

her

Lorem ipsum dolor sit

Elit sed diam nonum

© Tinctdunt ut laoreet

© Caelum

© Quis nostrud exerci

= Commodo consequat

2 Duts autem vel

elimbus.

iriure dolor in hendrertt

© Velit esse consequat

= Dignissim qui praesent

& Reipublicee forma

© Praefectus

© Rector

© Eques

© Opifex

© Operarius

© Curetor

a aes

Nimbus

Caelum aetiier,

Ture dolorin hendrent

Velivtesse consequat

Dignissim) qui praesent

View and edit your presentation text.

Edit and reorganize the content of

your whole presentation or an indi-

vidual slide.

Add or delete slides easily.

View your on-screen presentation as

your audience will.

See animation, autojumps, layering,

movies, sounds, and transition effects

in action.

CHAPTER 2: THREE STEPS TO PREPARING A PRESENTATION 19
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CHAPTER

3
@)

Working on
the Slide Level



Picturing Persuasion

Persuasion presentations are collec-

tions of slides that are viewed as

overheads, 35mm slides, or on-screen

slide shows. Each slide that the

audience sees is actually a composite

of information, not all of which exists

on the slide itself.

For example, you define design and

formatting information on back-

grounds and slide masters rather than

on individual slides. This allows you to

do time-consuming work only once

and then repeat the results through-

out your presentation.

You can enter your presentation

content on slides or in an outline. If

you prefer to work visually, enter your

content on slides where you'll

immediately see how your presenta-

tion will look. If you prefer to focus

first on what you want to say, enter

text into the outline and look at your

slides when you're ready to concen-

trate on design.

Format slide content with

placeholders

Outline your presentation

to save time

Understanding the parts of a slide

Working with slide masters and

aGKGLOUNGSS: isso nce, oxrsroxevsadensecesene 26
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How information gets ona slide

= velit es

© Dignis

© Reipublica

& Practed

@ Slide: Where you enter content and

what your audience actually sees.

© Slide master: Define the formatting

and placement for text and charts that

appear on slides.

Gaejum aetner,

+ inure dolor in hendrent

+ Velitesse: consequat

+ Dignissim gui praese
nt

—

@ Outline: Quickly enter and edit text

that appears on slides.

@ Background: Design backdrops for

your presentation.



Backgrounds and slide masters

Slide masters and slides

—

i lf
This is a Title Placenolde

This is 2 Subtitle Placeholder,

+ This isa text placeholder,
ue reas thefont and style

for each level
“ position the Box:

+ Resize and rep

© Reipublicae fo

© Praefectus|

© Rector

© Eques

is is a text pl
MM Ghange the fc

for each level
*» Resize and

+ Change ta

Gaelum aether,

+ iriure dolor jn hendrent

+ Velitesse consequat

» Dignissim qui praesent

emma

Give your presentation a consistent look

by assigning a background to several slide

masters.

Define once on a slide master how text

and organization charts will be formatted

and assign the slide master to one or

many slides to repeat the formatting

throughout your presentation.

Text you type in the outline takes on the

formatting defined by the slide master

when it appears on your slides.
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From slides to

presentations

When you're entering the content of

your presentation, you work with one

slide at a time. At some point,

however, you'll need to bring all of c = a 72

your slides together to form a —_—— ——— a —a: : —— ——| a
cohesive presentation. Use an —— _——- ———

AutoTemplate to give all of your

slides a consistent look. Use

Persuasion’s slide sorter to view and

work with all or several of your slides

at once.

AutoTemplates are collections of backgrounds and slide masters

Background

Slide master

—_—_—

Nimbus fp)
i Gaelumaether

endrerit+ Sriure dolor in fi

+ Velitesse consequat

+ Dignissin qui praesent

——

Slides reflect the design from the background and the formatting from the slide master.

The slide sorter is Persuasion’s light table

Nimbus

Caelum aether. chee
+ Iriure dolor in hendrerit

* Velit esse consequat

+ Dignissim qui praesent
Design and format with

AutoTemplates

Edit your presentation in the

slide sorter

Understanding the parts of a slide .

Working with slide masters and

backgrounds .

AutoTemplate Guide

Rearrange, copy and paste, or delete slides, and assign slide masters to them.
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Understanding the parts

of a slide

When you open an AutoTemplate

that comes with Persuasion or create

a new presentation, the first thing

you see is a slide. Use the slide’s tools

and menus to add text, graphics,

special effects, and transitions.

Layering slides 156

Picturing Persuasion

Transition effects for slides

and slide layers .......ceeeeeeeeeeeeeeeeeeees 164

Working with slide masters and

backgrounds ........ccececeeeseeeeseeseseseees 26

Anatomy of a slide

Click here tor subtitle

A Identifies what you're seeing on the

screen.

B_ Displays a particular slide, your notes

about a slide, your presentation as an

outline, or miniatures of all of your

slides at once.

C Formats text you type according to

the style defined on the slide master.

D Tools for choosing line thickness and

for choosing and editing endcaps

(display by choosing “Lines” from

the Show menu).

E Tools for moving objects, text, and

shadows incrementally (display by

choosing “Nudge” from the Show

menu).

CHAPTER 3: WORKING ON THE SLIDE LEVEL 25

Popup menu for placing selected

text and graphics on different layers

and assigning transition effects and

sounds.

Lists the slide masters you can assign

to the slide.

Creates a new slide formatted like

the slide displayed.

Displays the next or previous slide.

Tools for adding color and patterns

to text and graphics.

Tools for typing text, drawing graph-

ics, or putting charts or tables on

slides.

Tools for formatting text and con-

trolling alignment and spacing be-

tween paragraphs.



Working with slide masters

and backgrounds

Each presentation you develop can

use multiple slide masters and

backgrounds. The AutoTemplates

that come with Persuasion 3.0 each

have one background and several

slide masters. You can modify the

background or design additional

backgrounds to create several

backdrops within one presentation.

Each slide master in the

AutoTemplates that come with

Persuasion is designed for different

content.

e Use the title slide master, for

example, to create a title slide for

your presentation.

e Assign the text slide master to

slides containing the main body

of text.

e Assign the chart slide master to

slides containing charts.

If none of the slide masters suits your

particular slide content, you can

modify an existing one, create a new

one from scratch, or bring one in

from another presentation or

AutoTemplate.

Creating new slide masters and

backgrounds

Creating tall slides

Design and format with

AutoTemplates

Outline a presentation to save time

Using slide masters from other

presentations
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To display a slide master or background

Choose “Slide master” or “Back-

ground” from the View menu, and

then choose a slide master or Outline
Slide >

background from the submenu. Note > New...

Slide sorter ,

Chart

Tip: To view thumbnails of your slide Slide show r ee
a 

en

masters before youl assign them, Sitde master ptt tite
choose “Gallery...” from the master Background 4

menu at the bottom of the window. Note master
Handout master

Windows >

To assign a new background to a slide master

1 2

Gallery... XEeM

Reapply placeholder...

Reapply master

4 style or each love

wanes Slide master >

How. Background None
sin kind,

v Background

Background 2

Background 3

Display the slide master whose

background you want to change.

Choose the background you want to

assign from the background menu at

the bottom of the window.

Note: The background orientation (tall or wide) controls the orientation of the

slide master. When a new background changes the slide master’s orientation,

the “Adjust graphics” dialog box is displayed so you can move or scale elements

on the slide master to fit the new shape.



To assign a new slide master to a slide

1 2

Gallery... SM

Nimbus

Reapply placeholder...

Reapply master
Calum acther

+ Iniure dolor in hendrent

+ Velit esse consequat d None Tip: To assign a slide master to several

SEDIBDIeH AOL Ereeeent Background > slides at once, work in the outline or
Chart slide sorter where you can select more
Org Chart ‘ ‘

lv Tent than one slide at a time.

Display the slide whose slide master Choose the slide master you want to

you want to change. assign from the middle popup menu at

the bottom of the window.

To rename or removea slide master or background

1 22 3

Background i

Bar Chart Define masters

Org Chart ee

Text Rename: | Background
* Change tabsand indents

+ Slides wi folios

Display a slide master or background, In the “Define masters” dialog box, select. Type a new name or click “Remove,”

and then choose “Define masters...” a slide master or background to rename and then click “OK.”

from the Master menu. or remove.
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Format slide content with

placeholders

You put placeholders on slide masters

to define the position, style, size, and

color of text and organization charts

on your slides. You also use place-

holders to define the position and

size of charts. Placeholders add con-

sistency to your presentation because

text and organization charts format-

ted according to placeholders carry

the same formatting throughout the

presentation and charts appear in the

same location on each slide.

You can put several different

placeholders (such as title, body text,

and chart) on one slide master, but

you can add only one placeholder of

each type. For example, you can add

only one body text placeholder per

slide master. (Each body text place-

holder allows for six heading levels

and each heading can be formatted

independently.)

Page number placeholders can be

added either to slide masters or

backgrounds.

Adding an organization chart ............ 106

Controlling the direction of text flow... 58

Entering text in the outline «00.0.0... 64

Format slide text on the slide master.... 50
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Placeholders on slide masters create formatted prompt text on slides

Placeholder text

——

MG nange the f Nimbus)
for each level
» Resize and

+ Change ta

Gaelumaetner,

. Irure dolor in hendrerit

+ Velitesse consequat

. Dignissim gui praesent

———

Text you type in the outline is formatted and positioned by placeholders on slide

masters and replaces the prompt text on your slides.



To modify a placeholder on a slide master

This is a Subtitle Placeholder.

To reposition a placeholder, select it To resize a placeholder, select it and

and then drag it to a new location. then drag a handle in or out.

To add a placeholder to a slide master

1 2

fidd subtitle

Add body text

Add chart

Choose “Slide master” from the View Choose a placeholder from the Master

menu, and then choose a slide master menu.

from the submenu.

—————_

is is a Title Placeholder.

is a Subtitle Placeholder,

To change a placeholder’s font,

style, shadow, or color, select the

placeholder or the specific text you

want to change, and then select the

options you need from the text and

color palettes.

Tip: Only add placeholders from the

Master menu. If you copy a placeholder

from one slide master and paste it on

another, it becomes a block of

independent text.
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Using slide masters from

other presentations

You may have a slide master or set of

masters in another presentation or

AutoTemplate that would be ideal in

the one you're working on. In this

situation, import the slide masters

instead of creating new ones.

You can replace a presentation’s slide

masters with those from another

presentation or AutoTemplate; or,

you can add one or more slide

masters to the current ones.

When you replace slide masters, only

those with names that match the

imported ones will be replaced. To

preserve a slide master you've

customized, give it a unique name

before you import the new ones.

When you replace a presentation’s

slide masters, you also replace its

color scheme and slide shape (if the

colors and slide shape of the

incoming slide masters differ).

Creating a new color scheme ............ 126
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When you add slide masters with the

same names as your current ones,

Persuasion renames the slide masters

you're adding by including an

extension (such as Text.0). Adding

slide masters doesn’t replace a

presentation’s color scheme or slide

shape. Instead, the added masters’

color scheme approximates their

original color scheme and their slide

shape becomes the slide shape of the

presentation they're added to.

Imported slide masters carry their

backgrounds with them. Give unique

names to backgrounds you want to

preserve before you replace a

presentation’s slide masters.

Bringing in slide masters of a different shape

Adjust graphics [ox }

Page size of slides has changed. > .

Adjust graphics:

A {J Slides DJ Notes DJ Handauts

Options:

© Mowe objects

B @ Scale objects (Scale text sizes -— C

OC Maintain aspect ratio + -_____ p

Check options A, B, C, and D so that background colors, patterns, and graphics will

fit properly in the new slide shape.

To replaceor adda setof slide masters
1

| New »

Add masters...
, Copy colors...

Choose “Change design” from the File

menu, then choose “Replace mas-

ters...” or “Add masters..." from the

submenu.

2

|& Presentations ¥ |

Q Donatio.prf rey

In the dialog box, select the presenta-

tion or AutoTemplate with the slide

masters you want to use, and then click

“Import.”



To add one or several slide masters

1 2 3

View

Outline

Slide >

Note >

Slide sorter

Open the file you want to copy the In the slide sorter, select slides that use Open the presentation you want to add

slide masters from, and then choose the slide masters you want to add, and the slide masters to, choose "Slide

“Slide sorter” from the View menu. then choose “Copy” from the Edit menu. sorter” from the View menu, and then

choose “Paste” from the Edit menu.

Tip: If you scale objects to fit into a

new slide shape, review the scaled

slide masters in actual size to make

sure all objects are correctly placed.

If the slide masters you're bringing in Delete the extra slides you added in (the

are not the same shape as your current slide masters assigned to the slides

ones, use the “Adjust graphics” dialog remain) and assign the current back-

box to move or scale objects to fit into ground to the new slide masters.

the new slide shape.
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Model a slide master after

a slide you like

If you design a slide you particularly

like, you can repeat its design on

other slides by modeling a slide

master after it.

When Persuasion creates a slide

master from a slide, it replicates the

slide’s background fill and pattern on

the slide master. You can select

graphics and independent text from

the slide and copy them onto the

slide master. You can also convert the

placeholder and independent text

from the slide into slide master

placeholders.

Creating new slide masters and

backgrounds ............cceceseeeeseseeeeeeees 34

Working with slide masters and

DACKQIOUNS ascrssieiriceraeesscentneres 26

32 ALDUS PERSUASION 3.0 USER MANUAL

The “Choose master elements” dialog box

Choose master elements

Nimbus

Caolum aether

* Inure dolor in hendrert

* Velifesse consequat

© Dignissim qui praesent

tc [ea Create master from this slide
D OA Slide uses created master

r—E

eee ae
O Subtitle

O Body Text

OSlide #

OStatic

Ignore

q Hide ignored items

no

A The slide you want to model a slide

master after.

B Creates a slide master from the dis-

played slide.

C Lists the slides you can model a slide

master after.

D When checked, the new slide master

is assigned to the listed slide.

Models a placeholder after selected

text.

Shows what status is assigned to

which object.

Hides objects that won't appear on

your new slide master.

Prevents a selected object from ap-

pearing on the new slide master.



To create a slide master from a slide

11

Choose “Slide master” from the View menu, and then choose

"New..." from the submenu. In the “New slide master” dialog

box, name your new slide master, choose the slide master you

want to base it on, and then click “OK.”

rcigrenuasr

O Static

© Ignore

OHide ign

Create master from this slide

® Slide uses created master

In the “Choose master elements” dialog box, select the slide

to model the slide master after, and then click “Create master

from this slide.”

5

© Srure dolor in hendrerit Ke) subtitle
* Velit esse consequat @ Body Text

© Dignissim qui praese O Slide #

OStatic

@ Ignore

O Hide ign

{& Create master from this slide

® Slide uses created master

Select each object you do not want on your slide master, and

click “Ignore.”

Re-create from slide

Choose “Re-create from slide...” from the Master menu.

Choose master elements

Nimbu:

Caelum aether
Olitle

* inure dolor m hendrerit (@} subtitle:

In the preview box, select the text you want for the Title

placeholder, and then click “Title.” Repeat for each place-

holder or object you want to add to your slide master.

gyre

OStatic

O Ignore

& Hide ignored items

Create master from this slide

& Slide uses created master

Use the “Show” buttons and the “Hide ignored items” button

to see how your slide master will look, and when you're

satisfied, click “OK.”
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Creating new slide masters

and backgrounds

To design a new AutoTemplate, or to

customize a presentation (for

example, by making some of your

slides tall rather than wide), you may

need to create new slide masters and

backgrounds. To create new slide

masters or backgrounds, you can

either modify existing ones or create

new ones from scratch.

Modify existing slide masters and

backgrounds by adding text, drawing

or importing graphics, assigning a

different background fill, or adding,

deleting, or editing placeholders. If

you modify the original slide master

or background, you'll also modify all

the slides to which the originals are

assigned. To avoid modifying slides,

make a copy of a slide master or

background before you modify it.

Tip: To easily line up objects on

separate slides in the same position,

drag guides onto a new background

you create. If the guides aren't

visible, choose “Guides” from the

Show menu, and then check "Show

guides” on the submenu.

Creating tall slides ..

Designing new AutoTemplates

Use a layout grid for

Precise aliQnMENt ...........-..-c-recceerereeees 92

Working with slide masters and

backgrounds
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Assigning background fill

Set slide background fill

A—}-£] Use fill from Background

Cc—F7_ Color 1: 6YO

A When checked, the slide master C Applies color to the black part of the

takes its background fill from the pattern.

background. D Applies color to the white part of the
B Applies a solid color or a pattern to pattern.

the background fill.

To create a copy of a slide master or background to modify

1 2
None

Bar Chart

Org Chart

Text
Slide master

1 New...

Choose “Slide master” or “Back- In the “New slide master” or “New

ground” from the View menu, and background” dialog box, choose the

then choose “New...” from the slide master or background you want

submenu. to modify from the “Based on” popup

menu.

3

Type a name for the copy of your slide master or background, and click “OK.”



To create a new slide master

1 2

None

ee a? Add body text
: : Viitte | Rdd chart

Bar Chart

Org Chart

Text Add subtitle

Choose “Slide master” from the View _—__In the “Newslide master” dialog box, Assign a background from the popup ’
menu, and then choose “New...” from name your new slide master, choose menu at the bottom of the slide and

the submenu. “None” or another slide master in the add placeholders from the Master

“Based on” popup menu, and click “OK.” = menu.

To create a new background

Le !

Choose “Background” from the View menu, and then choose

“New...” from the submenu.

Master

Add title

Slide background fill...

Choose “Slide background fill...” from the Master menu,

choose the patterns and colors for your background fill, and

click “OK.”

Name: |(iTe driteltiitemes

Based on: | Background

Orientation: CtTaill © Wide

In the “New background” dialog box, type a name, choose

“None” or an existing background in the "Based on” popup

’ menu, select an orientation, and click “OK."

Add title ]

Choose “Add page number” from the Master menu if you

_ want to number your slides, and then add graphics, text, and

guides to your background.
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Creating tall slides

Although most of the AutoTemplates

that come with Persuasion have a

wide orientation, you can easily

create tall slides in any AutoTemplate.

Tall slides are useful when your

presentation includes information

such as a flow chart that needs to be

displayed vertically or if you need to

reformat your presentation into a

printed report.

You change a slide’s orientation on a

background. Changing the orienta-

tion of a background changes the

orientation of all the slide masters

and slides to which the background is

assigned. When you re-orient a slide

from wide to tall, you may need to

move or scale objects to fit into the

new slide shape.

To avoid changing the orientation of

existing slides, create a new back-

ground and slide master and then

assign them to slides whose orienta-

tion you want to change.

Creating new slide masters and

backgrounds .

Picturing Persuasion

Understanding the parts of a slide .......

Working with slide masters and

Ba CkQrOUnds sscssssdvccattaactiereverscmeensesiss 26
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The orientation of backgrounds determines the orientation of slides

Venturae

* Aura levis

© Secundus adversus

* Procella\crassus:
Nimbus

Caelim aether, CBee
* inure dolorin hendrerit

* Velit esse consequat

ignissim qui praesent

Backgrounds determine the orientation of slide masters and of the slides to which the

slide masters are assigned.

Move or scale objects on slides

Adjust graphics

Adjust graphics:

A—}——— Slides

Options:

B O Move objects

C= @ Scale objects

Page size of slides has changed.

ONotes Onandauts

QO Scale text sizes

O Maintain aspect ratio |. —

A Check options that need adjusting.

B Check to move all objects into the

center of the new slide shape.

C Check to scale objects to fit on the

new slide shape.

D Check to scale text sizes to fit on the

new slide shape.

E Check to scale all objects while

maintaining their original propor-

tions.

Note: If you adjust text and graphics on

many slides, save your file before you

use the “Adjust graphics” dialog box. If

the adjustments don’t work well, you

can return to the saved file by choosing

“Revert” from the File menu.



To create a tall slide

1

Choose “Background” from the View

menu, and then choose “New...” from

the submenu.

None

Bar Chart

Org Chart

Text

Text 2

v Title

In the “New slide master” dialog box,

name the new master, choose the slide

master to base it on from the “Based

on” popup menu, and then click “OK.”

Venturae

+ Auralevis

+ Secundus adversus

+ Procella crassus

DClutes Background2

Based on: | Background

Orientation: @Tall OQ Wide

In the “New background” dialog box,

name the new background, make a

selection from the “Based on” popup

menu, select “Tall,” and then click “OK.”

Slide master >

Tall Background

Choose “Background” from the

background menu at the bottom of the

window, and then choose the name of

the tall background from the submenu.

_ Sutline

Choose “Slide master” from the View

menu, and then choose “New...” from

the submenu.

Adjust graphics:

QSlides [Notes

Options:

O Move objects

@ Scale objects& Scale text sizes

O Maintain aspect ratio

Ohandouts

In the “Adjust graphics” dialog box,

select options for moving or scaling

objects on the slide master to fit the

new tall shape.

Tip: To change the orientation of an existing background from

wide to tall, choose “Background” from the View menu, and

then choose the background you want to change from the

submenu. Choose “Tall orientation” from the Master menu.

Assign the new slide master to existing slides (and adjust your

content accordingly) or to new slides you create.
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Edit your presentation in

the slide sorter

To view all or several of your slides at Slide sorter

‘once, use the slide sorter, Persuasion’s

light table. Seeing your slides side-by- ka S56BE ND BGG SG, S555{EEFB"
side makes it easy to proof the design

and overall content of your presenta-

tion and to rearrange slides.

The slide sorter is also useful when

you want to assign slide masters or

transitions to one or several slides or

when you want to copy and paste

slides from one presentation to

another. Pasted slides take on the

color scheme and slide shape of the

presentation they are pasted into.

A Displays all or several of your slides in Tip: Color slides will display faster in

the slide sorter. the slide sorter if you choose “Color

B_ Smaller magnifications display more System” from the Show menu, and

slides at once. then choose “Black and white.”

To rearrange slides

Creating a new color scheme

From slides to presentations %

Proof ANd SAVE oo... eee eeseeeeseeeseeeeeeeenee

Transition effects for slides and slide Click a slide to select it or select more Drag the slides until the vertical bar is

VAYERS. Seccssccsvaseseseessxscevoneds tontussceeseyseess 164 than one slide by holding down Shift where you want them moved.

Using slide masters from other and then clicking each slide.
PLESEMTALIONS vencccsssccsacarosersecsoennenessones 30
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To assign a slide master or a transition

1

Click a slide to select it or select more

than one slide by holding down Shift

and then clicking each slide.

Gallery...

Reapply placeholder...

Reapply master

Slide master

Background [etesterza

Choose “Slide master” from the master

menu at the bottom of the window, or

choose “First visual effect” or “First

sound effect” from the transition menu

at the bottom of the window.

To copy slides from another presentation

In slide sorter in the source presenta-

tion, select the slides you want to copy,

and then choose “Copy” from the Edit

menu.

In slide sorter in the destination presenta-

tion, select the slide you want the new

slides to follow, and then choose “Paste”

from the Edit menu.

First sound effect

Layer visibility...

Set layer

Blinds left

Choose the slide master or visual or

sound transition you want to assign.

Adjust graphics:

Slides Notes

Options:

O Move objects

@ Scale objects (Scale text sizes

& Maintain aspect ratio

Dhandeuts

If the “Adjust graphics” dialog box

appears because the pasted slide’s

shape changed, select options for

moving or scaling objects on the slide.

Note: If no slide is selected, pasted slides from the source presentation are added
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after the last slide in the destination presentation.



Design and format with

AutoTemplates

An AutoTemplate is a collection of

slide masters and backgrounds that

provides a common design for slides

in a presentation. You can prepare

presentations faster by using

AutoTemplates because you don’t

have to create everything from

scratch.

You have several sources for

AutoTemplates:

e You can save presentations you

like as AutoTemplates.

e You can develop AutoTemplates

from scratch.

e You can install the AutoTemplates

that come with Persuasion 3.0.

e You can convert AutoTemplates

from previous versions of

Persuasion.

You can save any presentation as an

AutoTemplate. (Delete the content

first, if you don’t want to include it in

the AutoTemplate.) AutoTemplates

differ from presentations only in how

they open. When you open an

AutoTemplate, an untitled copy,

rather than the original, is displayed.

Converting files created in previous

versions

Designing new AutoTemplate:

AutoTemplate Guide
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Note: If you didn’t install the

AutoTemplates that come with

Persuasion 3.0 when you installed the

software, you can install them now.

Double-click the Aldus Installer/Utility

on installation disk 1, deselect all

options except “AutoTemplates,” and

then insert disks as prompted.

AutoTemplates are collections of design and formatting decisions

yjaceholder-isa Title P

yale der.hiaceholder. this is a Subtitle Placelo

This is a Title PI ser

a ois 1d style foreachlevel.
range the font an
Sie sition the Box.

7 eholder.

This is. a Subtitle Placenol palate

—

This is a Tit

This is.a Subtitle Plat

This is a Chart

Placeholder.

le Placeholder:

ceholder.

—_
—

This is a title Pla

This is a Subtitle Placolo
eae 1s a Title Placeholder:ceo

subtitle Placeholder,This isaSi

This is a Chart Placeholder.

In AutoTemplates, time-consuming decisions, such as what color scheme and design to

use or how to format text, have already been made.



To open an AutoTemplate

1

& Autotemplates v

D Basic35

O Beach35

D Blinds35

O Book35

O Bubbis35

O Cnfeti35

D Cones35

O Diamnd3s

D Dots35

Open: © Original © Copy

Choose “Open presentation...” from the Persuasion startup

screen or from the File menu.

To save a presentation as an AutoTemplate

1

With the presentation open, choose “Save as...” from the File

menu.

Preview

Show

In the dialog box, check “Show” to preview the

AutoTemplates, locate the AutoTemplate you want, and then

click “Open.”

Save as:

© Presentation
EFormat: [Persuasion 5.0] &aytoremplate

In the dialog box, type a name for the AutoTemplate, select

“AutoTemplate,” and then click “Save.”

Tip: Since the output device selected in the Chooser and the slide shape selected in the “Presentation setup” dialog box

affect the shape of the slides in an AutoTemplate, make appropriate selections before you design your slides.

CHAPTER 3: WORKING ON THE SLIDE LEVEL 41



Decide how new

presentations will look

Each time you choose "Create

presentation” from the Persuasion

startup screen or from the File menu,

you open a copy of “Default

AutoTemplate.” This file provides the

formatting for new presentations you

start from scratch.

During installation, you can decide

whether you want “Default

AutoTemplate” to be sized for 35mm

slides, overheads, or onscreen slide

shows. At any time, you can replace

or modify the “Default

AutoTemplate” file.

Design and format with

AutoTemplates .......0...ccceceseseeeeseseee 40

How to install Persuasion 3.0.0... 8

AutoTemplate Guide
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Persuasion Startup Screen

‘ALDUS. PERSUASION, 3.0

A Opens a copy of “Default

AutoTemplate.”

B Opens an existing presentation or a

copy of an AutoTemplate.

Create presentation

Open presentation...

Design AutoTemplate

Help | Tutorial

aAwaD>

Please reinstall to personalize...

C Opens an untitled AutoTemplate

with only one slide master and one

background. Design a new

AutoTemplate by creating slide

masters and background design.

Tip: If you replace or modify the default AutoTemplate and then decide

you want to use the default AutoTemplate originally installed by

Persuasion, open the AutoTemplate called GradLn35, GradLnOH, or

GradLnSC, depending upon which media you chose as your default.

Then, follow the procedure for replacing the default AutoTemplate.



To replace the default AutoTemplate

1

& Autotemplates ¥

O Beach35

O Blinds35

D Book35

O Bubbis35

D Cnfeti3s

D Cones35

O Diamnd3s

O Dots35

Open: © Original © Copy

Choose “Open presentation...” from

the Persuasion 3.0 startup screen, and

then locate and open the

AutoTemplate you want as your

default.

Save as:

Default AutoTemplate

Format:| Persuasion 3.0 eon
@ AutoTemplate

In the text box, type Default

AutoTemplate, with exactly that

spelling, capitalization, and spacing.

Select the “AutoTemplate” option, and

then click “Save.”

2

Save as:

Fannats [Persuasion 3.0]° Presentation

'@ AutoTemplate

Make any changes you want to the

AutoTemplate’s settings, open the view

(slide, outline, or slide sorter) that you

want the AutoTemplate to open in, and

then choose "Save as...” from the File

menu.

Replace existing “Default

futoTemplate” ?

(cancerJ

In the message box, click “Replace” to

replace the existing “Default

AutoTemplate” file. If you don’t see the

message box, the Default AutoTemplate

won't be replaced.

© Aldus Persuasion 3.0 7

+ Persuasion Player 3.0 le]

O Persuasion Read Me

© Persuasion Support

D Protot.t

| © ProtoPlay!.1

In the list box, double-click your

Persuasion application folder, and then

double-click the “Persuasion Support”

folder.

To modify the default

AutoTemplate choose “Create

presentation...” from the Persuasion

3.0 startup screen, and then follow

Steps 2 through 5 to replace the

original default AutoTemplate with the

modified one.

Tip: To change any colored AutoTemplate to black and white, choose “Color system” from

the Show menu, and then choose “Black and white” from the submenu.
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Designing new

AutoTemplates

You can design an AutoTemplate

either by starting from scratch or by

modifying an existing AutoTemplate

or presentation. If you modify one of

the AutoTemplates that comes with

Persuasion, you can edit its slide

masters and backgrounds, delete

them, or add new ones.

Each type of presentation—

overheads, 35mm slides, or on-screen

slide shows—has a different slide

shape so when you design

AutoTemplates, you need to set them

up for the specific type of output

you'll be producing.

The AutoTemplate you open when

you choose “Design AutoTemplate”

from the startup screen is set up for

overheads. If you change the setup to

be appropriate for either 35mm slides

or on-screen slide shows, you need to

adjust graphics and text to fit onto

the new slide shape.

Creating new slide masters and

Da CKQPOUNOS i scsisceiccsesrisissesescceceues 34

Printing overheads and

support materials ..........ceeeeeeeeees 202

Preparing your on-screen

presentation

Setting up for 35mm output .
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Starting from scratch

Create presentation... 
Lee Z
or

fate... —
— a;

Design futoTe
mp

= id resize 1
= arei follow 8h

When you choose “Design AutoTemplate” from the startup screen, you open a black-

and-white AutoTemplate with one slide master and one background. Add as many slide

masters and backgrounds as you need and name them so they are convenient to use.

Setting up AutoTemplates for specific output

Type of presentation In the Chooser select In the “Presentation

setup” dialog box select

Overheads Printer Overhead

On-screen slide shows = Screen

35mm slides Film recorder or printer 35mm slide or custom

slide dimensions*

* Consult your film recorder documentation or your service provider for the specific

requirements for setting up an AutoTemplate to produce 35mm slides.



To design and set up an AutoTemplate

1

Choose “Design AutoTemplate” from

the Persuasion 3.0 startup screen.

In the “Presentation setup” dialog box,

select a slide shape or select “Custom”

and enter slide dimensions, and then

click “OK.”

2

&

Laser'writer

If necessary, in the Chooser, select the

output device for the final output you'll

produce.

5

Adjust graphics:

QiSlides [Notes O handouts

Options:

OMove objects

@ Scale objects& Scale tent sizes

Oo Maintain aspect ratio

If the “Adjust graphics” dialog box

appears, select options for moving and

scaling objects to fit in the new slide

shape, and then click “OK.”

To modify an existing AutoTemplate

Choose “Open presentation..." from

the Persuasion startup screen, and

then open the AutoTemplate you

want to modify. Add, delete, or edit

the AutoTemplate’s slide masters and

backgrounds and then save the

modified version under a new name.

Be sure to select “AutoTemplate” in

the dialog box.

Save as:

Choose “Page setup...” from the File

menu, and then click “OK.”

Save as"

Donatio

O Presentation
:Format:| Persuasion @ Autotemplate

Design backgrounds and slide masters,

adding placeholders as needed. Choose

“Save as...” from the File menu, and

then in the dialog box, type a name,

choose “AutoTemplate,” and

click “Save.”

{Uentus AT J

O Package movies

Format: |_Persuasion 3.0

(Open in slide show

O Presentatio

@ AutoTemplate
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CHAPTER

©)

Working with

Text



Enter text in the outline or

on slides

With Persuasion 3.0, you can enter

text directly on slides or in the

outline, whichever suits your working

style. Enter text on slides to get a

sense of how much text fits on the

slide and how it works with the other

slide elements. Enter text in the

outline when you want to concen-

trate on content and view the text for

all slides in a presentation at a glance.

On slides, you can enter text by

typing over the placeholder prompt

text or by typing independent text

outside the boundaries of placehold-

ers. After you've typed text into a

placeholder, the placeholder shrinks

or expands to fit the text.

You can also import text from other

applications directly into the outline

or to slides.

Change the indents in a body

text placeholder ic::....is..cs-serspanctieiseen 56

Format slide content with placeholders... 28

Outline your presentation to save time ... 62

“Import text” in Online Help

“Importing text on the slide” in Online Help
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Text you enter in placeholders flows to the outline

4| &[Nimbus
oS

On slides, when you type text into the

placeholder prompt area, your text re-

places the prompt text. The text adopts

the formatting of the placeholder and ap-

pears unformatted in the outline.

Text you enter outside placeholders is independent text

Nimbus

Caelum aether

+ Iriure dolor in hendrerit

+ Velitesse consequat

CONFIDENTIAL

Manipulating text blocks

Nimbus

Caelum aether

+ Iriure dolor in hendrerit

+ Velit esse consequat

CONFIDENTIAL

CONFIDENTIAL

Not all text needs placeholder formatting

nor does it need to flow into the outline.

For example, you might want to add the

word “Confidential” to one slide. Add

this independent text outside text place-

holder boundaries.

Both independent text and placeholder

text are contained in text blocks. You can

move a text block by selecting it with the

pointer tool, and then dragging it to the

desired location. Text blocks are automati-

cally resized vertically to fit the text you

enter.



Working with text placeholders

A The text ruler is displayed whenever

a—_ * “ 12 3 4 5 6 you select the text tool and click an
4 rT L 1 i i ’ . : .

en ee ee ee eS insertion point on the slide.

B Click here for body text B Prompt text shows you where to en-

| ter text within a placeholder. The

text you enter automatically replaces

the prompt text.

How to enter text within a placeholder prompt area

Type text. Click an insertion point within the placeholder and type.

_ Start a new paragraph. Press Return.

| Force a line break. Press Shift + Return. |

‘ Create a new indent. Press Tab at the beginning of a line.

_ Return to a previous indent level. Click an insertion point at the beginning of the line and press Shift + Tab.

Tip: To hide the text ruler, uncheck

“Text ruler” on the Text menu.
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Format slide text on the

slide master

To format text, select either a text

placeholder on the slide master or an

independent text block on a slide,

and then select the options you want

from the text palette.

Formatting options on the text

palette are also available on the Text

menu. For example, you can assign a

precise line-spacing value using the

“Line spacing...” command on the

Text menu.

Tip: To ensure that the audience

can read your slides, set your

type size within the range of

24 to 60 points.

Adding colors and fills ...........ccceeeeees

Changing bullet style ....

Format slide content with

placeholders
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Selecting a font size that your audience can read

Projected font size is relative to the depth of your seating area. One way to achieve the

appropriate projected font size is to set up the last row of the audience no further away

than eight times the height of your projected presentation. Also, the first row should

only be as close as two times the height of the projected presentation.



Use the text palette to format text

com

A The font popup menu.

wo The point size popup menu.

C These nudge buttons increase or

decrease the font point size.

D Type styles. Choose from Plain,

Bold, Italic, Underline, and Shadow.

Apply outline style, superscript, or

subscript from the “Style” submenu

on the Text menu.

E The text-alignment buttons align text

jetF G ! i]

H_ The bullet button shows and hides.

bullets.

The “Apply format” popup menu

lists user-defined formats you can

use to override a placeholder format.

left, right, centered, or justified in rela-

tion to the text-block margins. I

The line spacing buttons determine

where space is increased or decreased

between selected lines.

G These nudge buttons increase or de-

crease the space above and below a

selected paragraph.

Tip: Persuasion converts inch and

foot marks to typographer’s quotes

automatically. To show an inch

mark, choose “Preferences” from

the File menu and then uncheck

“Use typographer’s quotes”

in the “Preferences” dialog box

before you type.
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Changing bullet style

Persuasion adds a bullet to each

indent level in text placeholders, and

to independent text blocks you

create. You can change the character

or color used for bullets in place-

holder text on the slide master. Or,

you can hide the bullets.

Color basics 118

Format slide text on the slide master... 50

Format slide content with placeholders .. 28

“Changing bullet style” in Online Help

“Defining bullets in a body text placeholder”

in Online Help
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The “Define bullets” dialog box

A—r Font: [ Helvetica Cancel

B Color: [7 Accent 2}

G O Apply to all bullets

Bullets:

| tevelt{- | Lever a[-

D Level 2 (EM) Levels

tevel3[- | Levet6 co

A Lists the fonts available for bullets. C Changes bullets at all levels in the

B Opens the working set of the color text placeholder.

palette. D Corresponds to indent levels in the

body text placeholder.

Tip: Select “Key Caps” from the ¢ menu to find symbols and

characters that can be produced using the Shift, Option, and

Command keys. Then, type the desired character in the appropriate

“Level” box in the “Define bullet marks” dialog box.



To change bullet color or symbol

1

Display the slide master, and then

choose "Define bullets...” from the

Master menu.

To hide or remove bullets

a = Caelum nimbus

| Caelum nimbus

To hide bullets on individual slides,

select the text block, and then click the

bullet button on the text palette. This

removes all bullets from the text block.

4 Caelum nimbus

Vv Caelum nimbus

¢ Gaelum nimbus

Select a font and/or color. Enter the

bullet symbol for each level you want to

change.

In the “Define bullets” dialog box, select

the level of text for the bullet you want to

change, or check “Apply to all bullets.”

Tip: If you remove bullets from a text

placeholder using the “Define bullets”

dialog box, return to the slide master to

add them again.
To remove bullets from a body text

placeholder, display the slide master,

and then choose “Define bullets...”

from the Master menu. Select the level

of text from which you want to delete

the bullet, and then press Delete.
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Defining reusable text

formats

Use the Persuasion text formats as a

shortcut for assigning text attributes

to independent text blocks or to

individual words you want to

emphasize with placeholders.

For example, you can create text

formats to override placeholder styles

or to repeat text styles among several

slide masters. Then, you apply the

format by selecting it from the

“Apply format” popup menu on the

text palette.

Text formats are similar to stylesheets

in word-processing programs;

however, changes to them do not

affect text already typed. For

example, if you apply a text format to

a word, and then change the style of

the text format (from bold to italics),

you need to reapply the text format

to the word.
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Use text formats to emphasize words

Apply format —

Rainuhlieas

Body text vitae
Emph

Caelum

+ Iriure cle) |e) cin hendrerit

sse consequat

+ Dignissim ©} Uj praesent

Apply a consistent style to all words you want to emphasize within placeholders by

creating a format named “Emphasis.” Then, apply the Emphasis format on individual

words to override the placeholder style.

Use text formats throughout several slide masters

Repeat a text format throughout several slide masters by applying it to the placeholder

text of each slide master.



To create a text format

1

Prine arma

Choose “Define formats...” from the

Text menu, and then click “New” in

the “Define text formats” dialog box.

To apply a text format

1

Caelum nimbus

Select the text or text block you want to

format.

Tent format

Font: | Helvetica

Size: [12] Color: Tj

Style: (Plain D italic

OBola OD Undertir:

OSubscript LD Superse:

In the "Text format” dialog box, enter

the format attributes, and then click “OK.”

Caelum nimbus

Click the “Apply format” button on the

text palette, and then select the format

you want from the list.

Define text formats

Renam

In the “Define text formats” dialog

box, enter a name for the format, and

then click “OK.”

Tip: If you edit a text format, always

reapply it to your text, Also, if you

change a placeholder format in which

you also have a text format, reapply the

text format after you make changes to

the placeholder.
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Change the indents ina

body text placeholder

Persuasion gives you six indent levels

in the body text placeholder. Each

indent level corresponds to a sub-

ordinate heading in the outline.

When you want to change the indent

space for any of the levels, move the

corresponding marker on the text ruler.

To maintain consistent indent spaces

across many slides, set the body text

indent levels on the slide master. You

can override master settings on

individual slides if necessary.

When you set indent positions, you

are setting the position of the text,

not the position of the bullets. Bullets

always maintain a fixed distance to

the left of text.

Each pair of indent markers (top and

bottom) governs one indent level in

the body text placeholder. When you

drag the top marker, both upper and

lower indent markers move.

“Adjusting indents” in Online Help

“Aligning text and directing text flow” in

Online Help
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indent markers position text in a body text placeholder

; 1 2 3 4." 5 | 6,

pA SS mr

wAether lorem ipsum dolor sit elit sed di

nonum tincidunt ut laoreet

Cc « Pennea

¢ Nimbus iriure

¢ Velit esse rector eque

A Top indent marker

B Bottom indent marker

C_ Indent levels in the body text

placeholder

Tip: Apply paragraph alignment to

your text after changing indents to

maintain readability of your text.



ose

View the text ruler

Set an indent level

Create a hanging indent

Remove an indent marker

With the text tool, select a body text

placeholder. Make sure that “Text ruler”

is checked on the Text menu.

Click the top half of the indent marker,

and then drag it where you want to set

the indent.

Drag the top indent marker to where

you want the first indent line to start.

Drag the bottom indent marker to where

you want the rest of the paragraph to align.

Drag the indent marker to the left

until it covers another one.
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Controlling the direction

of text flow

After you position placeholders, you

may find that when you enter text,

the placeholder expands to accom-

modate the text. The direction in

which the placeholder expands is

determined by how the placeholder is

anchored.

You may need to change the

direction in which the placeholder

expands when you have several

objects in your slide design that

should not overlap. You change the

direction in which the placeholder

expands by changing the anchor of

the placeholder. Placeholders can

be anchored both vertically and

horizontally.

Format slide text on the slide master ...... 50

“Aligning text and directing text flow”

in Online Help

“Placeholder versus independent text”

in Online Help
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Anchor text to avoid overlapping objects

Lorem ipsum dolor sit amet, consectetuer adipiscing

elit, sed diam nonummy nibh euismod tincidunt ut

laéet dolore magna aliquam erat volutpat. Ut wisi

ize, | minim veniam, quis nostrud exerci tation

tien" |Orper suscipit.

If you position a text placeholder above a graphic, anchor the placeholder so that it

expands upward and does not overlap the graphic.

Lorem ipsum dolor sit amet,

consectetuer adipiscing elit,

sed diam nonummy nibh

euismod tincidunt ut laoreet

dolore magna aliquam erat

volutpat. Ut wisi enim ad

|minim veniam, quis nested

exerci tation ullamcog =
suscipit.

Anchoring is independent of paragraph alignment. For example, left-aligned text can be

anchored at the lower-right corner of the placeholder. The text flows up and from the

right corner into a left-aligned position within the text block.



The “Anchor content to placeholder” dialog box

A Anchors the placeholder vertically on
Anchor content to placeholder (oo) the slide using the top, center, or

OTop (Cancet } bottom as the anchor point.

ao | B_ Anchors the placeholder horizontally
<}-Sem [> * @ Center ————_;_A on the slide using the left, right, or

o | center as the anchor point.

. 7 a © Bottom

Oleft @ Center © Right—————_—_}—_ B

To anchor text placeholders

1 2 3

1 maison ——* O Top

Click here for title

Glick here for subtitie | \. Add title O Center
cates *

+ Glick hereifor body text © |

|

|

+ ee @ Bottom

Oleft OCenter @ Right

On the slide master, select the Choose “Anchor placeholder..." from Set both a horizontal and vertical

placeholder with the pointer tool. the Master menu. anchor, and then click “OK.”
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Creating multicolumn text

When you want to create

multicolumn text, you can use Aldus

Table, or you can set up rows and

columns in a body text placeholder.

On the slide master, you use the text

ruler to set tab stops for each

column.

You can set up to 25 tab stops per

line in any text block just as you can

in a word-processing program. Once

you set tab stops on the slide master,

you can enter multicolumn text either

in the outline or on the slide.

Adding a table to a slide

Using tables from other applications ... 112

"Create a table” in Aldus Table

Online Help
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Use the text ruler to set columns

To add, move, or delete tab stops

1

4 1 U 1 2 1 2 it 1 5. 1 6
+¥

i Pennae. 2-3 Dolore magna aliqua Rector

Aether Elit sed diam nonum Eques

Caelum Quis nostrud exerci Opifex Operarius

: Nimbus Duis autem vel Curator

Praefectus Dignissim qui praese Artifex Pedisequus

| Advolare Augue duis dolore Te feugait nulla facilisi

Table columns can be aligned left or to a decimal point.

(ini tehehenthale thal
“y +

With the text tool, select the place-

holder or independent text block in

which you want to create a table.

Select a tab icon, and then drag the

icon on the ruler to set the tab. Or,

drag an existing tab marker into place.

Tip: To remove an unwanted tab, drag the tab marker off the ruler.



Checking your spelling

Use the “Spelling...” command on

the Edit menu to find and correct

misspelled words on slides, in the

outline, or on note pages. (Text

created by Aldus Table or Aldus Chart

is not checked.) Changes made in

one view are reflected in other views.

So, if you spell-check the outline, the

placeholder text on the slides reflects

your changes.

You can add special terms, such as

company names, acronyms, or

professional jargon to a user dictio-

nary so that Persuasion prompts you

for misspellings of these terms also.

Tip: Make a backup copy of the

user dictionary (User1) in the

Spelling folder in the Persuasion

Support folder before you add

words to it. Then, if you enter a

word incorrectly, you can replace

the current dictionary with the

backup copy.

The “Spelling” dialog box

__——==S Nh SSS
A—— Unknown: — Caelum 4—E

B——|— Change to: (Close )-}—F

C——+ Suggestions: [Calm

Claim aa.
Clam

Column D H

p— Search: [Outline [XJ Slides [Notes

@Allslides/notes © Current only

A The misspelled word.

Enter the correct word here.

fa) Lists possible alternatives for

misspelled word.

D Parts of the presentation

to spell check.

E Does not change the word in the

“Change to” box.

F Stops the spell check.

Qa Replaces the misspelling with the

word in the “Change to” box and

continues the spell check.

H_ Displays the dialog box for adding

a word to the user dictionary.

Adding words to the user dictionary

4 Back up the current user

dictionary (User1) in the Spelling

folder in the Aldus Support

folder.

2. Inthe “Spelling” dialog box, click

3 In the “Add word to user

dictionary” dialog box, type the

word, choose the options you

want, and then click “OK.”

Add word to user dictionary (_o«_]

Word: Cancel

Add: © As all lowercase

@ With first letter capitalized

© Exactly as typed
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Outline a presentation to

save time

Working directly on slides lets you see

how text looks with the other slide

elements. But when you want to

enter and revise presentation text

quickly, the outline is the place to

work.

Your slides must have a slide master

assigned that has the appropriate

placeholders before the outline

content will appear on the slides. For

example, if you add subtitles in the

outline, the slide master must contain

a subtitle placeholder.

Adding an organization chart ............ 106

Collapsing and expanding an outline ... 70

Creating speaker notes... 74

{mporting text to the outline... 140
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Rearrange and edit content

quickly. Major text revisions are

quicker and easier to make in the

outline. You can move text around

quickly as you develop ideas. Use

standard Macintosh commands to

cut, copy, paste, insert, and replace.

You can also select text and drag it to

edit your outline.

View only slide titles. You can

collapse part or all of an outline to

view a large number of slides.

Collapsing an outline helps you

organize and edit it because it’s in a

more compact form.

Assign masters and transitions.

Another way to save time is to assign

masters and slide transitions (for on-

screen presentations) directly in the

outline. For example, you can quickly

apply the organization chart master

in the outline as you develop the

chart.

Add speaker notes in the outline.

Notes that you add to the outline do

not appear on the slides, but they can

be printed either with the outline or

on separate note pages.

Import an outline you've already

created. If you already have an

outline in a word-processing file, you

can save it as a text-only (ASCII) file,

and then import and use it in your

Persuasion presentation.

Tip: To use the outline, click the

outline icon in the upper-right

corner of the window, or select

“Outline” from the View menu.



This is a text pi
+ Change the fc

for each level

* Resize and

* Change ta

Nimbus

Gaelum aether.

+ Iriure dolor in hendrerit

+ Velit esse consequat

+ Dignissim qui praesent
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Entering text in the outline

Use the outline to enter text quickly

S—SSE_H_HH_EH_E_-====E=_—==s
SSSSSSSSsSSssSsSsSsaassssSaa

o [Donatio

© PennaeAwD
© Dolore magna aliquam

2 ®S Caelum

D Quis nostrud exerci

= Commodo consequat

© Duis autem vel

E=—3 ®S Reipublicae forma

> Praefectus

> Rector

F &) Eques

© Opifex

© Operarius

®S Curator

> Artifex

Nesting slides under an overview slide ...68

Picturing Persuasion 0.0... 22

“Import text” in Online Help

“Outline menu” in Online Help
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® Te feugait nulla facilisi ;

Slide divider icon. Type the presen-

tation title or section name here, or

use it for notes or comments. Slide

divider text does not appear on

slides or on note pages.

Slide title icon. Each slide title indi-

cates a new slide.

Slide subtitle icon.

Body text icon.

The slide number reflects the order

of the slide in the presentation.

Nested slides.



How to work in the outline

To...

View the outline.

Enter subordinate text after the slide title.

Create a new line at the same heading level.

Demote an empty line one heading lower (move right).

Promote an empty line one heading higher (move left).

Insert a line break wthin a paragraph.

Delete a heading with an insertion point anywhere in it.

Demote (move right) a heading with the insertion point

anywhere in it.

Promote (move left) a heading with the insertion point

anywhere in it.

Automatically add subtitles to all slides.

Add subtitles to individual slides.

View your slides.

Viewa slide.

View your notes page.

Choose “Subtitle.”

os - ee _ a

Do this...

Click the outline icon in the upper-right corner of the window.

Press Tab at the start of the line, and then type the text.

Press Return.

Press Tab. |

Press Delete or Shift + Tab. | oo |

Press Shift + Return. |
Press Command + X.

Press Command + Tab.

Press Command + Delete.

Choose “Auto subtitles” from the Outline menu. !
(The assigned slide master must contain a subtitle placeholder.) |
Then, press Return + Tab after a slide title. (Previously typed

entries are not affected.)

Click an insertion point at the end of the slide title. Press Return

and then choose "Set heading as” from the Outline menu.

Click the slide sorter icon in the upper-right corner of the window.

Click on a number for that slide along the left margin of the outline. |

Hold down Option and click on the slide number.
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Rearrange information in

the outline

To move a heading and its subheadings

Click the heading, and then drag the

heading icon to its new position.

Tip: Check that the icon is aligned at

the heading level you want before you

release the mouse button.

Donatio « Outline:

jonatio

@ Pennae

© Te feugait nulla facilisi

© Dolore magna aliquam erat

ether

© Lorem ipsum dolor sit

© Elit sed diam nonum

© Tincidunt ut laoreet

& Ceelum

© Quis nostrud exerci

= Commodo consequat

© Duis autem vel

Aether SSCS

rem ipsum dolor

Ent diam n

1 ut }ao

To move a heading without moving its subheadings

Click the heading you want to move,

hold down Option, and then drag the

heading icon to its new position.
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= Donatio ¢ Outline:

Donatio

®& Pennae

& Te feugait nulla facilisi

© _Dolore magna aliquam erat

©ether

= Lorem ipsum dolor sit

© Elit sed diam nonum

© Tincidunt ut laoreet

& Caelum

© Quis nostrud exerci

= Commodo consequat

= Duis autem vel



To select multiple headings

To select... Do this...

Nonadjacent headings Select a title, subtitle, or body text icon, hold down Shift, and then click additional

heading icons.

Adjacent headings Select an icon at one end of the range, hold down Shift + Option, and then select the

icon at the other end of the range, or drag-select all the headings you want to move.

All text in a heading Select a heading, and then choose “Select all” from the Edit menu.

All titles or all headings at one level Select a title or heading, and then choose “Select all” from the Edit menu twice.

To move multiple headings

Select the headings you want to =

move, and then drag them to their o Donatio
_ . 1 Pi

new location. A short vertical bar next peiPennee
: : 2 eayAether

to the heading icon indicates that a 3 © Coelum

heading is selected. 4 © Pennae

father a
6 @® Nimbus
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Nesting slides under an

overview slide

When you want to create one slide

that lists your presentation agenda,

you can create an overview slide from

a group of subordinate or nested

slides. Or, if you have a slide that has

too many bullet points, you can

divide it into one overview slide and

several nested slides to retain the

hierarchy of the information.

Outline your presentation to save time ... 62

“Outline menu” in Online Help
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Create an overview slide

=9
+ Auralevis ——
+ Secundus adversus

+ Procella crassus

Ventus 5

Aura levis

+ Lorem ipsum dojor sit

+ Elit sed diam nonum

+ Tincidunt ut laoreet

Secundus adversus

+ Quis nostrud exerci

+ Commodo consequat

+ Duis autem vel

Procella|crassus

+ Iriure dojor in hendr

+ Velit esse consequat

+ Dignissim qui praesent

When you nest slides, you create one overview slide that lists the titles of each of the

subordinate slides.

To nest slides

olAura levis :

coll Secundus adversus !

=1Procellacrassus :

Select the slides you want to nest, and

then drag the slides to the right and

below the overview slide.

@llAura levis

(i Secundus adversu

© Procella crassus

Choose “Set heading as” from the

' Outline menu, and then choose “Title”

from the submenu.



Assigning masters and

transitions in the outline

To assign a new master to a slide

1

watfa

o Presentation

1 = [Pennae

& Te feugait ral
© Dolore magne.é

2 ®S Aether

Select the slide title.

To add transition effects

1

fa:Ta

o Presentation

1 = |Pennae :

& Te feugait nult

= Dolore magna ¢i

2 © Aether

Click an insertion point anywhere on the slide you want the

transition effect to precede.

Adding and editing sounds................ 168

Sound transition effects for slides

and slide layers .........ceesseceeeseeeeteees 166

Transition effects for slides and

slide layers

Gallery... 538M

Reapply placeholder...

Reapply master

Background

Choose “Slide master” from the master menu at the bottom of

the window, and then choose a master to apply.

Close curtain

Blinds left

Glitter right

Glitter down

Glitter across

First sound effect

Layer visibility...
Set layer Dissolve

ai Random
>a

Choose “First visual effect” from the transitions menu at the

bottom of the window, and then choose an effect from the

submenu.

Tip: To apply the same effect to

multiple slides, select those slides

before applying the effect.
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Collapsing and expanding

an outline

Collapse your outline to move slides

around quickly or to review the

organization of your slides. You can

expand a collapsed outline to view

and/or print the text of your complete

presentation.

Tip: To hide all body text indented

on your slides, select “Hide body

text” from the Outline menu.

Format your outline for printing

AN VIEWING «2.2... eceeeeeesecesessteeeeseeenens 71

Printing overheads and support

Materials 0... ccceeeesessseeseeeeeeessenes 202

Rearrange information in the outline ... 66
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Collapsed and expanded outlines

|} Reipublicea forma

‘© Advolare

Collapsed Outline

©) Reipublicea forma

= Praefectus

> Rector

TM Eques

= Curator

= Artifex

= Pedisequus

- @ Advolare

= Feugiat nulla facilisis

TM=Accumsa et iusto odio

Expanded Outline

When a heading in the outline is collapsed, its icon is highlighted.

How to collapse and expand parts of the outline

' To...

Collapse the whole outline and show

| only the slide titles.

|

] ; : ° . .
| Collapse one outline section.
|

' Collapse several headings at once.

| Collapse all subheadings except

| immediately subordinate ones.

| Expand all subordinates in a
' selected heading.

Do this...

Click the icon in the lower-left corner

of the window. Click again to expand

the outline.

Double-click its icon. Double-click again |
to expand the section. |

Select the headings whose sub-headings |
you want to collapse, and then choose,

“Collapse selection” from the Outline menu. |

Select a heading with two or more

subordinates, and then choose “Show

subs only” from the Outline menu.

Select the headings you want to expand, |
and then choose "Expand subs” from

the Outline menu.



Format your outline for

printing and viewing

If you plan to print the outline either

for your own review or as part of

your supplemental material, it helps

to format the text to make it more

readable.

You can format the whole outline at

once, you can format all headings at

the same level, or you can format

selected text or headings.

Formatting that you apply to the

outline does not show up on your

slides except for superscripts and

subscripts.

Tip: To format individual words or

phrases, highlight them using the

text tool, and then choose the

formatting commands from the

Text menu.

Checking your spelling «0,-0.0: 61

Printing overheads and support

Materials o.oo... ceccececeesseseeseeeseesteeteeeees 202

To format an outline

1

Select the part of the outline you

want to format:

To select the whole outline, click

the first slide title, press Option +

Shift, and then click the last slide title.

To select all headings at the same

level, click an insertion point in one

heading.

2

Choose “Format outline...” from the

Outline menu.

3

In the “Define outline styles for

selected levels” dialog box, choose the

formatting you want, and then click

“OK." All text in your outline that is at

the same level of indent as your

selected text takes on the formatting.

@ fPonetio

1 ennee

&§Te feugait nulle facilis

= §Dolore magne aliquam

Sf Aether

o Donatio

1 © Penneel. H

© Te feugait nulla facilisi:

=> Dolore magna aliquam er:

ccafe nether

Set heading as

Font: | Helvetica

Style: & Plain D Italic Oou
OBold Ounderline Sh

OSubscript (Superscript
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Add handouts and speaker

notes to a presentation

A presentation is rarely complete

without printed handouts and

speaker notes. Persuasion gives you

several options for creating these

essentials:

e You can create speaker notes,

which contain thumbnails of your

slides along with notes you enter

in the outline.

e You can create handouts, which

contain slide thumbnails along

with any other objects or text you

wish to add (for example, lines for

your viewers to jot notes on).

e Outlines and printed copies of

slides can be used as speaker

notes or as handouts. Add

supplemental information as notes

and in the slide divider.

Creating handouts ..............cceeseeeeees 76

Creating speaker notes ...........::ccseces 74

Entering text in the outline .................. 64

Format your outline for

printing and Viewing .............: cece 71
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Masters provide the framework for

speaker notes and handouts just as

they do for slides. AutoTemplates

come with a formatted note master

and handout master; if you are

creating a presentation from scratch,

you'll want to format note and

handout masters as well.

Once you set up a master for speaker

notes, type your notes in the outline

or on the note pages of each slide.

The notes can be printed either with

the outline or as separate note pages.



Generate notes and handouts for your presentation

Presentation

> Donatio

( Pennae

sum dolor sit amet

@ aliquam erat

@ Consectetuer adipiscing elit sed
m ipsum dolor sit

seddiamnonum

idunt ut laoreet

@ Diam nonummy nibh euismod tincidunt
© Quis nostrud

You might prefer to print the outline and

use it as your speaker notes.

ore magna aliquam erat

o (Corem ipsum dolor sit amet

2 & Pennae

ore magne aliquam erat

© Consectetuer adipiscing elit sed

m ipsum dolor sit

© Elit sed diam nonum

© Tincidunt ut laoreet

© Diam nonummy nibh euismod tincidunt

modo consequat

If you use the notes in the outline as

audience handouts, you can still generate

speaker notes using the slide dividers,

which only print when you print the outline.

Pennae:

Lorem ipsum dolor

sit amet

You can also print notes using the note

master. The note master can contain

placeholders for a slide title, note text

from the outline, slide thumbnail, and

page number.

The handout master can contain place-

holders for slide thumbnails, slide titles,

and page number. You can add

independent text and objects (such as

lines for writing) to the master. You add

objects only to the master, not to individual

handout pages
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Creating speaker notes

Formatting a note master

1 2

Master

Add title

Add subtitle

Add body text

Add chart

Outline

Choose “Note master” from the View Select placeholders from the Master

menu. menu as needed.

To add text directly on the note page

Anchor and resize the box. |
+ Click here for notes

Click the note icon in the upper-right With the text tool, select the prompt text

corner of the screen. and edit the notes, or add independent

text outside the placeholder.

Entering text in the outline .............. 64

Format slide content with placeholders ... 28

Printing overheads and support

Materials 0... cceccceeeeseeeeeeeseees ve. 202

"Add speaker notes to the outline” in

Online Help
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This is a Title! Place:
Placeholder , ‘

Resize, format, or anchor the

placeholders, and then add graphics as

needed.

J Donatio*

fee4+ Donatio?

Ly

To reposition any object, select it with

the pointer tool, and then drag it.



To add notes in the outline

1

Set heading as

fidd notes

Click the slide title, and then choose

“Add notes” from the Outline menu.

|S Reipublicea forma

Donatio

© Reipublicea forma

> Praefectus

> Praefectus

Click an insertion point behind the note

icon and type your note text.

To hide the outline notes, click the

show-notes icon in the lower-left corner

of the screen.
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Creating handouts

You create handouts by defining the

contents of the handout master and

then printing the handout pages.

Each handout page can contain up to

eight slide thumbnails at a time,

which you can resize and position like

other graphics. You print the

handouts by selecting “Handouts”

from the print dialog box.

Tip: Using the handout master is

an excellent way to create a

storyboard of your presentation.

Print the handout in “Wide”

orientation. Choose "Handout

master” from the View menu, and

then uncheck “Tall” orientation

from the Master menu.

Printing overheads and

support materials ...

Working with slide masters and

backgrounds

“Defining the handout master” in

Online Help

- 202
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To create handouts

Sutline

Handout master

Choose “Handout master” from the

View menu.

(eS JS

Add slide copy

Choose “Add slide copy” from the

Master menu for each slide placeholder.

4

Show Name

Slide Title
Slide Title x

( y a

Drag each placeholder where you want

it. Resize to fit the page as desired.

5

To add page numbers to each

handout, choose “Add page number”

from the Master menu.

To add slide titles to the handouts, choose

“Add title” from the Master menu.

Drag the title placeholder into position.

Slide 3 Title Placeholder. |
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Working with imported

graphics

Persuasion accepts graphics and clip

art in EPS (encapsulated PostScript),

PICT, Windows Metafile and Photo

CD formats.

You can move and resize imported

graphics easily in Persuasion. If you

want to modify them more exten-

sively, you must first convert the

graphics to Persuasion format by

ungrouping them. Note, however,

that some imported formats (de-

scribed here) cannot be ungrouped.

Use PICT graphics if you intend to

edit the graphics extensively once you

bring them into Persuasion. Use EPS

graphics if you plan to use the

graphics without changing them, and

you want to print on high-resolution

PostScript printers and interpreters.

PICT graphics You can ungroup all

PICTs except those that contain

rotated text, bitmap elements (such

as scans), or other objects you cannot

create in Persuasion. Text that is not

rotated can be edited when you

Adding colors and fills .......0.0 eee 120

Importing graphics .......eee eeeeeeeees 136

"Maintain links with other applications”

in Aldus Table Online Help
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ungroup its PICT image. Colors in

imported graphics are displayed as

close as possible to the original

graphic’s colors.

EPS graphics EPS graphics can print

at high resolutions on PostScript

printers and are the best choice for

use in printed presentations, EPS

graphics retain all PostScript color

information, so the graphic will print

to a PostScript printer with the exact

colors of the original.

Most EPS graphics display at 72 dpi,

so their screen representation may

not be as sharp as the final printed

version.

EPS graphics print at 72 dpi on non-

PostScript output devices (such as

most film recorders) unless a

PostScript interpreter is used. So, if

you use a non-PostScript output

device, import your EPS graphic at

400% of the size you plan to use it.

When you shrink it on-screen, you

will refine the resolution.

EPS graphics can be resized and

moved, but not ungrouped and

converted to Persuasion’s format.

Windows Metafiles Windows

metafiles are converted to PICT

graphics as they import, so PICT rules

apply.

Photo CD While you are importing a

Photo CD image, you can adjust the

image's depth, resolution, and

orientation. You can also flip the

image about its vertical axis or rotate

images in 90-degree increments.

Once you import the image, it is

converted to PICT format and can be

moved and resized but not

ungrouped for more extensive

modifications.

OLE-linked graphics If you want to

ungroup and edit an OLE-linked

object, you must convert it to a

picture and then ungroup it.

Tip: Large, imported graphics—

particularly color or grayscale scanned

images—take time to redraw

on-screen. To speed up screen redraw

when you're working on a

presentation, choose “Preferences...”

from the File menu, and then check

“Hide big PICTs.”



To convert a PICT to Persuasion’s format

1

With the pointer tool, select the graphic you want to ungroup.

To convert an OLE-linked graphic to Persuasion format

1

Select the graphic and choose “Badges” from the Show

menu to display the OLE badge, if necessary.

Choose “Ungroup” from the Draw menu.

2

Edit

Redraw

Rename...

Convert to picture =.

Restore to original size

Select “Convert to picture” from the popup menu on the OLE

badge. This step will break the OLE link and the graphic’s

badge will disappear, indicating that the graphic can be

ungrouped.
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Drawing basics

Use Persuasion’s drawing tools and menus to:

Create and customize lines

and endcaps

Create shapes with variable

line widths st

Draw a polygon or freeform shape ...... 82

Duplicate a graphic .........eceseeeeseees 85

“Setting tool attributes before

you draw” in Online Help
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@ Create and reshape polygons.

© Duplicate your graphic at identical offsets.

@© Rotate or flip components of your graphic.

© Create shapes with variable line weights.

@ Create customized line ends (endcaps).



Drawing tools

A_Diagonal-line tool. Draws straight lines at any angle.

AaB: B Line tool. Draws vertical or horizontal lines.

C Arc tool. Draws curves or arcs.

D Ellipse tool. Draws ovals and circles.

E Rounded-corner tool. Draws rectangles or squares with

E eS rounded corners.

G F Square-corner tool. Draws rectangles or squares.

Lua G Freeform tool. Draws freeform shapes or lines.

H_ Polygon tool. Draws polygons.

1 Magnification tools. Reduce or enlarge magnification to

| show more detail or more of your slide, or switch back and

forth between views.

Constraining shapes as you draw

To draw a line or shape from the To drawa perfect circle, square, or To drawa perfect circle, square, or

center, hold down Option while 90-degree arc, hold down Shift while 90-degree arc from the center, hold

drawing. drawing. down Shift + Option while drawing.

Tip: Press Shift key to constrain lines and polygons to 45 degrees.
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Draw a polygon or

freeform shape

To create a polygon

1 2 3

+} —$—<$<$$<$a

Select the polygon tool. Click an Continue clicking to add line segments Double-click the first point you created

insertion point where you want the to close the shape.

shape to start, and then click where you

want the first line segment to end.

To reshape a polygon, arc, or freeform shape

1 2 3

Select the object with the pointer tool. Choose “Reshape” from the Draw menu. Drag the individual points to reshape

the object.

To add a point, click anywhere on the polygon’s lines To remove an unwanted point, drag it onto an adjacent

point.
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Create and customize

lines and endcaps

Tools for editing lines

None None

Beginning

3 pt. Both

Other...

To modify an endcap —

Edit endcaps : h

Choose “Edit...” from the line palette, Drag the points in the edit box to reshape

and then click the endcap you want to the endcap.

_ modify.

A Line weights (widths)

Custom line weights

C Places endcaps that scale with line

weight

D Styles of endcaps

E Modify endcaps

E&I Fitted

Check “Filled” to create a solid-fill

endcap.
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Create shapes with variable

line weights

_ Choose this tool... And enter these pixel settings in the To create...

“Custom line size” dialog box...

arc - . 1x15

_
: diagonal line OB 1x20

TM,,

‘ellipse. oo 15x5 : Cc)

rectangle Oo | | 5x25

—
polygon a . 15x1 :

freeform Oo 20x1 Z

: To create variable line weights

memes Spt.

ES ¢ pt.

____ ar
| Top. Vertical: [a] pixels

ae Horizontal: pinels

Select the object whose line weights you want to modify, and in the “Custom line size” dialog box, enter the appropriate

- then choose “Other...” from the line palette. line weights (up to 99), and then click “OK.”
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Duplicate a graphic

You can create interesting designs

and custom patterns by duplicating

an exact copy of an object at a

specific offset from the original.

Duplicated objects will look exactly

like the original. Duplicated text from

placeholders becomes independent

text.

Modifying complex graphics ................ 86

To duplicate an object to create a pattern

1

Select the object with the pointer tool,

and then choose “Duplicate” from the

Edit menu.

Choose “Duplicate” again to

reproduce the object and the offset.

2

Without deselecting the new copy,

drag it to the desired position to

create the offset you want to repeat.

Tip: Copy and paste objects instead of

duplicating them if you want the copy

to appear in exactly the same place as

the original. This is a useful technique

for masking an object on a lower layer

or for moving an object to the same

place on another slide or to the slide

master.
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Modifying complex

graphics

Grouping Use the “Group” com-

mand on the Draw menu to move

and resize several objects as one

graphic rather than selecting and

changing each component individu-

ally. Once you've grouped graphics

you don’t have to ungroup them

again to modify individual compo-

nents. Instead, you can subselect the

object you want to modify.

Stack ungrouped objects When

you are working with several objects

that overlap but are not grouped, you

can determine the order in which

they overlap.

Tip: Select any object on the slide

and choose “Regroup” from the

Draw menu to automatically

recombine objects you've

ungrouped and modified. All the

items that were most recently

ungrouped will be regrouped,

retaining changes you've made to

the objects.

Working with imported graphics ......... 78

"Grouping and ungrouping objects” in

Online Help

“Layering objects” in Online Help

“Manipulating your drawings on the

slide” in Online Help
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Modify one component of a grouped graphic

Subselect an individual component by double-clicking it, and then modify it as though it

were a single object.

Modifying like objects

To make changes to all freestanding (not grouped) objects on a slide drawn with a

specific tool (all ovals and circles, for example), select the tool, and then choose “Select

all” from the Edit menu.



To select an object in a stack

To select an object that is completely

or partly hidden in a stack on the

slide, hold down Option and click the

stack until the object you want is

selected.

To change the stacking order

4 Select the object whose position

you want to change.

2. Choose “Send” from the Draw

menu and then choose an option

from the submenu.

Tip: To select everything on the

slide, select the pointer tool and

then choose “Select all” from the

Edit menu.
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Aligning and distributing

objects

You can align several objects on your

slide with each other, or distribute

them to create an equal amount of

space between them. In Persuasion,

you do both of these automatically,

without selecting and dragging each

object.

When choosing to align or distribute,

you make three decisions. First,

decide whether you want to position

objects in relation to each other on

the vertical or horizontal plane. Then

decide whether to align, distribute, or

both. Finally, choose from among the

specific alignment and distribution

options.

Tip: Use the arrows or the edit

boxes on the nudge palette to

move objects, text, and shadows

incrementally.

Use a layout grid for precise

alignment...

“Rotating and flipping objects”

in Online Help
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Position objects in relation to each other

Align, Vertical Bottom

Distribute, Horizontal Center

-= eeeee== eee

Align, Vertical Top; Distribute Horizontal Center



To align objects with each other

1 2

Draw

Oleft @Center
© iB E)uorizontal: ~@ Align ia .

Select at least two objects, and then choose In the “Align objects” dialog box, check alignment options,

“Align/Distribute..." from the Draw menu. and click “OK.”

Tip: To align an object to the nearest grid intersection, choose “Align to grid” from the Draw menu.

To distribute objects evenly

Draw Otap oO

Send > O Center ia
Center on slide Olottom oy

3p 
Ondeight Oo. | i

Oleft @Center ORight ©:

Eluorizontal: © Align fo} Distribute;

Select at least three objects, and then choose In the “Align objects” dialog box, check distribution options,

“Align/Distribute...” from the Draw menu. and then click “OK.”
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Working with shadows

You can apply shadows to objects, Tools for applying shadows

text, and text blocks and then change

the color or pattern, or the offset of A BCD

the shadow.

A Line button

You use two buttons on the color B Fill button

palette to apply shadows: the F C Text button

shadow button and the button that uc = [Emphasis D. Shadow button

represents what you are shadow- =
“ . i . ody E Collapses and expands the
ing— text, line, or object outline, or

3 | color palette
object fill.

F Changes the foreground or back-

ground of a line, fill, or shadow

G Working set colors

H_ No fill

| Solid fill

J Graduated fills and (when

expanded) patterns

To apply a shadow to an object

4) Select the object with the pointer s ‘

tool, and then click the fill button

on the color palette.

2) Click the shadow button on the

color palette.

3) Click a pattern or fill, and then

click a color swatch.

120

118

Adding colors and fills

Color basics

“Changing text font, color,

size and style” in Online Help
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To apply a shadow to text characters

1 zz

‘
Tip: Remove text shadows from

7 2 . . : z selected text by choosing “Text

( ] . , format..." from the Text menu, and
ae um j um: then unchecking “Shadow” in the

« . rk . F . . “Text format” dialog box.

Select the text with the pointer tool. Click the shadow button on the color

palette, and then click a color swatch.

To apply a shadow to a text block

1 2

Select the text with the pointer tool, and then click the fill Click the shadow button on the color palette, and then click

button on the color palette a color swatch.

To change the offset of a shadow

Shadow offset

Tip: Use the arrows or the edit boxes

night: [9] points on the nudge palette to move objects,
text, and shadows incrementally.

Select the object with the pointer tool, Enter values in the “Below” and “Right”

and then choose “Shadow offset...” edit boxes and click “OK.” Enter

from the Draw menu. negative numbers to move the shadow

above or to the left of the object.
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Use a layout grid for

precise alignment

A key technique for creating a

consistent layout is using a layout

grid. The grid helps you position

objects precisely across all your slides.

Three sets of non-printing tools for

creating a layout grid and for

positioning and drawing objects on

your slides precisely are available from

the Draw menu: grid lines, rulers, and

guides.

You can choose to have objects

“snap to” guides and grid lines, so

that when you position an object

within a few pixels of the grid line or

guide, Persuasion automatically

moves the object to the line.

Set up guides on a background, slide

master, or slide depending on how

often you want them to appear.

Guides on masters or backgrounds

will show up on the slides.

Tip: Choose “Ruler units” from

Rulers in the Show menu to

change the measuring basis

of grid lines.

Aligning and distributing objects ......... 88

“Positioning graphics using rules, guides,

and grids” in Online Help
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Tools for precise positioning

seetebed telat tetelettel hed teeta)

LSE

Click and drag the crosshair to adjust

the position of the zero point.

Drawing on the grid

siebrtecbetedy

Grid lines help you place objects at

specific intervals from one another.

Iecbeletedeet

Lddtedadebthabaddetelddtdebadbabalt

C Click the ruler and drag guides into

Position to align objects precisely.

D_ Use guides to help place objects in

the same place on each slide.

Draw a symmetrical polygon by counting

grid intersections, or points between the

lines, as you draw your segments. Turn on

“Snap to Grid” from “Grid” in the Show

menu to ensure the lines are a consistent

length.



CHAPTER

6
©)

Charts, Tables,

and Organization

Charts



Adding a chart to your

slide

Aldus Chart is an integrated applica-

tion that opens automatically when

you click a chart placeholder on a

slide or draw a rectangle with the

chart tool in Persuasion. The chart fills

the space of the chart placeholder or

the rectangle.

With Aldus Chart you can create and

update complex charts while working

in Persuasion. Charts are OLE-

embedded in Persuasion, so you can

update a chart in Aldus Chart after

you have placed it on a Persuasion

slide.

With a Persuasion file open, you can

open Aldus Chart, enter your data,

and format the chart. You'll find

detailed instructions for creating and

customizing each chart type in Aldus

Chart online Help.

Note: Aldus Chart can OLE-embed to

any application that supports OLE.

Object linking and embedding (OLE) ... 144

Working with slide masters and

backgrounds

"Adding a chart to a slide” in Online Help

“Creating a chart slide master” in Online Help

“Moving and resizing charts” in Online Help

“Visual guide to Aldus Chart” in

Aldus Chart Online Help
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Two ways to position and size your chart

Advolare
Click here for title

Click here for subtitle

(Click here for chart:

The position and size of your chart is determined either by Persuasion’s chart

placeholder or by the rectangle you draw with the chart tool.

Advolare

ettre

After you've added your chart, you can move and resize it.

Tip: You may find that Aldus Chart runs faster when you close other

unused applications. If you have difficulty running Persuasion and

Aldus Chart simultaneously, open Aldus Chart to create and copy

your chart, and then open Persuasion and choose “Paste special...”

from the Edit menu to add your chart in your presentation.



To create a chart slide master

1 2 3

N lid ti Master
iewslide master Add title

Add body text

Based on: Add chart

Choose “Slide master” from the View In the “New slide master” dialog box, Remove any unwanted placeholders

menu, and then choose “New...” from base your new slide master on an existing from the chart master, and then

the submenu. slide master, name your chart master, and choose “Add chart” from the Master

then click “OK.” menu.

To add a chart using a placeholder

1

Tip: If the prompt text or the chart

placeholder does not appear, choose

“Placeholder” from the Show menu,

and then check “Prompt text” on the

submenu

Assign a chart slide master to a slide, In the new chart dialog box, select the

and then click the chart placeholder to chart type you want, and then double-

open Aldus Chart. click a thumbnail to open the chart.

To add a chart using the chart tool

1 2

Area

Bar

Bubble

HighLo

Histogram

Select the chart tool from the Persuasion tool palette, and In the new chart dialog box, select the chart type you want,

draw a rectangle on your slide to establish your chart’s and then double-click a chart template thumbnail to open the

Position and size. chart.
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Entering chart data

Enter data for your chart in the Chart data sheet with sample data
chart’s data sheet. You can either

enter your data over the sample data,

or clear the sample data and then

enter your own.
titied-1 ©

Sample data exists in “assigned cells”

to accurately title and label the chart,

and to display data. If you enter your

data over sample data, keying your

chart title over “Chart title,” for

example, you can select “Autoscan”

to set your cell assignments. That is,

to tell Aldus Chart which data is a

title, a data range, or a footnote on

the chart.

If you entered your data on a cleared

data sheet, you'll need to assign cell A The chart guide shows where sample E Chart position names.

data to chart positions manually. data, displayed in E, appears on a F Automatically assigns data in a pre-

standard chart. set and highlighted cell to a stan-
B The rowand column intersection for dard chart position.

the highlighted cell. G Chart button displays the chart.
C Displays data sheet cell(s) assigned to From the chart, the data sheet but-

the chart position named in E. ton displays the data sheet.

D Assigns data in highlighted cell(s) to H_ The edit line displays characters as

a chart position in E. you edit or type.

“Enter your data” in Aldus Chart

Online Help
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To display the data sheet from Persuasion

1 2

Advolare

Click the Chart badge on the slide to display the Chart menu, From the Aldus Chart control palette, click the data sheet

and then choose “Edit.” button.

To enter data and set cell assignments

1 2

viitle

= Subtitle

Set title Title vi > Footnote

} Show title A : Row headers.

A aT : py column headers
Anis title #1

--+. B oP - t Anis title #2
Sete t : = Anis title #3

Footnote ; —— 5 E Anis title #4
Data range

Click an insertion point in a cell and type your data. Press To set cell assignments, select a cell or a range of cells, and

Return to enter the data in the cell. then choose a chart position name from the popup menu.

3 4

toch The Wing Jo Kite Ming

Suitability of P.. ii DYsuitabitity of P...
Hseale:0 (not s. Ascate::0 (not s..

Clear any cells that contain only sample data, and then click If you typed over sample data, click “Autoscan.” If you cleared

“Show” to review your chart assignments. sample data, click “Set” to make cell assignments. (Type in all

your data before setting assignments.)
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Bringing in data created in

other applications

If you want to use data created in

another application, you have three

options for bringing it into Aldus

Chart: —S——_

¢ Subscribe to an edition file. :

¢ Import the data.

© Copy and paste the data. i ie | | | F

If you have data in your data sheet,

copy and paste or subscribe to an

edition file to add data from another If you want your chart updated when you make changes in the original (source) applica-

tion, use publish and subscribe.

Publish and subscribe for regularly updated data

application. Importing data clears all

existing data from the data sheet.

You can import any text-only (ASCII)

data that is saved in tab-separated

(Tsv), comma-separated (Csv), or

space-separated (Ssv) format. You : Sn

can also import data saved in = =

Microsoft Excel file format. . =

Import or copy and paste when no link to the original file is necessary

If you will not be changing your data in the original application, import your data, or

copy and paste it.

Aldus Chart immediately sets =

appropriate cell assignments if your

imported or copied data follows the

sample data format for your charts

data sheet. Otherwise, after import-

ing or copying data, you need to set

cell assignments manually.

Entering chart data 0.0... 96

Publish and subscribe 0.0.2... 146

“How to publish and subscribe in

Persuasion” in Online Help

“Setting the cell assignments” in Aldus

Chart Online Help
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To subscribe to an edition file

In the source application, publish an edition of the file to Select an area on the data sheet larger than the range of data

which you want to subscribe. in the edition file.

3 4

Choose “Subscribe to...” from the Edit menu. Select the edition to which you want to subscribe, and then

To import data from an application

1

Close data sw

Import data...

In the Aldus Chart data sheet, choose

“Import data...” from the File menu.

click “Subscribe.”

Cs data
Ssv data

Tsu data

Type: Mt)

In the “Import” dialog box, specify a file Select the file you want to import, and

type for the data you're importing. then click “OK.”
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Change the look of a chart

After you create your chart, you may

find that your chart type doesn’t

effectively show the data or that the

arrangement of data conceals

important information.

Change your chart type

3d riser

You can change the way your chart

: [ iors patenr 225

¢ Changing the chart type. Ree) :

© Reversing the position of your Cutscomer bars

data to bring obscured data to the f

foreground.

e Resizing your chart.

Each chart type has additional

options for restructuring your data.

Detailed information about each
chart type and its options is available Browse through chart types by choosing individual thumbnails from the Gallery menu.

in Aldus Chart Online Help.

Tip: If you get a warning message after changing your chart

type, you may need to enter additional information or reset

the data range chart assignment for the new chart type.

“Select a chart type” in Aldus Chart

Online Help
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RUE

Reverse series or categories of data

=e

Resize your chart

abi SoTL SA 2 SORES DS

You can emphasize different parts of

your 3d chart or reveal obscured data.

Experiment with reversing either series

(dependent data, like location) or catego-

ries (independent data, like time of day)

using “Data reversal” from the Aldus.

Chart menu.

After you place a chart in Persuasion, you

can change its size by dragging its resizing

handles. Resizing may distort objects or

text. Choosing “Redraw” from the OLE

badge popup menu can refine your

chart’s resolution.

Tip: To resize a chart to its original

dimensions, choose “Restore to

original size” from the OLE badge

popup menu.
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Modifying individual chart

components

Modifying charts in Aldus Chart is

similar to modifying graphics in

Persuasion: select the component you

want to change, and then select the

appropriate tools and options from

the palettes.

When you add your chart to a

Persuasion presentation, the colors in

the Aldus Chart color palette are

those of your presentation’s “Stan-

dard” color model. The Aldus Chart

color palette functions like the

Persuasion color palette. However, to

edit colors on a chart, use the

Persuasion color palette.

Tip: For faster screen redraw in

Aldus Chart, hide all the text and

graphic elements you are not

working on by choosing "Display

status” from the Chart menu.

You can also cancel screen redraw

by pressing Esc.

Adding colors and fills ........ cece 120

“Chart elements” in Aldus Chart

Online Help

“Edit the chart” in Aldus Chart Online Help
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The Aldus Chart control palette

AY B GD

A The pointer tool selects chart ob-

jects, tools, and commands.

B_ The popup menu tool displays

popup menus on chart objects that

you can use to modify chart objects.

C The eyedropper tool copies and ap-

plies colors, patterns, and fills from

one object to another.

Aldus Chart text palette

D The data sheet button displays the

data sheet. From the data sheet,

the chart button displays the chart.

E Displays the special effects (SFX)

palette.

n Displays the color palette.

a Displays the text palette.

= Displays the 3d view palette.

A Lists available fonts.

B Listsfont sizes.

C The bold, italic, and underline but-

tons determine text style.

D Text alignment buttons.

E The autofit button proportionally

resizes text when you resize a text

block.



To proportionally resize text

1 2

Tip: Not all chart text can be propor-
teaimchiiceck + — gs tionally resized. If handles—not solid‘Reipublicae Forma: i blicae Forman = vy ;ee eng FRiBY " FS FREDAD wit boxes—appear when the text block is

selected, the text can be resized using

the autofit button.
With the pointer tool, select the text Click the autofit button on the text

block you want to resize. palette, and then drag the handles on a

text block to the size you want.

To copy fills from one chart object to another

1 2

Select the eyedropper tool from the control palette, then click Click with the eyedropper tool on the object you want to fill.

the object whose color, fill, or graphic you want to copy.

To show popup menus

Select the popup menu button, and

then click and hold a chart object until

the menu appears from which you 16

can edit the object.

20

10 }——}

Cumulonimus Cirrus Altostratus

CHAPTER 6: CHARTS, TABLES, AND ORGANIZATION CHARTS 103



Special effects and

3d charts

In addition to Aldus Chart’s tools for

manipulating text and color, you can

use two additional palettes to change

the way your charts look: the special

effects (SFX) palette, for both two or

three dimensional charts, and the 3d

view palette. Display these palettes by

clicking the appropriate button on

the control palette.

Tip: You can add graphics,

including clip art, to charts by

saving them in the “Effects” folder

of the Chart folder. Graphics in this

folder appear in the “Pictures”

popup menu on the SFX palette.

Modifing individual chart

COMPONENS .....escessecsecseessessesseeseeseens

"Add special effects to your chart” i

Aldus Chart Online Help

“Emphasize portions of data” in Aldus

Chart Online Help

“Preset viewing angles in 3d charts” in

Aldus Chart Online Help
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Special effects enhance the look of your chart

‘Scale: 0 (not suitable)to 10 (perfect)

Suitability of Particular Kites
for Different Wind Speeds

@ Add custom gradient fills to chart

backgrounds or components.

© Add graphics to chart backgrounds or

components.

To add scans or graphics

1 Select the chart component to

which you want to add the

graphic, and then click “Pictures”

on the SFX palette.

2 Choose the graphic you want to

add from the lower popup menu,

and then click the “Apply effect to

selection” button on the SFX

palette.

@ Determine a viewing angle that em-

phasizes your data.



To apply a gradient fill to a chart object

1 3

Select the chart object you want to fill. Click the special effects button on the Select the fill you want from the popup

control palette to display the SFX palette, menu.

and then click the “Gradients” button.

4 5)

Tip: Expand the SFX palette if you

want to change the start or end color

for your fill.

Choose a direction in which the fill Click the “Apply effect to selection”

should flow from the “Direction” button on the SFX palette to see the

popup menu. change on your chart.

To change the viewing angle on a 3d chart

1 2 3

Select an object, and then click the 3d On the 3d view palette, select the aspect Click the “Apply” button on the 3d

view button on the control palette. you want to change, and then click the view palette to see your changes.

arrows in the 3d model to make

incremental changes.
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Adding an organization

chart

Use organization charts to show a

company’s reporting structure, or to

show other types of hierarchical

information.

You create organization charts in

Persuasion by entering your text in

the outline, and then assigning an

organization chart master to the

slide. Each AutoTemplate that comes

with Persuasion has an “Org Chart”

slide master containing a placeholder

for a three-level organization chart.

Each level holds up to five boxes. If

you chart is more detailed, you can

create a new organization chart

master. Be aware that larger organi-

zation charts can be less readable.

You modify an organization chart by

selecting the part you want to

change and working with the

Persuasion text, color, and line

palettes.

Adding colors and fills ..........:ceeeeee 120

Entering text in the outline 0... 64

“Formatting organization charts on slides

and slide masters” in Online Help.

“Making an organization chart”

in Online Help

“Setting up an organization chart

placeholder” in Online Help
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To work with your organization chart

as a graphic, ungroup it first. Then

you can make changes in the

connecting lines or change the shape

of individual boxes (other than giving

them round corners).

Ungrouped organization charts no

longer reflect changes made in the

outline.

Tip: Choose “Round corners” from

the Draw menu to turn your boxes

into more round-cornered

rectangles or ovals.

Outline levels correlate with chart levels

Reipublicae Forma

SReipublicea forma

=Opifex

=Operarius

= Artifex

ediseqi

Es pe ee
@ The first level on the outline represents

the slide title.

@ Each subordinate heading represents a

lower level on an organization chart.

© The first level of body text represents

the top level in your organization chart.



To add an organization chart to an AutoTemplate presentation

1 2

1| Reipublicea forma

=Praefectus

=Rector

=Eques

= Opifex

= Operarius

©Curator

© Artifex

= Pedise

1} Reipublicea forma

=Praefectus

Create a new slide in the outline, and Type the levels of your organization chart

then enter the slide title. as subordinate headings

To modify parts of your organization chart

Gallery...

Reapply placeholder...

Reapply master None

Master Bar Chart

Background div Master 1

Mate? > LEM) Org Chart
Text

Title

Choose “Org Chart” from the master

popup menu at the bottom of the

window.

[ee ls | ESAe See &
SSS3| ==].
To modify the entire chart, click the To modify a whole level of boxes or

chart once with the pointer tool and lines, double-click the level with the

then select options from the text, line, pointer tool, and then select options

or color palette. from the text, line, or color palette.

i —

To modify an individual box or line

on a slide, double-click the box or line

twice with the pointer tool, and then

select options from the text, line, or

color palette.

Tip: To modify text in the organization chart, triple-click the text with the pointer tool,

and then edit the content and the format of selected chart text.
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Tailoring your organization

chart

You have two primary ways to modify

the size and shape of your organiza-

tion chart boxes and the space

between them:

e Change the size of the organiza-

tion chart on the slide.

e Create a new organization chart

placeholder with a different

number of boxes and levels.

You establish box and level settings

for an organization chart when you

create it. The settings you choose are

a guide and do not restrict the

number of boxes or levels you can

enter.

For best results, try to estimate as

closely as possible the number of

levels and boxes you'll need for your

organization chart. When you add

more levels or boxes, the shape of the

boxes will change to accommodate

the data. When you add more levels,

the additional levels take on the

format of the next-to-last level.

Model a slide master

after a slide you like .......ececeeeeseeeees 32

“Setting up an organization chart

placeholder” in Online Help

“Formatting organization charts on slides

and slide masters” in Online Help
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Formatting options for the lowest level

Reipublicae Forma

Praetectus

[ 1

| me || com [ come

it 1
1

antes | | ome |] anter | [reser

| ||
z Opifex Opifex

Cpter sy ecpererius Operarius Operarius

Separate Boxes Boxed list List

The information in the lowest level of your organization chart can be formatted in three

ways, as a list, a boxed list, or separate boxes, depending on the option chosen in the

“Add org chart..." dialog box.

The “Add org chart...” dialog box

Add org. chart placeholder (or)

A Default number of levels: |3 ( Cancel }

B —- Default number of boxes: |5

C —+ Set lowest level as: © List

© Boxed list

@ Separate boxes

A Choose a setting as close as possible C Select a display option for the lowest

to the number of levels you expect level of your organization chart.

to use on your slide.

B_ Enter the maximum number of boxes

you are likely to require on any given

level of your chart.



To modify box size

| Printoctua

ub Forma

To make the organization chart boxes deeper, select the

chart with the pointer tool, and then drag either the center

top or bottom handle until the boxes are the depth you want.

Tip: You can proportionally resize your chart by clicking and dragging any corner handle. To change text size in resized boxes,

select the resized chart or chart level with the pointer tool, and choose a new point size from the text palette.

To create an organization chart master

Choose “Slide master” from the View menu, and then choose

“New...” from the submenu.

Delete any organization chart or body text placeholder and

then choose “Add org chart...” from the Master menu. (A

single master can hold one organization chart or body text

placeholder, not both.)

Reipubticee Forma \

=| =hHep=|
To widen the organization chart, select the chart with the

pointer tool, and then click and drag the center left or right

handle until the boxes are the width you want.

New slide master

Based on:

Chart,

vY Text

Title

In the “New slide master” dialog box, base your new master on

an existing slide master, name it, and then click “OK.” osseee
4 Add org chart placeholder

Default number of levels: 3 ,
5Default number of boxes: |

\

Set lowest tevel as: O List i
O Boned list l

@ Separate boxes

In the “Add org chart... ” dialog box, enter the number of

levels and maximum number of boxes you need on any level. !

Select a format for the lowest level and click “OK.”
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Adding a table to a slide

Although you can create columns of

text in a body text placeholder, when

you want to add complex tables to

your presentation, use Aldus Table.

Aldus Table is an integrated applica-

tion that opens automatically when

you draw a box with the table tool in

Persuasion.

Initially, your table fits into the box

you draw, but you can change its

dimensions any time by selecting the

table and dragging its side handles.

Tip: When you type text into a

table cell and it wraps in the cell,

all the cells in that row become

taller. To create wider cells, move

the cursor to the row-select zone.

When it turns into a double arrow,

click and drag it to the width

you want.

Creating multicolumn text. 60

“Place your table in another application”

in Aldus Table Online Help

“Set the table and text defaults” in Aldus

Table Online Help
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Parts of Aldus Table

A The rulers’ zero point.

B_ Select-all box.

“Table format” dialog box

C Row-select zone.

D Column-select zone.

Units of measure:

Table format (« )

tee" [EE] eign: inches |
A—S B

Columns: [3] width: inches |

A Defines the current number of rows

and columns in your table.

B_ Table height and width dimensions

reflect the box size you drew on

your slide.



To create a table

AdvolareAdvolare
Table Format

Rows: [6] H

Columns: f_] :

In Persuasion, display the slide on which Click where you want the upper-left When Aldus Table opens, choose

you want to add a table, and select the corner of the table to begin, and then “Table format..." from the Edit menu.

table tool from the tool palette. drag the cursor diagonally to create a In the "Table Format” dialog box, type

rectangle the size of your table. the number of rows and columns you

want, and then click “OK.”

4 5 6

_ ET aad; Praefectus Rector made Praefectus Rector

Eques Curator Import text... #1 eee Cee
Curator Opifex Operarius

Qpifex Operarius Quit 380
[| Upitex Qperarius —

Click in a cell and type your text. Press When you finish entering text, choose Choose “Close” or “Quit and return

Tab to enter your text and move to the “Update” from the File menu. to” from the File menu to return to

cell on the right. Use the arrow keys to Persuasion.

navigate through cells.

Tip: Choose “Restore to original size" from the table's OLE badge popup menu to restore your table to

its Aldus Table dimensions. If you need to fit your table onto a slide using precise measurements, you can

change its height and width in the “Table format” dialog box.
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Using tables from other

applications

If the text you want to use in your

table already exists in another

application, you have two options for

using it in Aldus Table:

© Copy and paste the table text

from the source application into

Aldus Table.

e Import the file.

Text files that you import must have

these characteristics:

© Columns are separated by tab

characters.

© Rows are separated by returns.

© The file is saved in text-only (ASCII)

format.

“Import text from other applications” in

Aldus Table Online Help

"Maintaining links with other

applications” in Aldus Table Online Help
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To import table text

1 74

New

Close ey}

Update 8S

nport tex

In Aldus Table, create a table and click Choose “Import text...” from the File

an insertion point where you want the menu

upper-left table entry to appear.

Presentations v © Hard Drive

O Donatio.THT Eject

Desktop

ao
In the dialog box, locate the file you want to import, and click “Open.”



Modify table text

Use the text palette in Aldus Table The text palette

to change the text formatting in

your table.

You can modify the contents of a cell,

a row, a column, or the whole table

depending on which cell or zone

you select. | |
B (c D E F

A Font popup menu E Line-spacing buttons

B_ Type style buttons F Vertical-alignment buttons

C_ Horizontal-alignment buttons G Point size popup menu

D Character-spacing buttons

Tip: To change the default settings for font, point size, style,

alignment, or character and line space settings, choose “Text

format...” from the Edit menu, and make your changes. Then, in

the “Text format” dialog box, click the “Set default” button.

“Format table text” in Aldus Table

Online Help

“Edit your table” in Aldus Table

Online Help
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Changing table borders and

margins

Use the table palette in Aldus Table to

modify the table borders and

margins. You can change table

borders one row or column at a time

or for the whole table. You can also

change the border of a single cell by

selecting that border. Table margins

can be changed when you click the

select-all box in the upper-left corner

of the table.

Within a table, you can apply a single

color to lines and a single color to

text by using the Persuasion color

palette. Unless a colored object is

placed behind your table, it will

appear transparent and take on the

background fill of your slide.

Tip: To add colors to table lines

or text, click either the line or the

text button on Persuasion’s colors

palette, and then click a color.

To remove colors from your table

and restore it to its original color,

use the no-fill swatch.

Adding colors and fills .........0.0sees

Working with imported graphics .........

“Adding a color to tables” in Online Help
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The table palette

Table margins

Bet c
fl

A Cell border lines.

B_ Line weight popup menu.

C_ Horizontal nudge buttons.

D_ Vertical nudge buttons.

To create a background for a table

‘ 2

Advolare

Praefectus Rector

| Eques
i Opifex

is)

Curator

Operatius

Select a drawing tool, such as the

rounded-corner tool, and then draw

the shape you want.

Click the fill button on the palette, and

then click a color swatch.

ora Advolare
Send

B To front) SSF Praefectus Rector

Forward <3]
Eques Curator

Toback “S#B Opifex Operarius
Backward #2[

Choose “Send” from the Draw menu, and then choose "Backward" from the

submenu until the shape is positioned behind your table.



To change the width of the table lines

1

Select the lines you want to change by clicking a cell line or

table zone.

To change column or row margins

1

Tu

Click the select-all box in the upper-left corner of the table.

To merge table cells

1

Select the cells you want to merge together

Celt borders

oT None —

SS Hairline

In the “Cell borders” selection box, click the proxy for the cell

line you want to change, and then choose a line weight from

the “Line” popup menu.

Click the appropriate horizontal or vertical nudge button on

the table palette.

ites 82

Choose “Merge” from the Edit menu.

Tip: To make your new table borders and margins the default settings, choose “Table format..." from

the Edit menu. In the “Table format” dialog box, click “Table defaults.”
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Color basics

The Persuasion color palette consists

of three sections, giving you a wide

range of color choices and making it

easy to access to the colors you use

most often. The three sections are the

working set, the color scheme, and

the color spectrum.

Although there are specific reasons to

use colors from each section, you can

apply color to any text, line, or

graphic from any swatch in any

section on the color palette.

Change color systems for

YOUP OUIDUL:, ...c.05c00ses.s.0.sescerensssesesedies 128

“Adding colors, patterns, and shadows to

objects” in Online Help

“Using the color palette” in Online Help
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Tools for working with color

ao ERSRSS SETA SEY

A The working set allows quick access

to the colors you use most often.

B The color scheme contains both col-

ors and powerful editing and appli-

cation tools.

C The color spectrum represents colors

from a broad range of both hue and

lightness.

D Lists Persuasions color systems.

E Patterns and graduated fills. You can

color either the foreground and/or

background of a pattern.

Note: Some patterns do not image on

high-resolution film recorders. Check

with your film recorder source before

using them for a 35mm presentation.



When to use which section of the color palette

Use colors from the working set if you

want to access them from the collapsed

color palette. In the AutoTemplates that

come with Persuasion, working set colors

correspond to the first two columns of

the color scheme and are named after

their use, for example “Title” instead of

LB9.

You can copy colors into the working set

from both the color scheme and the color

spectrum.

The color scheme is a powerful tool

for changing the overall look of a presen-

tation quickly. If you edit or replace a

color swatch in the color scheme, all the

objects in your presentation colored from

that swatch reflect your change.

You can only edit colors in the color

scheme. Copy colors from the working set

or the color spectrum to the color scheme

if you want to edit them.

Since the colors in the color spectrum

do not change automatically when the

color scheme is replaced, use them when

you want to maintain consistent colors for

objects. Even if you import a new color

scheme, colors applied directly from the

color spectrum will remain unchanged.
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Adding colors and fills

In Persuasion, you can apply color

and a variety of patterns to objects

drawn in Persuasion, shadows, and

some imported objects. For example,

you can apply color to PICT graphics.

EPS graphics and scanned images

including Photo CD images cannot be

colored by Persuasion.

You can also apply color to text and

text shadows, and use different

colors for the foreground and

background of a pattern. For

example, you can create red bricks

with gray mortar using the brick

pattern.

Changing bullet style ........... cece 52

Creating a working set of colors .

Working with imported graphics

Working with shadows...
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The collapsed color palette

monwyp
7

|

J

Line button.

Fill button.

Text button.

Shadow button.

Changes the foreground or back-

ground of a line, fill, or shadow.

No fill.

Solid fill.

Collapses and expands the color

palette.

Working set colors.

Graduated fills.



To apply a fill to an object

1 2

Tip: If you've applied a pattern to an

object, you can color the background

by choosing “Fill background” from

the “Fill” popup menu, and then
. Ls

choosing a color from the color palette.

With the pointer tool, select the object Select a fill from the color palette, and

you want to fill, and then click the fill then select a color from the color palette.

button on the color palette.

To apply color to text

1 7

+

With the text tool, select the text and then click the text Select a color from the color palette.

button on the color palette.

To apply color to a text block

‘| 2

Caelum-_\e .<Caeciaim

With the pointer tool, select the text block, and then click the Select a color from the color palette.

object button on the color palette.
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Creating a working set of

colors

The working set is a handy tool

because you can work with it when

the color palette is collapsed. You can

copy colors into the working set from

either the color scheme or the color

spectrum.

When you build a working set from

colors in the color scheme, the colors

are mapped together. That is, if you

change a color scheme color, the

corresponding color in the working

set changes too.

If you’re using Persuasion’s "Stan-

dard” color system, color spectrum

colors placed directly into the

working set will not change if you

bring in a new color scheme.

Tip: When you build a working set

from colors in the color scheme

and map the colors together, if you

change a color scheme color, the

corresponding color in the working

set changes too.

Color basics

Creating a new color scheme .
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The working set

Click here for title

Gjick here for-subtitie

lick here for, body tex:

In the AutoTemplates that come with Persuasion, the names of working set colors re-

flect their application and are mapped to the colors in the left two rows of the color

scheme.

The “Edit colors” dialog box

A B Cc

Edit golors, Standagd OK )

(ancet_)

R: 100 %

G: 100 %
: @nop Ocmy F"s fenome: [TT Ousv Oms. 8: 100 %

G

The working set. F Percentages of color present in the

The color scheme. highlighted color swatch.

The color spectrum. G Color models you can match colors

Displays the Color Picker. me
H_ Renames a selected color swatch in

the working set.
monwD> Copy and paste colors between

sections of the color palette and

between presentations.



To add a color to the working set

1

Text (Emphasis

Subtitle

Line2 En

Double-click any color swatch on the color palette to open the

“Edit colors” dialog box.

Text Enmphasis

Subtitle

Ged) Regen]

5 ‘Accent &

Rename:

To copy from the color scheme, select a working set swatch

to replace, and click “Paste.”

To rename a working set color

1

Text Emphasis

Subtitle (ARH!

Double-click any color swatch on the color palette to open the

“Edit colors” dialog box.

Text Emphasis

Subtitle (ARORA

om
Line2 EXE a

an

In the “Edit colors” dialog box, select the color you want to

move into the working set, and then click “Copy.”

Peer

nename: (SEEN a)

To copy from the color spectrum and map the working set

colors to the color scheme, paste a color swatch into the color

scheme, and then copy and paste it into the working set.

Bullet

i

Ca AccentS |
Line ‘Accent6

Line Bkod
Line

kad 2
J

In the “Edit colors” dialog box, click the color in the working

set you want to rename, type the new name in the “Rename”

box, and then click “OK.”
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Matching print colors

In Persuasion, you may want to

match print colors to reproduce logos

or other colors that have precise color

values. Using the RGB color model,

you can match a print color by edit-

ing any color in the color scheme.

Understanding color models Color

graphics created for commercial

printing presses usually use the CMY,

CMYK, or HLS color models.

Persuasion uses the RGB (red, green,

blue) color model, which is the

standard for all video technology,

including computer monitors,

televisions, video screens, and film

recorders.

RGB defines color in terms of trans-

mitted light, whereas other print-

oriented color models—CMY or

HLS—for example, define color in

terms of reflected light.

OIE: DASICS sissccerssatscsniseptscsnecsnseees - 118

Working with imported graphics ......... 78

“Color and imported graphics” in

Online Help

“Color models” in Online Help
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Matching imported graphics

colors When you import a colored

graphic, its colors do not automati-

cally show up in the color palette,

but you can add them by creating

matching colors. To match a CMY or

HLS color, note the color model and

exact percentage values for the color

you want to match. For example,

note the percentage of cyan,

Tools for matching colors

magenta, and yellow in a CMY

model. Then, create a matching color

in the color scheme.

The colors will be reproduced in the

closest approximation of the CMY,

HLS, or HSV color possible.

Edit colors, Standard

G: 100 %

B: 100 %

© Aca Ocmy
Ousu Outs

A The color scheme.

The new color.

C The color models you can approxi-

mate.

D Color model percentages.

==

c D

Tip: Only color scheme colors can be

edited in the “Standard” color sys-

tem. In all other color systems, both

color scheme and color spectrum col-

ors can be edited.



To match a color

Double-click any color to open the “Edit colors” dialog box. In the “Edit colors” dialog box, click a color in the color

scheme, and then click “Edit...” to open the Color Picker.

3 ce ABER
Hue (a)

Saturation [47195 | (3)

Brightness [65535 | (3)

Red [18341 (3)

Green [45478 _|(3)

Blue |65535ue 8 Rename:

Choose a color from the wheel, or choose a color model and To name the color, copy the new color into the working set,

enter the correct values for your new color, and then click rename it, and click “OK.”

Tip: If you need to match a CMYK

color, use the brightness slider bar

on the Color Picker to approximate

the black (K) value.
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Creating a new color

scheme

When you design a presentation from

scratch, you will want to build your

own color scheme. There are three

ways to do this:

e Copy and paste any of the colors

from the color spectrum into the

color scheme.

e Edit the values of the existing

color swatches in the color

scheme.

© Copy in an entire color scheme.

Color basis .........ccceeecceeeeteetteeteeeeees 118

Creating a working set of colors ........ 122

“Using the color palette” in Online Help
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Copy and paste individual color

swatches You can use any color from

the color spectrum in your color

scheme. You copy colors into the

color spectrum the same way you

copy colors into the working set.

When you've created one or two

colors that you want to use in

another presentation, the easiest way

to transfer them is to copy them from

one presentation to another.

Replace a color scheme to change

the overall look of a color presenta-

tion quickly.

When you replace a color scheme, all

the objects colored from any swatch

on the color scheme change to match

the new color. You won't need to

reapply new colors to each object

and slide individually.

Tip: Make your color scheme

colors accessible from the

collapsed color palette by building

them into the first two columns.

When you bring new colors

into your color scheme or working

set from another color scheme,

your names will remain

unchanged.



To replace a presentation’s color scheme

1 2

D Alpha Donatio

D Beta Donatio

O Delta Donatio

ie

NE ET Replace masters...
Add master:

Copy colors...

S|

Choose “Change design” from the File menu, and then In the dialog box, select the presentation or AutoTemplate

choose “Copy colors...” from the submenu. whose colors you want to use, and then click “Open.”

To copy and paste individual color swatches

1 2 3

AREB

Open the presentation into which you In the presentation you want to copy In the “Edit colors” dialog box, select

want to copy colors, and then open the from, double-click any color on the color the color you want to copy, click

presentation from which you want to palette. “Copy,” and then click “OK.”

copy colors.

4 5

te

@ace Ocmy © [65_]*
Ousy Outs 8: |52_|%

Select the title bar of the presentation into which you want to In the “Edit colors” dialog box, select the color swatch in the

copy, and then double-click any color in the color palette. color scheme which you want the new color to replace. Click

“Paste,” and then click “OK.”
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Change color systems for

your output

Persuasion’s color systems let you

easily tailor one presentation for

several output devices. For example,

you may want to produce the same

presentation on black-and-white

overheads, on 35mm slides, and on

videotape. Instead of reassigning

individual colors to the content of

every slide each time you need to

produce your presentation on a

different output device, you can

quickly and easily switch color

systems. Except for the colors, the

presentation itself is not changed.

Note that QuickTime movies always

play using the “Standard” color

system.

You can change color systems from

either the color-system popup menu

on the color palette or by choosing

“Color systems” from the Show

menu.

Printing 35mm slides

Proofing 35mm slides

“Color systems Persuasion supports”

in Online Help

“Creating a custom color system”

in Online Help

Oo oon eerennenccsereserone
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How color systems affect changes

to colors If you edit a color scheme

color while you're working in the

“Standard” color system, your edit is

reflected in the color scheme of all

the color systems, which are subsets

of “Standard.” However, if you edit

colors in any of the other color

systems, the change will apply only to

the scheme of the color system you

edit.

Note: You cannot edit color spectrum

colors in the “Standard” color

system, but you can edit color

spectrum colors under all the other

color systems.

Use custom systems 1 or 2 to create

color systems targeted to meet

requirements of your output devices.

For example, every film recorder

reproduces colors with some slight

variations. You could create a custom

color system to accommodate those

variations

You can create and edit colors in

custom system 1 and 2 the same way

you edit colors in the “Standard”

color system.

Tip: Only colors from the

“Standard” color system colors

transfer between Macintosh and

PC environments.



Color systems and output devices

Use this color system For this output device

Standard Color monitor, projector, film recorder, color laser printer
Grayscale Grayscale monitor or laser printer -

Inverse grayscale Laser printer (prints a reversed copy of the entire slide, or of all but selected objects for
proofing) |

Black and white Laser printer (black-and-white overheads or proof prints)
NTSC US video and television
PAL European video and television :

Custom 1 and 2 Customize to suit your specific film recorder color shifts or other output device

Using color systems effectively

Suppose you create a color presentation

in the “Standard” color system that looks

good on your color monitor. Then you

learn that you need to print black-and-

white overheads. By choosing the gray-

scale or inverse grayscale color system,

you can convert the presentation to look

good in black and white. If necessary, you

edit any gray value applied under the

Standard Inverse Grayscale “Standard” color system.

Nimbus

Caelum aether

Nimbus

Caelum aether

+ triure dojor in hendrerit

- Velitesse consequat

+ Dignissim qui praesent
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Replacing custom color

systems

If you've designed a custom color

system for a specific output device,

such as a film recorder, you can use it

in any presentation by replacing a

color system with the custom one.

You can replace a specific color

system or replace all the color

systems in a presentation at once. For

example, if an international division

will produce your presentation on

video, you may want to replace all

the color systems to ensure your

presentation maintains its look

worldwide.

Color systems replace only their

same-name counterparts. If you

replace “Custom 1” while using

“NTSC,” “NTSC” is not replaced.

Only “Custom 1” is replaced.

Change color systems for

your output .. . 128
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Tools for replacing color systems

Preview

Presentations 7

D Alpha Donatio

O Beta Qonatio

= Hard Drive

D betta] All
O Gamm

© Show

System:

Grayscale an
Inverse grayscale _

Black and white

NTSC (U. S.) video

PAL (European) video

Custom 1

Custom 2

(J Replace color system edits

A

A When checked, replaces any edited

colors in the color scheme and the

color spectrum. Leave this option un-

checked if you do not want to re-

place colors you have edited.

B List of color systems. A selected

color system replaces its same-

named counterpart. “All” replaces

all the color systems.



To replace color systems

1 2 3

[= Presentations ¥ | © Bae :

OD Alpha Donatio ; D Alpha
OD Beta Donatio O Betad Grayscate :
D Belta Donatio O delta! inverse grayscalehh

Replace masters...

Rdd masters...

Copy colors...

Change design

PAL (Eurcpean) video

Custom 1

System: | Custom 2

Q Gamma Donatio Black and white

NTSC (U. S.} video

, |

. Choose “Change design” from the File Find the presentation or AutoTemplate In the dialog box, select the color :

menu, and then choose “Copy with the color system you want to use. system you want to import from the

~ colors...” from the submenu. “System” popup menu, or choose :

“All” and click “Open.”

Tip: Click “Replace color system edits” if you want to override all edits you have

made to the color spectrum of the color system you are replacing.
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Color variations between

computer monitors

When you need the colors on more

than one monitor to match exactly

(for example, if you're developing a

presentation on one monitor and

presenting it on another), you can

create a controlled environment in

which to view your presentation.

You can invest in color-calibration

hardware, such as the Radius

PrecisionColor Calibrator or the

RasterOps Calibrator, to calibrate

your monitors. You may need to

recalibrate the monitors frequently to

maintain the calibration.

You should also control the lighting

around the monitors. Avoid daylight

settings in favor of artificially lit rooms

with a constant brightness. By

carefully controlling these variables,

you can experiment more accurately

on the screen with the colors in your

presentation.

132 ALDUS PERSUASION 3.0 USER MANUAL

Factors that affect color display

Some monitors display a green or blue

tint that affects the appearance of colors.

Adjusting the monitor brightness affects

your perception of color on the monitor.

The lighting in a room affects your per-

ception of colors on the monitor.

The age and average temperature of a

monitor affect the way it displays color.
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Methods for moving things

into and out of Persuasion

When you want to include text,

graphics, or spreadsheets that were

created in other presentations or

applications in your Persuasion

presentation, you have four options:

¢ Copy and paste

e¢ Import

e OLE-embed

e Subscribe to an edition file

When you want to make slides,

outlines, or entire presentations

created in Persuasion accessible to

other applications, you have three

options:

e Copy and paste

e Export

e Publish a slide

Exporting outlines ....... eee 141

Exporting slides .......00. eee 142

Import presentations from

other applications ........... eee 138

Importing graphics ......00. eee 136

Importing text to the outline .............. 140

Object linking and embedding (OLE)... 144

Publish and subscribe .................0 146
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Using information from other applications

_ Method

~ Copying and pasting

: Importing

OLE-embedding

Subscribing

Advantages

e Fast and convenient.

¢ Most applications have copy

and paste commands.

© Works with large and small files.

¢ Allows you to use files created in applications

you don’t have access to.

e From within Persuasion, create and edit

an object using the source application.

© No additional files created.

¢ The Persuasion file reflects changes made

in the original application file.

Sharing Persuasion information

_ Method

Copying and pasting

Exporting

Publishing

Advantages

© Fast and convenient.

¢ Most applications have copy and paste

commands

e Puts Persuasion information into a format

applications can use.

* More than one other application or file can

use the same Persuasion edition file.

e Updates to the slide are reflected in the

applications using the edition file.

Use for )

Use for

¢ Simple PICT graphics

* Copying text from a word-processing

application into the outline

e EPS graphics created in graphics programs

or complex scans

¢ Presentations created in other applications

¢ Text files in ASCII format

¢ Sounds for use as slide or layer transitions

© Movies

¢ Complex graphics, charts, tables, and

spreadsheets

e Spreadsheets or graphics that are

updated regularly

* Copying a Slide from one presentation

to another or from a Persuasion presentation

to another application

* Copying text, graphics, movies, or sounds

between slides, slide masters, and presentations

e Slides you want to use in another other

application

e An outline you want to incorporate into a

word-processing file

e 35mm slides made using certain film recorders or

slide service bureaus

e On-screen presentations run on computers

using the Player

e A slide you want to incorporate in more than

one other application or Persuasion file
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Importing graphics

You can import graphics into

Persuasion from a variety of sources,

including drawing or paint programs

and clip art collections. Persuasion

accepts graphics in PICT, PICT Il,

Windows Metafile (WMF), encapsu-

lated PostScript (EPS), QuickTime, and

Photo CD formats.

Import when:

¢ agraphic is too large to copy to

the Clipboard.

e you want to use a graphic such as

clip art or a scanned image

created in an application you

don’t have access to.

¢ you want to use an EPS graphic

created in a graphics program

(such as Aldus Freehand) and you

intend to print your presentation

on a PostScript device.

About QuickTime video movies ......... 170

Methods for moving things

into and out of Persuasion ............0004. 134

Working with imported graphics ......... 78
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Locate the Photo CD image you want to import

A Folder containing files for each indi-

vidual image.

& PHOTO_cD v

IMAGES

B Catalog file you can browse for a

specific image.

"Adjust Photo CD image” dialog box

Adjust Photo CD image

(Mirror——— {Caneel} _}__¢

Ciotate7oo |p

Depth E

(@s2bits Obits

(Olbbits O2 bits

| O8 bits Ol bit

; Resolution. os oo

O64n96 @512n768

5} O128 #192 C1024 1536 |

(© 256# 384 ©2048x 3072 |
1572864

A When “Overview.PCD;1" is selected,

use the scroll bar to browse images.

B_ Size (in bytes) of the image. F The higher the resolution, the larger

C Flips the image around its vertical the dimensions of the image and the

axis. larger the file size. Choose higher

resolutions for 35mm or overhead

presentations.

E The greater the depth (bits/pixel) the

finer the color distinctions.

D_ Rotates the image in 90-degree in-

crements.



To import a Photo CD image

Choose “Import” from the File menu,

choose “Graphics...” from the

submenu, and then in the dialog box,

locate and open the Photo CD.

Select the “Overview.PCD;1” file to

browse all the images (or open the

“Images” folder and select the image you

want to import).

OMirror

0°

DOPED nn

| @ 32 bits O 4 bits

(O16 bits O2bits

'O8 bits © 1 bit

Resolution

(0644 96 @512n 768

In the “Adjust Photo CD image” dialog

box, if you selected “Overview.PCD;1"

in step 2, locate the image you want to

import, accept the default settings or

adjust the settings as needed, and then

click “OK.”

Tip: If a Photo CD includes a QuickTime file called “Slide show,” import the file and

play it for a quick preview of all the images available on the CD.

To import a PICT, PICT II, WME, or EPS graphic

From the slide, slide master, back-

ground, or note page where you want

the graphic to appear, choose

“Import” from the File menu, and then

choose “Graphics...” from the

submenu.

2

Presentations v

B Graphic

D Logo

In the dialog box, locate and select the

graphic you want to import, and then

click “Import.”
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Note: Imported graphics appear in the

center of the slide. Reposition by

dragging the graphic; resize propor-

tionally by pressing Shift and dragging

a handle.



Import presentations from

other applications

You can import presentations created

in other applications, such as

PowerPoint and DeltaGraph, that

have been saved in Scrapbook

format.

Slides saved in Scrapbook format do

not have slide masters, so when you

import a Scrapbook file into a

Persuasion presentation, you can

create a new slide master modeled

after one of the imported slides, or

you can assign an existing slide

master to the imported slides.

When Persuasion creates a slide

master from a slide, it replicates the

slide’s background fill and pattern on

the slide master, unless you indicate

that the background should be

ignored. You can select graphics and

text from the slide that you want to

place on the slide master and you can

convert the independent text from

the slide into placeholders. Graphics

and independent text that you copy

to the slide master no longer appear

on the slide.

Methods for moving things

into and out of Persuasion ................. 134

Working with slide masters and

backgrounds
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On slides to which the newly created

master is applied, text that corre-

sponds to placeholders (title, subtitle,

or body text) appears on the slides

and in the outline. Charts and tables

imported in Scrapbook files are PICTs

that you can’t edit using Aldus Chart

or Aldus Table.

The “Choose master elements” dialog box

Choose master elements

Nimbus

Caelornaeiier

© Jnuredolormnendrent

® Veltesse consequat

© Dionissim quipracsent

B Slide 4 Create master from this slide

@ Slide uses created master

(Concer)-—c

OD lide ignored items _|

Pes

A_ Displays the selected slide.

B Lists the slides from the imported

and existing presentations (imported

slides appear in roman type, existing

slides in italics, and the model slide

for the slide master is underlined).

C Cancels the new slide master. Use

when you plan to apply slide masters

already in your presentation to the

imported slides.

D Models a placeholder after selected

text.

Shows what status is assigned to

what objects.

Prevents a selected object from ap-

pearing on your new slide master.

Hides objects that won't appear on

your new slide master.

Creates a slide master from the

model slide.

Assigns the new slide master to the

selected slide.



To import a presentation

Sj Presentations ¥ 3

O Graphic

D Logo
©) Create master from this slide

Slide uses created master

From a Persuasion presentation, choose

“Import” from the File menu, and then

choose “Graphics...” from the

submenu.

“Import.”

In the dialog box, select a presentation

saved in Scrapbook format, and then click

Choose master elements

Mae

Waclonnaeiey
@litle

© Inuredolor im hendrent

On the displayed slide, select the text you want for the Title

placeholder, and then click “Title.” Repeat for each type of

placeholder you want to add to your slide master.

Slide t

Slide 2

(Create master from this sli

Bd Slide uses created master

From the popup menu, select each slide (if any) you do not

want the new slide master assigned to and uncheck “Slide

uses created master,” and then click “OK.”

In the “Choose master elements”

dialog box, select the imported slide

that you want to model a slide master

after, and then click “Create master

from this slide.”

© Subtitle

@ Body Text i

O Slide #

OStatic

@ Ignore

OHide ign

© Jnure dolor im hendrent

» Veltesse consequat

» Dgnissim qu Hee

x

Create master from this slide

@ Slide uses created master

Select each object you do not want on your slide master, and

click “Ignore.” Ignored objects still appear on the slide.

Tip: If you choose not to assign the newly created slide master

to an imported slide, that slide will have no slide master and it

will keep its original background fill as an object. If you assign

a slide master to the slide, you will need to select and delete

the background fill in order to see the background fill of the

slide master.
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Importing text to the

outline

When you’ve created text in another

application that you want to use in

your Persuasion presentation, you can

import the text into the outline.

Before you import the text, save it in

text-only (ASCII) format, which

retains return and tab characters but

not formatting instructions, such as

font, point size, and text style. You

can reformat the text after you

import it into Persuasion.

To preserve the relationship between

headings of different levels in an out-

line imported from a word-processing

file, tab to indicate subordinate

points. Persuasion translates return

characters without tab characters into

new headings.

Note: You can also import text

directly onto a slide as independent

text. You can select and format it, but

it won‘t appear in the outline.

Methods for moving things

into and out of Persuasion ................. 134

Outline your presentation

TO SAVE TIME ooo eeeeteeeteeseseteeeeees 62
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0 importtext.
~

~ Click an insertion point in the outline
__ where you want the imported text to

- Start, choose “Import” from the File

Graphics...

Text...

Sounds...

Movies...

| Menu, and then choose “Text...” from

~ the

Wan nan

submenu.

Note: If you click an insertion point in ah

\€9 Presentations vy |

eS

©]

_ In the import dialog box, locate the file

~ you want to import, and then click

“Import.”

eading that includes subordinate

headings, the text is imported after the subordinate headings.

a_i ne ta

1
fi

\

roa Sa a SO



Exporting outlines

Exporting an outline means saving it

in a file format that other programs

can use. Usually, you'll export outlines

in text-only (ASCII) format since most

word-processing applications can

read text-only files. Persuasion also

gives you the option of exporting in

formats the outline applications Acta

and More can read.

Outline your presentation

to save time

Rearrange information

in the outline

Options for exporting an outline

— (_Enport_)
Seantaien)& Presentations

DB Donatio i]

D Graphic =

a Nie : Desktop

D Presentation ie © Hard Drive

O Sound

O Spreadsheet [S| Export:

Presentation.THT _| Lintire outline +—_4—c

File format: Slide options:

A} {ET TS] © P0ckaround
jActa O Separate layers

B |More Package movies
S| Cl Fewer colors

A The format most word-processing C Export the entire outline or selected

applications can read. parts of an outline.

B_ Formats for specific outline applica-

tions.

To export part or all of an outline

4 Inthe outline, select the text you Ea

want to export. o Donatio :

2 Choose “Export...” from the File 1 Eabsntes H
wfTe feugait ;

= JDolore magna:

2 Aether :

© §Lorem ipsurn i

menu.

3. Inthe “Export” dialog box, select

“Outline selection” or “Entire

outline” from the popup menu,

enter the filename and choose

the format, and then click

“Export.”
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Exporting slides

By exporting one or more of your

Slides in PICT format, you can place

them into another application file,

such as a PageMaker document.

If you develop 35mm slide presenta-

tions, you may also need to export

your Persuasion slides in PICT or

Scrapbook format before the slides

can be produced. Ask your service

provider or read the documentation

for your film recorder to determine

the correct format for your files.

Options for exporting slides

upon [ox__
[a Presentations v

D Graphic nnn 2.

D Logo

D preeeC Presentation Desktop
CO Sound © Hard Drive
C Spreadsheet

D Tent Export:

| | [Current slide }———-—p

File format: Slide options:

A— fd Background fill ——F

Scrapbook (System 6) Separate layers /_. &

B Scrapbook (System 7) CO Package movies L—G
Cc Stide show (] Fewer cotors H

A Saves each slide or layer as a sepa- F Exports a separate slide for each

rate PICT file, even when you export

all your slides.

B_ Groups all slides and layers into one G

file.

C Format for slides you want to show

using the Player.

D Exports the current slide, all slides, or 4

all note pages.

E &xports background fill with the

slide. When unchecked, the slides

are transparent.

Exporting outlines ......... cece 141

Printing 35mm slides «00.0.0... eee 208

What is the Persuasion Player? .......... 184

142 ALDUS PERSUASION 3.0 USER MANUAL

layer. Each slide includes the current

and all previous layers.

Puts all movies and sounds in your

presentation into one QuickTime file

(available only with “Slide show” file

format).

Exports a PICT or Scrapbook file for

use on a 16-color monitor.



To export one or all slides

1 2

OG Presentation
Entire outline

O Sound

O Spreadsheet =] an mee a
D Tent ie] Pee ess

Donatio.PICT ] Current slide

Slide options:

& Background fill

& Separate layers ;

OPackage movies

File format:

Scrapbook (System 6)

Scrapbook (System ?)

Slide show <>} (1 Fewer colors

In the “Export” dialog box, select “Current slide” or “All

slides” from the popup menu, choose the file format, and

then click “Export.”

From a slide, choose “Export...” from the File menu. To export

one slide, make sure the slide you want to export is displayed.

Tip: To export your note pages, follow the procedure for exporting a slide but start on a

note page and choose “Current note” or “All note pages” from the popup menu.

To export selected slides

Donatio.PICT Selected slides

File format: Slide options:

(& Background fill

& Separate layers

OPackage movies

CO Fewer colors

Scrapbook (System 6)

Scrapbook (System ?)

Slide show

In the “Export” dialog box, choose the appropriate file formatIn the slide sorter, hold down the shift key and select the slides

and slide options, and then click “Export.”you want to export, and then choose “Export...” from the File

menu.

CHAPTER 8: MOVING THINGS INTO AND OUT OF PERSUASION 143



Object linking and

embedding (OLE)

When you OLE-embed an object in

Persuasion, the object retains its

connection to the application in

which it was created (the source

application). This means that from

within Persuasion, you can create

and/or edit the object using the

source application.

For example, you can OLE-embed a

graphic created in Aldus IntelliDraw

ona slide. When you edit the

graphic, you open IntelliDraw

without leaving Persuasion. Edits you

make in IntelliDraw appear in the

OLE-embedded graphic on the slide.

You can OLE-embed anything created

in an application that supports OLE.

You can also simultaneously create

and OLE-embed an object by opening

the source application from within

Persuasion. Charts and tables you

develop within Persuasion are OLE-

embedded objects that you create

using Aldus Chart and Aldus Table.

Note: Persuasion 3.0 for the

Macintosh is an OLE client application

that supports OLE-embedding only.

94Adding a chart to your slide. :

AOAdding a table on a slide ...

Methods for moving things

into and out of Persuasion ................ 134

“How to edit OLE objects in Persuasion”

in Online Help
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Tools for creating and editing OLE-embedded objects

Redraw

Rename...

Convert to picture

Autocontrast

Cc

J tot —— D

Restore to original size

roe

mi

iG

Peal

A Expands or collapses the tool palette.

Tools for the applications that sup-

port OLE-embedding.

Displays the badge popup menu

when selected.

Opens the source application.

Redraws charts and tables to elimi-

nate distortion after you resize them.

Allows you to rename your object.

Converts the object to a PICT that

you can ungroup.

Restores the object to its original

size.

With color system settings of

“Grayscale,” “Inverse Grayscale,” or

“Black and White,” adjusts shading

so you can tell adjacent bars apart

when they're printed.



To create and OLE-embed an object

1

Advolare

Open a Persuasion presentation, and

* display the slide on which you want the

object placed.

Advolare

Expand the tool palette, select the tool

for the source application, and then click

an insertion point on your slide, or draw a

rectangle the size of the object.

To OLE-embed an object you have already created

1

In the source application, copy the

object to the Clipboard.

2

Open a Persuasion presentation. From

the slide where you want the object

placed, choose “Paste special...” from

the Edit menu.

Advolare

When the source application opens,

create the object, choose “Close” from

the File menu, and then click “Update”

when prompted.

SS Paste special

Format

In the “Paste special” dialog box,

select the format appropriate for the

object's source application, and then

click "OK."

Note: If you choose a format other than the one appropriate for the object's source application (for example, “Picture” for an

IntelliDraw graphic) the object is pasted rather than OLE-embedded.
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Publish and subscribe

Publishing an object makes an edition

file containing that object available to

other applications. Subscribing allows

an application to use an edition file.

Publish an object when you revise it

frequently and/or when you want to

include it in more than one other

application.

When you publish an edition file, you

can subscribe to it from as many

other files as you want. You can

decide to have modifications you

make in the publishing file automati-

cally appear in the edition file and in

all of its subscribers.

Persuasion can both publish and

subscribe. For example, you can

publish a slide you want to include in

both a PageMaker and a Microsoft

Word document, and you can

subscribe to an Aldus FreeHand

graphic that you want to include in a

Persuasion presentation.

Methods for moving things

into and out of Persuasion ................. 134

@ The publishing file contains the object you publish as an edition file. @ The edition

file 1s a separate file created when you publish an object. @ The subscribing file is the

file in which you place the edition file. @ The subscriber is the object that appears in the

subscribing file when you subscribe to an edition.
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To publish a slide

Undo paste #2

Create publisher...

From the slide you want to publish,

choose “Editions” from the Edit menu,

and then choose “Create publisher

from the submenu.

To subscribe to an edition

1

Undo paste #2

Presentations ¥

Name of new edition:

Donatio Edition <1>

In the dialog box, decide where to

save the edition file, type its name,

and then click “Publish.”

Subscribe to...

From the slide you want to place the edition on, choose

“Editions” from the Edit menu, and then choose “Subscribe

to..." from the submenu

Sas!

Save changes to your presentation to

save the slide as an edition file.

Presentations ¥

© Donatio Edition <1>

|

by

In the dialog box, locate and select the edition you want to

subscribe to, and then click “Subscribe.”

CHAPTER 8: MOVING THINGS INTO AND OUT OF PERSUASION 147



Updating edition files and

subscribers

After you publish an edition file, you

can decide whether to update it

automatically each time you change

the publishing file or only when you

specify.

After you subscribe to an edition file,

you can decide whether the sub-

scriber will be updated automatically

every time the edition file is updated

or only when you specify. You can

also launch the application that

produced the original file and the

edition file and modify the original

without leaving Persuasion.
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Options for updating edition files

Publisher to: | Donatio Edition<1> v}

-~Send Editions:

@ On Save
( Cancel Publisher }+}—

© Manually [ Send Edition Now }

Latest Edition: Thursday, September 9, 1993 10:16:12

A Updates the edition file every time

you save changes in the publishing

file.

B_ Lets you control when Persuasion

updates the edition file.

Options for updating subscribers

C Deletes the edition file. Subscribing

files retain unlinked copies of the

edition file.

D Updates the edition file.

Subscriber to: |© Donatio Edition<1> |

~Get Editions:

@ Rutomatically
( Cancel Subscriber }-j—©

© Manually { Get Edition Now ) ("Open Publisher Jy — D

Latest Edition: Thursday, September 9, 1993 10:16:12

A Updates the subscriber in Persuasion

automatically every time you update

the edition file.

B_ Lets you control updates to the sub-

scriber.

C Breaks the link between Persuasion

and the edition file.

D Opens the publishing file where you

created and published the original

object.

E Updates the subscriber in

Persuasion.



To define when an edition file will be updated

1

Publisher options... —

From the slide defined as a publisher,

choose “Editions” from the Edit menu,

and then choose “Publisher op-

tions...” from the submenu.

2

Send Editions:

@ On Save

© Manually

In the dialog box, select the “Send

Editions” options you want, and then

click “OK.”

| To define when a subscriber will be updated

Get edition now

Open publisher

Cancel publisher

Subscriber options...

Double-click the subscriber (or click the

badge and choose “Subscriber

options...” from the popup menu).

To modify a subscriber

oa|_ Get edition now

i Cancel publisher

Subscriber options...

Select the subscriber’s badge, and

then choose “Open publisher” from

the popup menu.

2

Get Editions:

@ Rutomatically

O Manually

In the subscriber options dialog box,

select the “Get Editions” options you

want, and then click “OK.”

In the publishing file, modify the original

object, choose “Save” from the File

menu, and then choose “Quit” or return

to Persuasion 3.0.

_ If you‘re updating the subscriber

click “Send Edition Now” in the

To udpate an edition file manually, )

publisher-options dialog box. |

To update a subscriber manually, click !

“Get Edition Now” in the subscriber

options dialog box or choose it from

the popup menu on the badge.

Pet tation sont

manually, select the badge on the

object and choose “Get Edition Now

from the popup menu.

"
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Transferring files between

Macintosh and Windows

When you need to revise or edit a

presentation or AutoTemplate on

another platform, save it as an

interchange file before you transfer it

between platforms. (If you only want

to play, not edit, a Macintosh

presentation in Windows, export the

presentation as a Player file).

When you transfer Persuasion 3.0

presentations between the Macintosh

and Windows, all masters transfer. By

planning ahead, you can adjust the

few features that change between

platforms.

If you transfer presentations fre-

quently, create compatible

AutoTemplates on each platform that

adjust for feature differences. When

you transfer a presentation created in

a compatible AutoTemplate, open it

in the equivalent AutoTemplate on

the other platform.

To preview how your presentation or

AutoTemplate will look on the new

platform, save it as an interchange

file and then open it on the platform

where you created it. You can then

make adjustments before you

transfer the file.

Creating Player files...ee eeeeeee 186

What is the Persuasion Player? .......... 184

"Creating a pair of compatible

AutoTemplates” in Online Help
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Adjustments for successful file transfer

: Both ways

| Fonts

_ Organization charts

_ Lines with arrow heads or other

' endcaps

~ Object shadows

Object linking and embedding (OLE)

(except for charts and tables created in

Aldus Chart and Aldus Table)

Transition effects for slides or slide layers

Movies and sounds

Animated objects and autojumps

EPS graphics

Adjustment

Since font substitutions occur when

fonts are not available on both

platforms, use fonts known to be

available on both platforms.

Organization charts convert to the

destination’s placeholder style, so

reformat them on the destination

platform.

Reapply endcaps in the destination

platform.

Reapply shadows in the destination

platform.

If the same application is not available on ,

the destination platform, convert the |

OLE-embedded object to a PICT,

ungroup it, and then transfer it.

Reapply transition effects in the

destination platform.

Add movies and sounds in the

destination platform.

Reapply animation and reset autojumps

in the destination platform.

Transfer the graphics to the destination

platform and import them.



From Macintosh to Windows

~ Multiple backgrounds

. Different master orientations (wide or tall)

Page number placeholders

Bullets applied to independent text using

the “Bullet” command

Patterned lines

PICT graphics

From Windows to Macintosh

Multiple body text placeholders convert to one large body

text placeholder

Multiple organization chart placeholders convert to one

organization chart placeholder

Breaks in the outline become blank lines

TIFF and other bitmaps (such as BMP and PCX)

Windows metafile (WMF) graphics

Adjustment

presentation.

Transferring files between Macintosh and Windows

| | !

Adjustment

Backgrounds other than “Background” are converted to slide

masters so apply “Background” to all your slides before you

transfer.

Only the most-used orientation transfers, sso orient all your slides
the same way|before you transfer.

.

Reapply page numbersin Windows.
|

Add bullets to independent text by typing Option 4+8 before
you transfer the file or add bulletsin Windows.

Use only solid linesin presentations you intend to transfer.

Transfer separately and then import into Persuasion forWindows.

ateeeelIn the Macintosh file, convert the text from the second body text
placeholder into independent text, and place it where you want

iton the slide.

Place the organization charts on separate slides before |
transferring.

Delete the blank linesin the Macintosh outline.

if possible, use other graphics formats; or, export the original
graphicin Windows metafile format (WMF), transfer it to

a Macintosh separately, and then import it into a Persuasion

Transfer separately and then import into «a Persuasion
presentation.
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Transferring files between Macintosh and Windows

To transfer a Macintosh presentation or AutoTemplate to Windows

1

Open the presentation or

AutoTemplate, and then choose “Save

as...” from the File menu.

2)

@® Presentation

© futoTemplate
v Persuasion 3.0

Persuasion 2.1

Persuasion 2.0

Persuasion 1.0

Interchange file

In the dialog box, select “Interchange

file” from the “Format” popup menu,

and then select either “Presentation” or

“AutoTemplate.”

Move the interchange file from the Macintosh to Windows

using any linking program, such as Apple File Exchange or a

shared server, and then open the interchange file in

Persuasion 3.0 for Windows.
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then click “OK.”

Save as:

Donatio.prt

Format: | Interchange

Type a name of no more than eight

characters for your file, add a .prf (for a

presentation) or .atf (for an

AutoTemplate) extension (for example,

BlueOH.atf), and then click “Save.”

If the “Interchange master selection” dialog box appears,

choose an AutoTemplate in which you want the interchange

file to open or use masters from the interchange file itself, and



To transfer a Windows presentation or AutoTemplate to a Macintosh

1

In Persuasion 3.0 for Windows, create

the presentation or AutoTemplate you

Transferring files between a Macintosh and Windows

2

& Presentations

O Presentation

Open: © Original @©Copy

In Persuasion 3.0 for the Macintosh,

choose “Open presentation” from the

startup screen, and then, in the open

3 where is the
AutoTemplate Donatio for

Presentation “Donatio.pri”?

© Autotemplates v

D Basic35

D Beach35

O Blinds35

D Book35

O Bubbis35

O Cnfeti3s

O Cones35

O Diamnd35

If the “Where is the AutoTemplate”

dialog box appears, choose the

AutoTemplate in which you want thewant to transfer, save it as a Persuasion

interchange file, and move it to a

Macintosh using any linking program.

interchange file to open or click “Give

up” to use masters from the inter-

change file, and then click “Open.”

dialog box, select the interchange file you

want to open.

Tip: To use the slide masters from the file you're transferring, transfer the file as an AutoTemplate. Then Persuasion won't ask

you to locate an AutoTemplate on the destination platform.
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CHAPTER

S,
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Creating

On-screen

Presentations



Layering slides

Adding layers to your slides is an L inginP %

effective way to present information. Ay Sing in.cerstasion

In Persuasion, you can create up to

30 layers per slide and you can set

transition effects for each layer.

You don’t need to decide immedi-

ately what information goes on each

layer; you can enter all the informa-

tion on one layer and then assign

individual layers to objects and text

later. You can also hide some layers

while you're working to simplify your

work, and you can set or change Nimbue

layer assignments at any time. Nimbus
‘aolum aethe i

Caclum aether 
Nimbusal

Caelum aether \
+ Iriure dolor in hendn Caelum aether &

+ Inure dolorin hendr

* Velitesse consequal 4 lips tok
+ Walite

+ Dignissim qui praesent

Use layers to present related information sequentially, emphasizing each idea in turn.

Animating slide objects ...........ccee 160

Autolayering and highlighting

information

Transition effects for slides

and slide layers ...

“Layering slides” in Online Help
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The Layer menu

A Shows the current drawing layer.

B_ The first number is the current draw-

. . ing layer, and the second number (in

brackets) is the layer of the selected

First visual effect object.
First sound effect

Layer visibilit:

Set layer

To assign text or graphics to a layer

Nimbus : Nimbus
Caelum aether BBs Calum aether

“+ Iriure dolorin hendrerit © + Iriure dolor in hendrerit

. Velit esse consequat > Velit esse consequat

* Dignissim qui praesent * Dignissim qui praesent

First visual effect

Select the text or graphics you want to move to a specific layer. Choose “Set layer” from the Layer menu at the bottom of the

Use the text tool to layer individual parts of a text block. Use window, and then select a number from the submenu.

the pointer tool to layer the entire text block.
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Autolayering and

highlighting information

Highlighting layered information is an

excellent way to emphasize informa-

tion. It creates a focus for your

audience yet demonstrates the

relationship between several ideas.

With Persuasion, you can automati-

cally layer a bulleted list, a block of

text, a chart, a table, or an organiza-

tion chart. You can also layer an entire

placeholder on a slide master. Then,

every time you use that placeholder

on a slide, each bullet of text, level of

organization chart, or data series in a

chart will be automatically layered.

You can layer text in three ways:

creating a cumulative effect, display-

ing your text all at once, or using a

combination of both effects.

Layering Slid@S 0.0... eeeeee 156

Running your on-screen presentation ... 180

Transition effects for slides

and slide layers .........ccc ec eeeeees 164
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“Text autolayer” dialog box

Text eutolayer

Create layers:

A @ None

B——__ Ofer each paragraph

C—T— OFor each topic

Layer effects:

® Cumulative

_——————

=a

E——+—__ O Highlighted

F—]— Oven

one one two one two three

A Leaves all text on a single layer.

Displays single paragraphs of text as

individual layers.

Displays each first-level head and its

subordinate levels together on the

same layer.

Displays only the first layer and then

adds each successive layer one at a

time.

Displays all layers, highlighting one

layer at a time while dimming the

other layers. After the last layer is

highlighted, all layers are high-

lighted.

Displays only the first highlighted

layer. A highlighted layer is added

one at a time, as the previous layer is

dimmed. After the last layer is high-

lighted, all the layers are high-

lighted.

Colors for text that is not high-

lighted (dimmed).



To add autolayers and highlights

With the pointer tool, select what you

want to highlight and layer, and then

choose “Autolayer...” from the Draw

menu.

Click “OK” when you have selected the

options you need.

Create layers:

© None

@ For each paragraph

O For each topic

In the autolayer dialog box, select an

option from “Create layers.”

Slide show ————_ .
Preview current slide,

To see your effects, choose “Slide show”

from the View menu, and then choose

“Preview current slide” from the

submenu. Press Command + . (period) to

end the slide show.
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Cotor of dimmed items:

Layer effects: pos

© Cumulative

@ Highlighted

© Both

If you are creating highlighted layers

for text, select a highlight from the

“Layer effects” option. Select a color

for dimmed layers by clicking “Color

of dimmed items,” and then selecting

a color.

Tip: If your layers do not appear,

choose “Slide show” from the View

menu, and then choose “Show all

slides” from the submenu. In the

“Show all slides” dialog box, check

“Layers.”



Animating slide objects

Animation—where an object moves Once an object is animated, it is

across the screen—adds action to labeled with an animation badge,

your presentation and quickly draws from which you can do basic anima-

attention to the animated object. tion editing. Animation badges can

be displayed on slides using the Show

You can animate text and graphics on — menu and can be hidden or displayed

a slide as well as placeholders on slide — when giving the presentation.

masters. If your text block, place-

holder, table, or chart is layered, each

piece will animate in a top-to-bottom

or left-to-right sequence. In an on-

screen presentation, you can use

animation to create a “rolling credits” By ®

effect in your presentation, where

words scroll onto the screen and then

off the screen again.

Editing animations using the animation badge

After an object is animated, you can click

its badge and edit the animation from the

Hi popup menu.

Direction

Speed

Play area
You can set animation so that an :

object either enters or exits from the

screen. You can also set different

animation speeds, and you can

determine whether the object moves Remove auto-animation

across the full screen or within a

specific area.

vvyv
Edit auto-animation...

Layering slides 156

Running your on-screen presentation ... 180

Transition effects for slides

ANA Sle IAYEMS: cv. .stuccsnsnssassresvesneeateses 164
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To animate slide objects

Direction:

Enter from right

Speed:

Play area:

Cropped

In the “Autoanimate” dialog box, select

Using the pointer tool, select the object Choose “Autoanimate..." from the Draw —_ a direction, speed, and play area for the

or placeholder you want to animate. menu. animation, and then click “OK.”

To create a “rolling credits” effect

1 2 3

* Itiure dolorin hendrerit

+ Velit esse consequat

* Dignissim qui praesent

Using the pointer tool, select the text Drag the text block so that the top Choose “Autoanimate...” from the

block you want to animate. touches the bottom edge of the slide. Draw menu,

4 5

Direction:

Outline

Speed:

Cr area: iH Preview current slide

In the “Autoanimate” dialog box, set the direction to “Exit to To view the animation, choose “Slide show” from the File

top," set the speed to "Slow," and set the play area to “Full menu, and then choose “Preview current slide” from the

screen,” and then click “OK.” submenu. Press Command+ . (period) to exit the slide show.
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Creating jumps within a

presentation

When you have reference slides or

material from another application

that may enhance your presentation,

you can display this information by

using autojumps. You can also use

autojumps to create self-paced,

interactive presentations.

You can create jumps to another slide

or slide layer, to another application,

or to a Player file. After the jump,

you can return to the slide from

which you jumped. When you jump

to a Player file, all the slides in that

file are shown unless you create a

return jump.

You can set up jumps in both manual

and automatic slide shows, and you

can create an unlimited number of

jumps on each slide or slide layer. An

autojump object or area is labeled

with an autojump badge from which

you can edit jumps. Badges can be

turned on or off through the Show

menu.

Tip: Preview jumps by choosing

“Slide show” from the View menu,

and then selecting “Show all slides."

Run multiple Player files ..........0.0.00. 196
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Jump between slides, Player presentations, or other applications

Nimbus

Aether Caelum aether chees
> inure dolor in hendrerit

+ Velit esse consequat

> Lorem ipsum dolor sit + Dignissim qui praesent

+ Elitsedidiam nonum

» Tincidunt ut laoreet xy

You can turn any object or area on a slide or slide layer into a “hotspot” for a jump.

During a slide show, you click the hotspot to jump to another slide or presentation. (The

pointer turns into a hand icon when it passes over the hotspot.) The Persuasion 3.0 tu-

torial uses the Autojump feature extensively.

The “Autojump” dialog box

Auto jump { OK )

A —j—O No jump

B —j}-—® vump to slide

Layer: [ First layer

C —f ump and return

D —}—O uump to Player presentation

E —}—O bpen application/document

A Removes an autojump from an ob- C Creates a return to the originating

ject or area. slide after a jump to another slide in

B_ Enables options to jump to a particu- the same presentation is completed.

lar slide or slide layer. D Sets up a jump to a Persuasion

Player file.

E Sets up a jump into another applica-

tion or document.



To create a jump to another slide

‘l 2 .

J Autojumpa @ Jump to slide
Slide:

With the pointer tool, select an object from which you want to In the "Autojump” dialog box, select the options you want,

jump, and then choose “Autojump..." from the Draw menu. and then click “OK.” When you select “First layer,” only the

first layer in that slide will be shown. When you select “Last

layer” all layers are shown.

To create a jump to a Player file or an application

1 2 2)
Jump to Player presentation

@ Jump to player presentation
& Presentations V

—- } O advolare.ppf
© Open application/document : D aether.ppf

D donatic.ppf

With the pointer tool, select an object In the “Autojump” dialog box, select a In the dialog box, select the file you

from which you want to jump, and destination, and then click “Choose....” want, click “Open, ” and then click

then choose “Autojump...” from the “OK.”

Draw menu.

To create an area on your slide from which to jump

Select the autojump tool from the tool HUNTON COME RRR GM On| WER CMNU KO:

palette and create a rectangle on the i

slide by clicking the upper-left corner

of the proposed hotspot and dragging

diagonally. When you release the

mouse button, the “Autojump”

dialog box will appear. Select desired

options and click “OK.”
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Transition effects for slides

and slide layers

Slide transitions determine how a

slide or slide layer opens on the

screen. To create a smooth flow

between slides and add interest to a

presentation, you can add visual and

sound effects to slide transitions. You

can set transition effects for indi-

vidual slides, or you can set default

transition effects for an entire

presentation. You can also set the

time the slide or layer will display.

The “Fade” transition is available

when the color palette is limited to

256 colors (known as 8-bit color

mode). It is not available when the

color palette has access to thousands

of colors (16-bit color mode) or

millions of colors (24-bit color mode).

Tip: To preview transition effects,

choose “Slide show” from the View

menu and then select “Preview

current slide” or “Show all

slides...”

Adding and editing sounds............0.. 168

Autolayering and highlighting

information

Bringing QuickTime movies

into Persuasion

Layering slides .

Sound transition effects for slides

and slide layers ...
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The “Transitions” dialog box for visual effects

Transitions

Stide Delay

AS] 1 Slide 1

2 Slide2

Use defaults

Delay between slides: (2 ]seconds Edit sound...

During sound

Layer ___Visual effect Delay Sound effect playback

B

c= [None
: D

Wipe left

Wipe right

Wipe up

Wipe down

To center

| Open curtain
Close curtain

Blinds down

Blinds left

Glitter right

Glitter down

Glitter across

¥

A Lists all the slides in the current pre-

sentation and shows the slide num-

ber and display time between each

slide.

B Lists the layers for the currently se-

lected slide and their settings.

C Displays the “Visual effect” menu.

D_ Indicates the delay time (in seconds)

between each transition.

E Displays the “Layer delay” dialog

box after you have selected a layer

and then selected “Other...” from

the “Delay” popup menu.

Note: An asterisk (*) next to a setting

indicates that it is the default setting.



1

|

|
i

To add a visual effect to:a slideor slide layer

Slide shaw

from the submenu.

i

' Select a transition effect from the “Visual effect” popup menu.

Transitions...

Choose “Slide show” from the View

menu, and then select “Transitions...”

2

Transitions
Layer Visual effect Delay

Stide

1 Slide 1

In the “Transitions” dialog box, select the To apply the transition to the whole

slide you want to apply a transition to slide, select Layer 1 in the “Layer” list

from the slide list box.

Layer Visual effect

ipe left

None

Wipe feft

Wipe right

Wipe down

To center

Open curtain

box. To apply the transition to another

slide layer, select the layer.

Layer Visual effect Delay

\ipe left 1

None

Other...

| Wipe up 1

3
4

5

- Click the “Delay” popup menu, select the desired delay time

(in seconds) and then click “OK.”
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Sound transition effects for

slides and slide layers

Sound used in slide transitions adds

another dimension to a presentation.

You can create transitions for

individual slides and slide layers, or

you can set default transition effects

that apply to your entire presenta-

tion. Using sounds in Persuasion

requires the System extension

QuickTime 1.6 or later.

You can import any QuickTime movie

with sound to create transitions on

slides or slide layers. You can also

import sounds in AIFF format, System

7 (sfil format) sounds, and audio CDs

(with appropriate equipment), which

Persuasion converts to QuickTime

sound-only movies.

Tip: To set default sound

transitions for the entire

presentation, choose “Slide show”

from the View menu, and then

select “Set default transitions...”

from the submenu.

Adding and editing sounds................ 168

Autolayering and highlighting

INFOPMATION 0.0... eee ecceeccteeteeteeteeseeeens 158

Bringing QuickTime movies

INTO PErsUASION ........ eee eceeeeteeetereeeeees 172

Layering slides... se eeeeeeeeeenseees 156

Transition effects for slides

and slide layers...ce eeeeeeeeeeneees 164
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The “Transitions” dialog box for sound effects

Transitions

Stide

2 Slide 2

Use defaults

Visual effect

Delay between stides: (2 _| seconds Edit sound

During sound

playbackSound effect

A_ Adds sound effects to a slide or

slide layer.

B Determines how the sound transi-

tion affects subsequent layers.

3

2 + None 1 None 1
3 # None 1 None ie A

| Wipe left | 1 || None ° || Wait B

| i

{

Import... em|WaitDetete unused...

None

C Plays sound completely before the

next layer or transition effect occurs

(“Wait"), or plays sound while other

slides and slide layers are shown

(“Continue”).

Note: An asterisk (*) next to a setting

indicates that it is the default setting.



To set a sound effect to a slide or slide layer

1 2 3

Transitions

Slide

1 Slide t

Choose “Slide show” from the View In the “Transitions” dialog box, select the | To add a sound effect that will play

menu, and then select "Transitions..." slide you want to apply a transition to when the slide opens, select Layer 1 in

from the submenu. from the slide list box. the “Layer” list box. To apply a sound

effect to another slide layer, select

that layer.

4 5

Import...
Delete unused...

|

(None ja | souna.ar ]|_wait |

None

sound 2

ound.d

Select a sound from the “Sound effect” popup menu, or select Select an option from the “During sound playback” popup

“Import...” to add a sound to this list. menu, and click “OK.”
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Adding and editing sounds

You can use sound as a transition

between slides or slide layers, and

you can place sound directly on the

Slide so it will play when the slide or

slide layer becomes active. Persuasion

can directly import QuickTime sound-

only movies. When you import other

sound formats—AlFF, System 7 (sfil

format), or audio CDs (with appropri-

ate equipment)—Persuasion creates a

QuickTime sound-only movie from

the sound.

A QuickTime sound-only movie

added to slides will play when the

layer it is on is displayed. A sound

placed on the first layer of a slide is a

transition sound that will play when

the slide first appears.

After you import sounds, you can

adjust the volume, play time, and

play sequence. You can edit sounds

using the QuickTime playbar and

slider that you use to edit QuickTime

movie sequences.

About QuickTime video movies ......... 170

Bringing QuickTime movies into

POPSUASION .......... cee ceecceecccesenecsccesecaeees 172

Transition effects for slides

ANd Slide layers ....... eee ees eeseeereees 164
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To add a sound to a slide

1

Display the slide or slide layer where

you want to place the sound. Choose

“Import” from the File menu, and

then choose “Sounds...” from the

submenu.

Select the sound file you want to

import. If the sound is a QuickTime

sound-only movie, click “Import,”

otherwise, click “Convert....”

3

If the sound is not QuickTime, provide

a name in the import dialog box for

the QuickTime sound-only movie that

will be created referencing the sound

and click “Save.”

L'RDOrt ears

: iort.
Graphics...

Tent...

Sounds...

|€a sounds v|

PO sound
BD sound 2 |

D sound.gt

hj Show preview

| sounds wl

Q Sound

D seund 2

D sound.Qt

Save converted file as:



To edit the play sequence of a sound

1

Outline

Choose “Slide show” from the View

menu, and then select “Transitions...”

from the submenu.

Delay __Sound effect

[None

In the “Transitions” dialog box, select a

slide from the “Slide” list box, and then

select a layer from the Layer list box that

has a sound assigned to it.

4 5

Edit sound Edit sound

Name: Neme: [sounaat]

eea>) SSS}

shift

In the “Edit sound” dialog box, press

Shift and drag the slider bar over the

section you want to copy or delete.

To copy the selected section, press

Command + C. Move the slider to the

point where you want to insert, and press

Command + V. To delete the section,

press Command + X.

Use defaults

CIES

Select “Edit sound..."

Click “OK” in both dialog boxes.

Tip: You can set the volume for a sound in the “Edit sound” dialog box by clicking the

volume control button on the slider bar and adjusting the volume slider.
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About QuickTime video

movies

Persuasion 3.0 lets you add Recommended hardware and software

QuickTime movies to your slides, slide

masters, and backgrounds. Item Recommended

ee 7 Processor 68030 or later

eQuickTime is an extension to th RAM 8MB

Apple Macintosh operating system -

that lets you put animation, video, Operating system 7.0.1 or later
JPEG compressed PICTs, and sound Memory allocated to Persuasion 3.5 to 6MB

into your Macintosh files. You must QuickTime software Version 1.6 or later
have the QuickTime extension in your

Extensions folder in your System

folder to use the “movie” (MooV) file

format. Like other graphics, you can

import or paste movie files into

Persuasion. You can also copy movies 5 . . an ;
between slides within a presentation. Add impact to your presentations with QuickTime video movies

Training: Show a video of parts assem-

bly, a product in use, or animated graph-

ics of a complex process.

Marketing: Show a taped message from

a VIP, a video clip of a testimonial, or a

cartoon animation.

Tip: To view information about

movies and sounds in your

presentation, choose “Movie

info..." from the File menu.

Adding and editing sounds................ 168

Bringing QuickTime movies into

Persuasion .

Setting up a movie in Persuasion

Transition effects for slides

ANG SWCe layers vctes Pserereucsscveseromeues 164
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Parts of a QuickTime movie

“Movie information” dialog box

A

z vie information

Movie title

Selected movies

Overall totals

Cc D

The poster frame is the image that

displays when the movie is not run-

ning. It is also the image shown

when the slide is printed.

The badge labels the movie and

contains a popup menu for editing

or getting information about the

movie.

The movie frame is the area in

which the movie will play.

Lists all movies in the presentation,

including sound-only movies.

Shows the size, duration, and dis-

play size of the movie.

Displays the file size used by

Persuasion and the total run time of

selected movies.

Displays the total file size and total

run times for all movies in the pre-

sentation.
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Bringing QuickTime movies

into Persuasion

When you import a QuickTime

movie, you are actually establishing a

link with the movie, not adding the

movie to your presentation. Import-

ing only the reference keeps the

presentation file size smaller, since

movie files can be quite large.

A movie file itself can contain

references to other media files for

audio, video, or animation data.

When you move a presentation from

one computer to another, always run

through your presentation before

giving it.

You will most likely use video movies

directly on a slide, although you can

also use a movie with sound as a slide

or slide layer transition. Movies

placed on backgrounds will play first

when the slide is displayed; movies

placed on masters will play second;

and movies on slides will play third.

About QuickTime video movies

Preparing your on-screen

presentation

Running your on-screen

PLESENtStION sssccravaeoeea neces
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Import movie dialog box

A—
Preview DB Movie lard Drive

5 A

Create (import _)
& Show preview

A Displays QuickTime movie files that

can be imported.

B_ Previews the selected movie.

Tip: Keep movies used in a

presentation in the same folder as

the presentation.



To import a QuickTime movie

1 2 3

Nimbus ~ O kite.movie &

Caelim nether C < DO Sound
Import

i

Display the slide, slide master, or Choose “Import” from the File menu and In the “Import movie” dialog box,

background on which you want to then choose “Movies...” from the select the movie file to import, and

place the video movie. submenu. then click “Import.”

To copy a video movie

1 2

—~

Click the video movie in another application, another Choose “Copy” from the Edit menu.

Persuasion presentation, or view the movie in the Scrapbook to

select it.

3 4

Nimbus he

Caelum aether OS Undo R2

Cut #H

Copy Ede

Open your Persuasion presentation and display the slide on Choose “Paste” from the Edit menu.

which you want to put the movie.
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Setting up a movie in

Persuasion

In Persuasion, you can specify several

characteristics of your QuickTime

movie. You can adjust the volume,

you can set the poster frame, and

you can decide how big the movie

will be on your slide. You can also

perform basic edits to a QuickTime

video movie and test playback.

Movies are labeled on slides with a

movie badge containing a popup

menu from which you can do basic

movie editing. Use the playbar to edit

the current or selected frames of the

movie. When the playbar is not

visible, edits such as cutting, copying,

or deleting apply to the movie as a

whole. You can choose to display or

hide movie badges.

Tip: To preview a movie,

double-click it. To stop play, click

the movie once again.

About QuickTime video movies ......... 170

Bringing QuickTime movies into

RGISUASION ssvesrasststtisrtirstenecees 172
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The movie badge popup menu

Play ——___|_ A
Soundon ——_____B

Video on ——_l_¢

Show playbar — D

Set poster frame —|— E

Show poster frame 4

Restore original size} G

Movie info... ——j~H
Setname... —| J]

Plays the movie from the current

frame. Once the movie is playing,

click anywhere to stop play.

Turns the sound on or off for movies

that contain sound.

Turns the video display on or off for

movies that contain video.

Displays or hides the playbar.

Designates the current frame as the

poster frame..

Displays the frame that is assigned

as the poster frame.

Returns the movie to its original size

if you have resized it manually or us-

ing the “Adjust graphics” dialog

box.

Displays information on the movie

selected and information on all mov-

ies in the presentation.

Allows you to change the name of

the movie as it appears in the

“Movie information” dialog box.

The original movie maintains its

original filename.



The playbar

Play

Sound on

Video on

To display the playbar, Choose “Show

playbar” from the movie badge popup

menu.

To adjust the movie sound volume

1

To display the playbar, choose “Show playbar” from the movie

badge popup menu.

Set poster frame

Play

Sound on

Video on

in

Displays the volume slider that controls

the volume of the movie.

Plays the movie from the current frame.

C Indicates the current frame's place in

movie.

Steps backward through the movie one

frame at a time.

Steps forward through the movie one

frame at a time.

Play

Sound on

Video on

v Show playbar

Choose “Set poster frame” from the

movie badge popup menu.

Advance the movie using the playbar to

find the desired frame.

Click the volume control button to display the volume slider,

and then drag the slider to the desired setting.
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Editing movie frame

sequences

You can cut, rearrange, or duplicate

movie frames in Persuasion. This

allows you to cut a longer movie to

show only the frames you want or to

create a movie clip from a longer

movie. You can paste frames into the

movie from which you cut or copied

them, or you can make a new movie

consisting only of the cut or copied

frames.

Tip: QuickTime movies in

Persuasion play using the

“Standard” (RGB) color system.

Use a QuickTime editing program

to play a movie using a different

color system.

About QuickTime video movies ......... 170

Bringing QuickTime movies into

RErSUASION itcsvscrstesssececvateussesocstedees 172
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To move QuickTime movie frames

1

Play

Sound on

Video on

Show playbar

poster frame

Display the playbar by choosing “Show

playbar” from the movie badge popup

menu.

shift

Hold down Shift and move to the end

of the sequence by either dragging the

slider or clicking the step buttons. To

move just one frame, click a step

button once.

Go to the frame after which you want

to append the sequence, and then

choose “Paste” from the Edit menu.

5c N

Using the slider or step buttons, go to

the first frame of the sequence you

want to cut or copy.

4

Choose “Copy” or “Cut” from the

Edit menu.

Click the play button on the control bar

to review the result.



To remove a sequence

ee

[~

Using the slider or step buttons on the Hold down Shift and go to the end of the © Choose “Clear” from the Edit menu or

playbar, go to the first frame of the sequence by either dragging the slider or press Delete.

sequence you want to delete. clicking the step buttons. To remove just

one frame, click a step button once.

To create a new movie from a selected sequence

1 2 3

fat]

Using the slider or step buttons on the Hold down Shift and go to the end of the Deselect the movie, and then go to the

playbar, go to the first frame of the sequence by either dragging the slider or slide or location where you want to

sequence you want to cut or copy. clicking the step buttons. To move just paste the “new” movie, and choose

one frame, click a step button once. “Paste” from the Edit menu.
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Preparing your on-screen

presentation

Before you run an on-screen presen-

tation, preview any special effects

you have created, and fine-tune your

work before showing your presenta-

tion to an audience. You can then

save it so that all you need to do is

double-click the presentation’s icon or

name to start it.

{f you are giving your presentation on

a monitor that has a different screen

resolution (such as 1024 x 768) than

the monitor on which you created

the presentation, you need to record

the new screen dimensions in the file

before you present it.

It is a good idea to “package” all the

QuickTime movies in your presenta-

tion. This will create one file that

contains only the movie frames and

sounds your presentation uses. If you

choose not to package your movies,

you must bring all movies and sounds

along with your presentation, and

store them in the same folder.

About QuickTime video movies ......... 170

Animating slide objects ................ 160

Creating jumps within

A Presentation ..........ce eeeeceseeeseneeees 162

Layering slides ...........cccceeceereeees 156

Transition effects for slides

and slide layers «0.0.0... cececcceeeeeees 164
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The “Slide show” dialog box

Slide show [ Play | |__.

Range: @All OFrom[1 |to[1__| —

A —— After last slide: |Piey again v|

B — Slide advance: © Manual @ Automatic

Display: @ Full screen O Window @ Player preview

< Show: [] Menu bar () Sounds
p— J Layers & Transition effects

CI Badges J Movies © Manual © Automatic—-—G

Animations (] Display error messages

Lists options for the end of your au-

tomatic slide show.

Manually advances each slide or runs

your presentation automatically.

Displays the slide show centered on

the screen and reduced to the player

size (640 x 480 pixels).

Features that will be displayed or en-

abled during your slide show.

E Saves the settings and closes the dia-

F

G

log box.

Shows your presentation using the

settings you have chosen.

Movies can be played in “Auto-

matic” or “Manual” mode when

"Slide advance” is set to "Manual."



To change the slide size to match a different monitor

In the “Presentation setup” dialog box,

choose “Custom,” and then enter the

appropriate screen dimensions, and

click “OK.”

Choose “Page setup...” from the File

menu, and then click “OK” in the

“Page setup” dialog box.

To prepare a presentation to open in slide show

1 2

Outline

Cancel(Conce

Select the options that you want, and

then select “Save.”

Choose “Slide show” from the View

menu, and then choose “Show all

slides...”

[donatio ]

Format: eS
oO Open:

[donatio

Format:

Package movies ope ByPackage movies

Check “Package movies” to put the

sounds or QuickTime movies in your

presentation into one file.

In the save as dialog box, select a folder

and type a name for your slide show.
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Adjust graphics:

W Slides

Options:

O Move objects

@ Scale objects

In the “Adjust graphics” dialog box,

select “Slides,” and then select either

“Move objects” for small adjustments

or "Scale objects” for large adjust-

ments. Click “OK.”

Choose “Save as...” from the File

menu.

=a]0 @ Presentation
= © AutoTemplate

Boren in slide show

Check “Open in slide show,” and

then click “Save.”



Running your on-screen

presentation

Once you have correctly prepared Using the menu bar with an on-screen presentation
your presentation, and have saved it

to open as a slide show, running it is

easy. You simply double-click the _

presentation icon or the filename in

the file folder. All of your multimedia B

effects, such as sound transitions,

animation, QuickTime movies,

autojumps, and highlighted text, will

play according to the settings you

last saved.

File Edit view stigeshow

Advolare

You can navigate manually through

your presentation using either A These menu items allow you to B_ These menu items allow you to navi-

keyboard commands and the mouse change transitions in your presenta- gate through your presentation.

¢ tion.
the menu bar, or the control bar. The

menu bar gives you flexibility in

manipulating your presentation, but

it can be intrusive and is best used for The control bar is a simple navigation tool*
informal presentations.

The control bar is much less intrusive

and provides controls if you are giving

the presentation away from the

computer. Keyboard commands are

handy if you are giving the presenta-

tion while sitting in front of a A Moves to the first slide or the first D Plays the presentation. In automatic

keyboard. layer of the first slide. mode, it starts or restarts your pre-

B Moves to the previous slide or the sentation.

last layer of the previous slide. Press- E Moves to the next layer or next slide.

ing Shift + clicking the button moves Pressing Shift + clicking the button

to the previous layer. moves to the last layer of the current

C Pauses the presentation when it is in slide.

automatic mode. F Moves to the last slide or the last

layer of the last slide.

* Pressing Shift + Command + c displays

the control bar.

Creating Player files ..........scssscsseees 186

Preparing your on-screen

presentation

Run multiple Player files . 196
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Keyboard commands when running an on-screen presentation

; To...

Display or hide the menu bar

Display or hide the control bar

Display the next slide or layer

Display the previous slide

- Display the previous layer

| Go to the first slide

_ Go to the last slide

' Go to the first layer of the first slide

Go to the first layer of the last slide

Go to a specific slide

Go to the first layer of a specific slide

Stop or resume a slide show set to automatic advance

Turn the cursor on or off

. Switch between manual and automatic advance

Turn the blank screen on or off

Turn the screen black

Exit the slide show

~ Exit from the slide show and quit

Press Shift + Command + ¢

Press Shift + h or press Shift + Home

Type a slide number and press Return

Press a

Do this...

Press Command +m

Click the slide or press the right arrow or press in ; oo -

Double-click the mouse or press the left arroworpressp

Press Shift + left arrow or press Shift +p
Press Home or press h

Press End or press e

Press Shift + e or press Shift + End - oo —

Type a slide number and press Shift + Return

Press the spacebar

Press =

Press b or press , (comma) -

} Press Shift + b or press . (period)

Press Command +. (period)

Press Command + q
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CHAPTER

@)

On the Road with

Persuasion



What is the Persuasion

Player?

The Persuasion Player is a portable

version of Persuasion that allows you

to run on-screen slide shows on

computers that don’t have Persuasion

installed. With the Player, you have

the option of distributing your

presentations to people who don’t

own Persuasion.

Included with your Persuasion 3.0

software is one 800K disk containing

the Macintosh Player and another

containing the Windows Player. Using

the appropriate Player, you can run a

slide show on either platform,

regardless of where it was created.

The Player supports transition sounds,

visual effects, autojumps between

slides, slide shows, or applications,

animation, sounds, and movies.

Because the Macintosh and Windows

support different movie formats,

movies and sounds in Player files will

not transfer between platforms.

a a ae ee

Add notes to Player files 00.0... 194

Creating Player files 0...ee eeeeeee 186

Preparing your on-screen

PFESENtAtiON ........c...cceeesesesseceeseneeeees 178

Run a Player slide show ...............005 190

Testing Player files on-site .................. 188
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To run a slide show using the Player,

first create your presentation as an

on-screen slide show in Persuasion,

then export it as a Player file. Since

Player files are snapshots of

Persuasion slides, you can’t edit

them. You can annotate them,

however, with notes and sketches.

The annotations don’t change slide

content and can be saved with the

Player file for future reference.

Recommended system requirements for running Player files

| Component “Macintosh PC

Processor -S—=~*S*S«~RB'20 (Mac Il or higher) 80386

Memory (RAM) CAMB 4MB

| Operating system System 6.0.7 Windows 3.1

| | Monitor 4B inches (640 x 480 pixels) VGA, 256 colors*
256 colors*

|

|

| *On black-and-white or 16-color monitors, colors and patterns will be less smooth;

! on monitors smaller than 13 inches (640 x 480 pixels), Player slides displayed at full

' screen may be cropped.



Taking a presentation on the road

Use the Player to run an on-screen slide

show on any Macintosh or Windows

computer that meets the recommended

system requirements, regardless of where

the slide show was created.
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Creating Player files

Before you can run an on-screen

presentation using the Player, you

need to create a Player file. You

create a Player file by exporting slides

from Persuasion in slide show format.

You can export single slides, selected

slides, or entire presentations.

From within Persuasion, you can save

settings for how your slide show will

run as a Player file before you export

it. For example, you can decide

whether slides will advance automati-

cally or manually. If you choose

manual slide advance, you can pause

and restart the slide show as you

deliver your message and you can

activate special effects, such as movies

or jumps between nonconsecutive

Slides, at specific times. You have the

option of modifying the settings as

needed from within the Player.

Run a Player slide show ..............005 190

Testing Player files on-site ...0..0..0...000.. 188

What is the Persuasion Player? .......... 184
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Save settings running a Player file

Cc

Slide show [ Ploy |

Range: @ All OFrom[fto (4 |

A—tL After last stide: [| Play again 7}

B —+- Stide advance: © Manual @ Rutomatic

Cc —7_ Displey: © Full screen © Window © Player preview

D— Show: (J Menu bar J Sounds

} Layers (Transition effects

E (1 Badges CiMovies © Manual @ Autcmatic

F &) Animations O Display error messages

Options for ending a slide show set D

to advance automatically.

You control when slides and layers E

advance, or the Player advances

them automatically. is displayed.

How your slide show displays on F When checked,

your screen.

Options you can choose to operate

or display in your slide show.

You control when movies play or

they play automatically when a slide

error messages dis-

play when objects can't be found or

played.

Tip: Since Player files are snapshots of slides with content you

can't modify, preview your slide show in Persuasion before you

create the Player file. In the “Slide show” dialog box, select the

“Player preview” option and then click “Play.” Exit the slide show

at any time by pressing Command + period.



Decide how your presentation exports

3 Presentations ¥

Q Donatio a (_Goncet_)
} Donatio Edition <1> [=|
D Donatio.prt (Cesktop )
D Graphic

OD Logo @ Hard drive

QO Movie

O Presentation (@| Export:

Donatio.ppf | Current slide A

File format: Slide Options:

PICT a] ( Background fill

Scrapbook (System 6) & Separate layers i— B

Scrapbook (System 7?) & Package movies i——— C

| () Fewer colors

D

To create a Player file

1 2

Outline

Open a presentation, choose “Slide

show” from the View menu, and then

choose “Show all slides...”

Choose “Export...” from the File menu

to open the “Export” dialog box.

Menu bar & Sounds

& Layers Transition effects

CBadges & Movies© Manual@ Automatic

Animations& Display error messages

In the “Slide show” dialog box, select

settings as needed, and then click “Save.”

File format:

PICT

Scrapbook (System 6)

Scrapbook (System ?)

Slide show [=|

Select an option from the “Export”

popup menu, and then select “Slide

show” from the “File format” scroll box.

A Export your entire presentation, one

slide, or selected slides.

B_ Exports separate slide layers; don’t

check if the computer you'll use has

less than 4MB of memory.

C Packages movies and sounds into a

QuickTime file.

D The Player can only use “Slide show”

format.

To export one slide or selected slides,

display the slide sorter and select the

slides you want.

6

Donatio.ppt Current slide

Slide Options:

& Background fill

& Separate layers

& Package movies

O Fewer colors

Check the options you want, name your

Player file (add a .ppf extension to run

the file in Windows), and click “OK.”
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Testing Player files on-site

Since you may be running your Player

slide show on unfamiliar equipment

in an unfamiliar setting, try running it

before you deliver your presentation.

You may find you need to change the

way the slide show is displayed on

the screen, the speed at which it

runs, and other settings.

You can run the Player file in full

screen or window display depending

upon monitor size. Because Player

files are bitmaps, patterns may

change when you switch from one

display to another.

If you use a projection device to

project your Player slide show, it will

look exactly like it does on the

monitor.

You can control your slide show from

one monitor (where the menu and

dialog boxes display) and present it

from another. Set your Player file to

display in a window and drag the

window to the second monitor.

If you set your slide show to run

automatically, you can control the

speed at which it runs. Unless you

Creating Player files oo... 186

Run a Player slide SHOW ......ceeceeeeee 190

Transition effects for slides

and slide layers

What is the Persuasion Player?
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modify the timing settings, slides

advance according to the delays you

set for transitions between slides and

layers. (The default settings are two

second delays between slides and

one second delays between layers.)

Choosing the best display option

Full-screen display Regardless of moni-

tor size, Player files display at 640 x 480

pixels (the approximate size of a 13-inch

monitor). On larger monitors, Player files

appear in the center of the screen sur-

rounded by black. On smaller monitors,

the edges of the slides extend beyond the

edges of the screen and slides will be

cropped.

Window display !f necessary, slide im-

ages are scaled to fit in the window. On

smaller monitors (such as a Macintosh SE

or a Powerbook), choosing window dis-

play scales slides to fit under the rnenu

bar and within the bounds of the screen.

Text scales as a bitmap so it may appear

jagged in smaller windows.

Tip: To modify settings while the

Player file is running: Press

Command + T to display the

“Settings” dialog box, modify the

relevant settings, and then click

“Restart” or “Continue.”



Controlling the speed of your Player slide show

A When a Player file that is set to ad-

vance automatically first opens, theSettings (Criey_)
Range: @ All O From t_t [6 | slider is deactivated, and the slide

. show plays at normal speed.
After last slide: | Playegein —_—v|

A Slide advance: © Manuel! © Automatic LHe B Moving the slider left makes the pre-

sentation run slower (minimum

speed is four times stower than nor-
Display: @ Full screen © Window © Pleyer preview

Show: (Menu bar & Sounds

() Layers {) Transition effects mal speed).
C) Badges Movies © Manual © Automatic C Activates the slider and allows you to
Animations [) Display error messages change slide show speed.

B naeianes timing: Unchenced rast D D Moving the slider right makes the
— ower achange aster ee : ’

EEE ey une OUAETeERUANGRENETUEEEH presentation run faster (at maximum

speed, the slide show runs as if all

delays are set to None).

To change settings for running a Player file

1 2 3

O advolare.ppf ney

OD sether.ppf

GJ Menu ber (Xj Sounds

Leyers Transition effects

Persuasion Player 3.0 CO) Badges (fd MoviesO Manual@® Rutomaetic

p

D nimbus.ppf

o Animations & Display errer messages
J Show settings

Double-click the Player application icon In the open dialog box, select the file you In the “Settings” dialog box, choose

to open the Player. want to open, check “Show settings”, the display, timing, and other options

and then click “Open.” you want to change, and then click

“Play.”
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Run a Player slide show

For best performance, copy your

Player files to the hard disk before

you run your slide show.

To run a Player slide show, simply

double-click the icon of the file you

want to run. The slide show will run

according to the settings that were

last saved.

Navigate through your Player file

using either the keyboard, the control

bar, or the Slide show menu.

Note: If you plan to run multiple

Player slide shows consecutively,

create a show list file on the com-

puter where you'll be running your

presentation.

Creating Player files 0.00.0...ce eeeeseees 186

Run multiple Player files ................... 196

Testing Player files on-site .................. 188

What is the Persuasion Player? .......... 184
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Before you take your Player slide show on the road,

answer these questions:

Did you test your presentation on your own computer first?

Have you exported your presentations as Player files in slide show

format?

What kind of computer (Macintosh or Windows) will you be using

for your presentation?

Does the computer meet the recommended system and hardware

requirements?

Did you take the appropriate Player application (Macintosh or

Windows)?

Have you saved your Player files and packaged movie and sound

files onto a disk formatted for the computer you'll be using?

If you'll be running a slide show in Windows that you created on a

Macintosh (or vice versa), does your slide show include movies or

sounds that won't play on the other platform?

If you'll be running a slide show in Windows, does your Player file

name have eight or fewer characters and a .ppf extension (for

example, 3QSales.ppf)?

Tip: Before you run your slide

show, disable screen savers, mail,

or any other program that might

interrupt your presentation.



Run a Player slide show

Navigate using the control bar*

A Moves to the first slide or the first D Starts or resumes the slide show

layer of the first slide. from the current slide.

B Moves to the previous slide or the E Moves to the next layer or next slide.

last layer of the previous slide. Pressing Shift + clicking on the but-

Pressing Shift + clicking on the ton moves to the last layer of the

button moves to the previous layer. current slide.

C Pauses the slide show and/or any F Moves to the last slide or the last

running movie, sound, or animation layer of the last slide.

effect. *Pressing Shift + Command + C on
a Macintosh or Shift + Ctrl + C in

Windows displays the contro! bar.
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Run a Player slide show

Navigate using the keyboard

To...

Display or hide the menu bar

Display or hide the control bar

Display the “Settings” dialog box

Go to the next slide or layer

Go to the previous slide

Go to the previous layer

Go to a specific slide

Go to the first layer on a specific slide

Go to the first slide

Go to the first layer of the first slide

Go to the last slide

Go to the first layer of the last slide

Pause or resume a slide show set to automatic advance

Toggle the cursor on or off

Switch between manual and automatic advance

Switch between the current slide and a blank screen

Switch between the current slide and a black screen

Exit from the slide show

Exit from the slide show and quit

Do this...*

Press Command + m

Press Shift + Command + c

Press Command +t

Click the mouse, or press the Right arrow, or press n

Double-click the mouse, or press the Left arrow, or press p

Press Shift + the Left arrow, or press Shift + p

Type the slide number and press Return

Type the slide number and press Shift + Return

Press h or Home Be
Press Shift + h or press Shift + Home

Press e or End

Press Shift + or press Shift + End

Press the Space bar

Press a —

Press =
Press b or press , (comma)

Press Shift + b or press . (period)

Press Command + period (Macintosh) or press Esc (Windows)

Press Command + q (Macintosh only)

*If you're running your Player slide show on a PC, press Ctrl instead of Command.

192 ALDUS PERSUASION 3.0 USER MANUAL



To run a Player slide show on a Macintosh computer

1

Copy the Player application, your Player

files, and any movies and sounds into

the same folder on the hard drive.

2

Persuasion Player 3.0

Double-click the Player application icon.

To run a Player slide show in Windows

1

Make sure Windows is running, and

then insert the floppy disk into the

disk drive.

4 = vie

Comouse cS
Gadus Copas
Os vendows

ma Dwnezos 9:

Brose |[Elatooecda 4

Ors lcommand com 46:
Dwndows -

ies Ei

In the File Manager, click the icon for

the "c" drive. Double-click the “c:\"

directory to view the icons for your

Player files.

2

File Manager

In the Program Manager, open the

“Main“ group, double-click the File

Manager icon, and then choose “Copy”

from the File menu.

File name:

donatio.ppr

Double-click the Player application icon

(called “playerw.exe") and in the

“Open” dialog box, select the Player file

you want to run.

Run a Player slide show

ee tir

Settings

Range: ©All © From [fit [5]

After last slide: | Play again bd

Slide advance: © Manual © Automatic

If necessary, change the settings by

pressing Command + t.

(Eencet_]

Cie]

Current Directory: C:\

i Of]
O Copy to Clipboard

Type “a:\*.*" for “From” and type

“c\" for “To.” (If you're using disk

drives other than “a” and “c,” type

those letters instead).

Tip: In the “Open” dialog box, check

“Show settings” to view or change the

settings for how your slide show will run.
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Add notes to Player files

In the same way that you use a

marker to make notes on transparen-

cies, you can use the keyboard and

mouse to make notes and sketches

on slides during a Player presentation.

Using the Player annotation tools,

you can add comments and sugges-

tions directly to slides that need to be

changed. After your presentation,

you can open both an annotated

Player file and a Persuasion file and

easily incorporate revisions into your

original presentation.

By choosing not to display annota-

tions, you can present a Player file

slide show even after you have made

notes on the slides. Although you

can’t print annotations, you can save

them with the Player file.

Creating Player files «0.0.0.0... cece

Run a Player slide SHOW ..........seeeeeeee

Testing Player files on-site ...

What is the Persuasion Player?
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Annotation options

File Edit Slideshow SRTTRYET TTT

= Show annotation tools

v Show annotations

Clear slide annotations

Clear all annotations

C Deletes the annotations on the

current slide.

Displays or hides the annotation

tools. Showing the tools when anno-

tations are not displayed also shows

the annotations.
D Deletes all annotations in the

Player file.

Displays or hides annotations. Dis-

playing annotations displays all the

layers on a slide; you can’t annotate

individual layers.



Annotation tools

A Pointer tool.

B Text tool. Click on any location on

the slide to enter text.

C Marker tool. Make freehand draw-

ings on your slide.

D Eraser tool. Erase any or all of your

annotations. Double-click to erase all

annotations on a slide.

E Color tool. Choose one of nine col-

| ors for your annotation text and

F sketches.

F Tools expand (when you click and

hold) to offer you a range of sizes

and colors.

To add notes and sketches to a Player file

1 2 3

Ronotations ~

Show annotation tools Nimmous Open... #0

~ Show annotations Close ew
Cygsugy ues

Clear slide annotations Caslum usther Create show list...
Clear ail annotations + Iriure dolor in hendrerit

+ Yalit assy sonsayual Soros
2 Dignissin yui praysans

Display the menu bar by pressing On the annotations tool palette, press When you're finished annotating your

Command + m and then choose and hold the tool you want to use, select file, choose “Save” from the File menu

“Show annotation tools” from the the size or color you want, and then to save the annotations with your

Annotations menu. annotate the slide. Player file.
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Run multiple Player files

When one presentation consists of

multiple Player files, you have two

ways to run them: you can jump from

one Player file to another using

autojump, or you can create a show-

list file. A show-list file is an ordered

list of Player file names.

Create a show-list file when you

want to run Player files in sequence.

Because a show-list file consists of

pointers to the Player files you want

to run, you must create it on the

computer on which you run the

Player files. If you decide to change

the order in which the Player files run,

simply create a new show-list file.

Run a show-list file just as you run a

single Player file (double-click a show-

list file icon). Options you set for

running a show-list file apply to all

the slide shows in the show list. If you

want to run a show-list file in

Windows, make your filename no

longer than eight characters and add

a .psl extension (for example,

_ 4WkRpt.psl).

Creating jumps within

A PPESeENtatiON .........cc ecescecseseeetteeees 162

Creating Player files 00.00... cee 186

Run a Player slide show .............ee 190

What is the Persuasion Player? .......... 184
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Use autojump when you want to

move back and forth between Player

files. Set the options for running each

Player file individually.

To create a show-list file

1 2

Show list:

aduvolare.ppf
Open... #0

Close EY

Create show list.
Remove

Launch the Player and choose “Create In the “Create show list” dialog box,

show list..." from the File menu. select each Player file from the top list

in the order you want them to run and

click “Add” after each selection.

3 4

Desktop

Save as:

[tabute.pst Cancel )

When all the Player files are added, click —_ In the “Create show list” dialog box,

“Save.” In the save as dialog box, type click “Done.”

a name for the show list file (add a .psi

extension if you intend to run the file in

Windows) and click “Save.”

J



To create jumps between two Player files

1 2

Presentation

A

File B

Export the presentation you want to

jump to as a Player file (called File B

here).

4

Presentation

B

File &

Within Persuasion, in Presentation B (not Player File B), create

an autojump to Player File A.

To jump from one Player file to another

1

Presentation Presentation

A

Run the Player slide show. On the appropriate slide, move the

cursor over the object or area to which you've assigned the

autojump, and click when the cursor becomes a pointing hand.

Within Persuasion, in the presentation you

want to jump from (called Presentation

A), create an autojump to Player file B.

File B File 4

Export Presentation A as a Player file

(File A).

File B

Export Presentation B again as a Player file, naming it exactly

the same as you did before.

Presentation Presentation

From the file you jumped to, return to the first file by clicking

ona return autojump, if you created one, or by displaying the

menu bar and then choosing “Return to...” from the

Slideshow menu.
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CHAPTER .

Printing



Printing in Persuasion

Persuasion gives you a variety of

options for printing 35mm slides,

overheads, support materials, and

outlines.

° Print slides without separate layers

or background fills for proofing.

e Print slide layers as separate slides.

e Print an on-screen presentation

with badges to become familiar

with the autojump hot spots.

© Create a PostScript file for 35mm

slides.

¢ Print parts of your presentation

independent of other compo-

nents. For example, print just the

outline without the slides or notes

to review your presentation

content.

e Print color slides on a black-and-

white printer without changing

your presentation.

Printing in Persuasion

Handouts

Overheads

Any part of your presentation—slides, outline, notes or handouts—can be printed sepa-

rately without printing all the presentation components.

Add handouts and speaker notes to a

presentation

Creating jumps within a

PFESENTATION .sasssscsesscesosrostessectectsastnese 162

Outline your presentation

TOISAVE UIE: ....-.ssnrecnernsnssstnepnnstennszseeess 62
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Persuasion’s printing options

LaserWriter

Copies:((m] Pages: © All © From: [| To: [|

Cover Page: @No First Page © Last Page

Paper Source: © Paper Cassette © Manual Feed

Print: O Black & White © Color/Grayscale

Destination: © Printer O PostScript File

A—t Print choices: Bd Sttdes {Outline (jNotes (Handouts

B Graphic options: [KX] Separate layers Badges (Background fill—+~—G

Cc

D Cutline options: [)UVisibte items only [] Current selection H
E £] Hide body text CI Hide notes

F &] Level icons & Headers (] Footers J -
nt

A Prints the parts of the presentation E

that are checked.

Prints the outline without subtitles or

body text.

B_ Prints one page for each additional
slide layer.

C Prints badges for all charts, movies,

sounds, jumps, and animation in an

on-screen presentation.

D Does not print collapsed or hidden

Prints slide title and heading level icons

along with text.

Prints slides with their background fills.

Uncheck to print slides without back-

ground fills.

Prints only the selected heading and its

text. subordinates.

I Prints the outline without notes.

J Prints page numbers at the bottom

of each outline page.

K Prints the presentation title at the

top of each outline page.

Note: The look of the print dialog box

depends on the printer driver currently

active. However, all of the options de-

scribed here are available with all

printer drivers.

CHAPTER 11: PRINTING 201



Printing overheads and

support materials

The best way to produce clear, crisp

overheads, outlines, speaker notes,

and handouts is with a high-

resolution black-and-white or color

laser printer.

When you print overhead transparen-

cies, be sure to use the transparency

product recommended for your

printer. You can also print overheads

on paper and then use a copier to

transfer images to transparencies.

Some limitations exist in the range of

colors available on color printers. If

you want to print color overheads,

refer to your printer documentation

to review your printer's color

capabilities.

Tip: To change your color system

to black and white before you print

support materials, choose “Color

system” from the Show menu and

then choose either “Black and

white” or “Inverse grayscale” from

the submenu.

Add handouts and speaker

notes to a presentation

Proof and save
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More legible thumbnails

Nimbus

Cactum acther GOK

+ Irjure dolor in hendrerit

+ Yelit esse consequat

+ Dignissim qui praesent

Nimbus

Caelum aether

+ Iriure dolor in hendrerit

+ Velit esse consequat

+ Dignissimqui praesent

Nimbus

Caelum aether

+ Irlure dolor in hendrerit

+ Velit esse consequat

+ Dignissim qui praesent

Grayscale

Inverse grayscale

Black and white

Before you print speaker notes and handouts that include thumbnails of slides with

darker or more complex color schemes, change the color system so that slide thumb-

nails are more legible.

To print overheads, outlines, notes, or handouts

1

Choose “Print...” from the File menu.

Print choices: OSlides Outline Notes Handouts

Graphic options: Separate layers [] Badges (] Background fill

Outline options: [Visible items only (Current selection

OHide body text Olide notes

Levelicons (Headers J Footers

In the print dialog box, select the options you need. Uncheck the parts of the

presentation you don’t want to print, and then click “Print.”

Tip: If your presentation has a dark color scheme, change the color system to “In-

verse grayscale” or “Black and white” before printing proofs on a laser printer.



Converting presentations

to 35mm format

When you convert a presentation

designed for on-screen display or

overheads to 35mm format, and vice

versa, the dimensions and shape of

your slide will change. In Persuasion,

you can move or adjust graphics and

text automatically on both slide

masters and slides to accommodate

a larger or smaller slide.

Tip: Before converting your

presentation from one slide shape

to another, save it under a new

name. You can then compare the

converted slides to the original

slides, which can help you make

placement and sizing decisions.

Choose your final output and design... 15

Proofing 35mm slides «0.0.0.0... 206

“Adjust graphics dialog box” in Online

Help

“Overview: Transferring files across

platforms” in Online Help

“Adjust graphics” dialog box

Adjust graphics [ox |

Page size of slides has changed.

Adjust graphics:

A— {) Slides O Notes DO handouts

Options:

B——— © Move objects

c— @ Scale objects (J Scale tent sizes ——D

C) Maintain aspect ratio—}—_e

A Adjusts slides.

B Moves objects toward the center of

the new slide shape, retaining size.

D Scales text sizes to fit proportionally

in the new slide shape.

E Scales all objects and maintains their

C Scales objects to fit proportionally in proportions.

the new slide shape.

To convert a presentation to 35mm format

1 2

Choose “Page setup...” from the File

‘menu, and then click “OK.”

In the Chooser, select your film recorder

device. If using custom dimensions,

select any device, then click “OK” in

response to the Alert message.

3

Presentation setup

Sitde shape: © Overhead @35mm slide © Screen

© Custom: [iro 4q by [6.75 inches

In the “Presentation setup” dialog box, select “35mm slide.” If you are using

custom dimensions instead of a device driver, click “Custom,” enter those

dimensions, and then click “OK.”
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Setting up for 35mm

output

Before you make 35mm slides using

either an in-house film recorder or a

slide service bureau, you need to

select the correct output device from

the Chooser, and define your slide

shape.

Your film-recorder documentation or

your slide service bureau will specify a

device driver or give you a set of slide

dimensions to work with. When you

select the device driver from the

Chooser, your slides will be sized

accurately. Without the device driver,

you must enter the slide dimensions

provided by your service bureau.

Aldus Authorized Slide Service

Bureaus have the latest technical

updates and tips to help you save

time and money. Call Aldus Customer

Service at 206.628.2320 in the U.S.

to find one near you.

fy ra

Converting presentations

to 35mm format ........cececeeseeeeeees 203

Proofing 35mm SlideS ..........eceeeereees 206

“Produce slides using an in-house film

recorder” in Online Help

“Produce slides using a slide service

bureau” in Online Help
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Questions to ask a slide service bureau

What services do you offer

Do you use Persuasion 3.0 for the Macintosh?

What resolution in lines or dots per inch do you offer?

Can | get PostScript slide output?

Do you have Persuasion color test slides produced from your

35mm devices?

Which fonts do you have?

e Will fill patterns print on your equipment?

How should | set up my presentation

Do you have a film recorder driver or queueing software that you

want me to use?

What slide dimensions does your film recorder require?

Do you have size or orientation limitations?

What do | need to do if | want separate slides for slide layers?

How should | send my file

Should | save my presentation as a Persuasion file, an export file,

or a PostScript file?

Should | send my presentation by modem or on disk?

e How should | transport my presentation if it is too big for a floppy

disk?

Do you recommend any file-compression software?



Setting up for 35mm slides

To... Do this...

Produce 35mm slides with a device driver installed 1. In the Chooser, select a film-recorder device driver or the

on your computer film-recorder’s conversion software as specified in your

documentation.

2. Inthe “Presentation setup” dialog box, select "35mm" as

the slide shape.

Produce 35mm slides through a slide service bureau 1. In the Chooser, select any printer.

supplying slide dimensions (but no device driver) 2. Inthe “Presentation setup” dialog box, select “Custom”

and enter the service bureau’s slide dimensions.

Produce a PostScript file 1. In the Chooser, select the LaserWriter driver.

2. Consult the slide service bureau or your film-recorder

documentation for any special settings required in the

“Presentation setup” dialog box.

Proof 35mm slides on printer paper 1. In the Chooser, select a printer.

2. Choose “Page setup...” from the File menu, and then

reduce the page size to 70%. You can vary the reduction if

needed. (Return this value to 100% before printing your

final 35mm slides.)

To use the “Presentation setup” dialog box

1 2

Presentation setup

Slide shape: © Overhead @ 35mm slide © Screen

EA Ge Si Seca O Custom: ||10.14 by inches

Choose “Page setup....” from the File menu, and then In the “Presentation setup” dialog box, select “35mm slide” or

click “OK.” enter your slide shape, and then click “OK.”
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Proofing 35mm slides

You can ensure your 35mm slides

print as expected by proofing them

before you print the whole presenta-

tion. The three variables you should

proof are color, text, and graphics.

Proof colors and text on 35mm film,

and proof graphics using a desktop

printer.

Proof with a test slide Create a test

slide to determine how the colors,

fonts, and fill patterns will image on

the film recorder you intend to use.

Run test slides by following the

procedures for setting up and

printing 35mm slides.

Test for color variances Each 35mm

film recorder translates colors in a

slightly different way. Therefore, you

may find that your test slide colors

are slightly different than you those

you want. You can edit your colors to

compensate for film recorder color

shifts before you print the whole

presentation.

Creating a new color scheme ............ 126

Printing 35mm Slides ...........:csceeceeees 208

Replacing custom color systems......... 130

Setting up for 35mm output ............. 204

“Editing on slides” in online Help
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You can add edited colors into the

“Custom 1” or “Custom 2” color

system so that when you use the

same film recorder again, you can use

a tested color palette.

Proof for fonts and text flow Film

recorders that are compatible with

Adobe Type Manager can print any

font you send smoothly at any size.

Without Adobe Type Manager, use

your test slide to verify that your

fonts print properly.

Test print graphics on a desktop

printer Print slides containing

complex PICT and EPS graphics on a

desktop printer first. If your printer

cannot process the slides, it is

possible the film recorder will also

have difficulty.

Tip: If you create your presentation in

“Fit in window” view, remember that

“Actual size” is the most accurate

view for seeing text and graphic

placement. You may want to print a

set of proofing slides on a laser printer

to review all text and graphic

placement in your presentation.



‘To proof complex graphics on a black-and-white laser printer

Choose “Color system” from the Show Choose “Print...” from the File menu.

menu, and then choose either “Inverse

grayscale” or “Grayscale” from the

submenu.

Print: © Black & White @ Color/Grayscale

Destination: @ Printer © PostScript® File

Print choices: E)Slides [)Cutline ()Notes (J Handouts

In the print dialog box, select “Color/Grayscale” and deselect “Outline,” “Notes,”

and “Handouts,” and then choose “Print.”
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Printing 35mm slides

There are three ways to send a To create an export file

Persuasion file to a film recorder:

e Send a Persuasion file directly. 1

e Create an export file (your slides

become PICT or Scrapbook

images).

° Create a PostScript file. prot

Your film-recorder documentation or

slide service bureau will specify which

method to use.

Choose “Export...” from the File menu.

Note: Some PostScript interpreters

require special page settings for 2

output. And some film recorders

require you to use their software to O Graphic Expo’

process your presentation before it [ ] [Current stige]

prints. Read your film recorder File format: Slide options:

PICT

Scrapbook (System 6)

Scrapbook (System ?)

Slide show a

In the “Export” dialog box, select “All slides” or “Current slide” from the “Export”

popup menu, and PICT or Scrapbook as the file format.

documentation, or contact your slide

service bureau for instructions.

Background fill:
O Separate layers i

C Package movies

OC Fewer colors

3

_ Ga)
(taneerTM

Cancel
O Graphic

D Logo

Behe kt© nimbus.ppt Desktop
D Presentation E © Hard Drive

D Sound

O Spreadsheet S| Export:

. 130

. 204

Replacing custom color systems

Setting up for 35mm output ...

“Test before producing in color” = i P oO . ,in Online Help Tip: Check “Separate layers" to print individual slides for each slide layer.

Select the slide options you want to include, name the file, and then click ” Export.”
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To create a PostScript file

Print: @ Color/Grayscale Print choices: Slides (Outline

Graphic options: (J Separate layers

Choose “Print...” from the File menu.

destination.

ONotes [Handouts

OBadges [Background fill

Check “Background fill,” and then click “Save.”

Destination: @ PostScript® File

In the print dialog box, select “Color/

Grayscale,” and “PostScript® File” as the

Select “Slides” and deselect other print

choices. Check “Separate layers” to

print individual slide layers

D aether.ppt

O Donatio

© Donatio Edition <1>

O donatio.ppt

D Donatio.prt

:” box, type in a name for your file,

Save Disk File As:

[Donatio.Ps

In the “Save Disk File As:

and then click “Save.”

Tip: To print 35mm slides from

your computer, choose “Print...”

from the File menu. In the print

dialog box, check the options you

want, and then click “Print.”
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Formatting

‘To...

Format text

Change line and paragraph spacing

Style type bold

Style type italic

Style type underline

Style type outline

Style type shadow

Style type plain

Align text left

Align text center

Align text right

Align text justified

Editing

To...

Select all

Copy

Duplicate

Paste
Cut |

Undo/Redo

Find

Find again

Change

_ Change then find

~ Check spelling

Press...

Command+t

Command+m

Shift + Command + b

Shift + Command +i

Shift + Command + u

Shift + Command + 0

Shift + Command + s_

Shift + Command + Spacebar

Shift + Command+1
Shift + Command + ¢

Shift + Command +r

Shift + Command +| ;

Press... _

Command+a

Command + c

Command + d

Command +V

Command + x —

Command+ z

Command + f

Command+g

Command+h

Shift + Command +h

Command + | Run a Player slide SHOW ........cceseeeee 190

Running your on-screen presentation... 180

“Keyboard Shortcuts” in Aldus Chart

Online Help

“Keyboard Shortcuts” in Aldus Table

Online Help

CHAPTER 12: KEYBOARD SHORTCUTS 213



Viewing

To...

Go to slide

Move from slide to slide master

Move from slide or slide master to background

Toggle between slide, outline, slide sorter, and note
Open the Gallery to choose a slide master

Preview current slide

25% magnification

50% magnification

75% magnification

100% magnification

200% magnification

400% magnification

Fit in window

Working with objects

To...

Display or hide rulers

Display or hide guides

Snap to grid

Snap to guides

Display or hide badges

Send to front

Send forward

Send to back

Send backward

Align/distribute

Group

. Ungroup
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_ Command + |

Press...

Shift + Command + 9

Option + click the slide icon

Option + Command + click the slide icon

Command + the up/down arrow

Option+ Command +m

Shift + Command + p

Command +0 |

Command + 5 7

Command + 7

Command + 1 .

Command + 2

Command +4

Shift + Command + w

Press...

Command +r

Command + y

Command+ u

Command+b

Option +Command + f

_ Shift+ Command + ]

_Shift+ Command +[
shift + Command + a

. Option + Command +9

Option + Command + u

_ Option + Command +b





Index

SYMBOLS

(Hs charttool 17

data sheet button = 17

Noteicon 75

outline icon 16

<S Persuasion 3.0icon 15

show-notes icon 75

o slide divider icon 64

.ppf file extension 187, 190

.psl file extension 196

35mm slides

asoutput 204

converting 203

designing AutoTemplates for 44

exporting 141, 208

preparing to print 205-207

printing 208

production issues 204

proof prints, on printer paper 205

proofing 204-205

requirements for printing 204

setting up for production

using a film recorder 205

using a PostScript file 205

using a service bureau 205

testing color 206

3d charts 104-105

3d view palette in Aldus Chart 102

A

"Add masters..." command 30

"Add notes" command 75

"Add org chart” command 109

"Add org chart" dialogbox 108

“Add page number" = 76

“Add slide copy" 76

"Add title” command 76

Adding

a chart to your presentation 94-105

a slide to your presentation 16
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patterns to objects 120

slide masters 31

stide masters from other presentations

30

words to user dictionary 61

“Adjust graphics" dialog box 26, 30,

36, 45, 179, 203

“Adjust Photo CD image" dialog box

136

Adjusting

objects for different output devices

203

Photo CD images 136

Adobe Type Manager, film-recorder

compatibility 206

Advancing in Player presentations 186

Agenda, showing on an overview slide

68

AIFF sounds, importing 168

Aldus Authorized Slide Service Bureaus

204

Aldus Chart 94-105

contro! palette 102

datasheet 96

features 3

importing data from other

applications 98

online Help 94

opening 94

showing popup menus 103

text palette 102

tools 94, 104

Aldus Chart Effects folder 104

Aldus folder 6

Aldus FreeHand, subscribing to 146

Aldus Installer/Utility 8, 40

Aldus IntelliDraw, editing OLE-embedded

graphics from 144

"Aldus Persuasion AutoTemplate

installation" dialog box 9

Aldus Table. See Tables

“Align objects” dialog box 89

“Align to grid” command 89

"Align/Distribute..." command 89

Aligning objects 88, 92

Alignment tools 92

"Anchor content to placeholder” dialog

box 59

Anchor point, specifying 59

Anchoring text 58-59

Animated objects, transferring between

platforms 150

Animating

graphics 160

placeholders 160

Slide objects 160

example 161

text 160

Animation

badge 160

direction 160

“Roll credits" 160

sequence 160

speed, setting 160

Annotations

in Persuasion presentations 72-76

in Player files 184, 194

Applications

exchanging information with 134-153

importing data into charts 98

importing presentations from 138

importing text from 48

importing text into tables 112

jumping to automatically 162, 163

“Apply effect to selection” command

(SFX palette) 104

“Apply format” option on text palette

54-55

Applying a fillto an object 121

Arc

90-degree, drawing 81

reshaping 82

Arctool 81

using to draw shapes with variable line

widths 84

Arrowheads 83

transferring between platforms 150



ASCII text files

importing

Assigning

background fill 34

backgrounds to slide masters 26

masters in the outline 69

slide masters to slides 25, 39

transitions in the outline 69

transitions in the slide sorter 39

Attributes, assigning to text blocks 54

Audio tracks, of QuickTime movies

turning onand off 174

"Autoanimate” dialog box 161

*Autoanimate..." command 161

Autojump badges 162

“Autojump" dialog box 162

Autojumping. See Jumping automatically

Autojumps, transferring between

platforms 150

autolayer dialog box 159

“Autolayer...“ command 159

Automatic slide advance 178

in Player presentations 186

“Autoscan“ button, in Aldus Chart 96

AutoTemplates

and final output = 15

and output device 42-43

converting from earlier versions

of Persuasion 10, 40

creating from scratch 40

62, 135, 140

default

modifying 43

replacing 43

when upgrading to Persuasion

version3.0 6

definition 40

designing 44

for 35mm slides 44

for custom-sized slides 44

for on-screen slide shows 44

for overhead transparencies 44

handout master 72

installing 40

modifying 45

note master 72

opening 41

saving presentations as 40

setting up for output device

sources of 40

transferring between platforms 150

AutoTemplates folder 15

42-43

B

Backdrop, for slides. See Backgrounds

“Background" command 26, 34, 37

Background command 34

Background fill, assigning 34

Backgrounds

adjustments when transferring between

platforms 151

assigning to slide masters

creating 34

designing 26

for tables 114

making acopyof 34

modifying 34

orientation 26, 36

removing 27

renaming 27

Backup copies of installation disks 4

Badges

animation 160

autojump =: 162

chart 97, 101

printing 201

QuickTime movie 171, 178

menu commands 174

showing and hiding 162

table 111

"Badges* command 79

“Based on” popup menu = 37

Basic installation 8

Black-and-white color system 129

Black-and-white printer, using to proof

graphics 206

Blends. See Gradient fills

Body text placeholders

anchoring 59

26, 35

28, 49

Borders, of tables 114

Boxes in organization charts 106-109

Build Slides. See Layering slides;

“Autolayer..." command; Highlighting

layered information

"Build Stand-Alone..." command.

See Player files: creating

Bulleted list, highlighting 158

Bullets

adjustments when transferring between

platforms 151

changing color 53

changing style 52-53

displaying and hiding

special characters 52

51-53

Calibration, color. See Color: calibration

hardware

CD images. See Photo CD images

Cell assignments in Aldus Chart 97

for imported data 98

Cells, in Aldus Table

changing shape of 110

merging 115

Cells in Aldus Chart

assigning in datasheets 96

"Change design” command

30, 127, 131

Changing slide orientation

Chart. See Aldus Chart

Chart button 96

Chart datasheet 96

Chart objects

applying gradient fills 105

copying fills between 103

36, 76

modifying 102

Chart OLE badges 101

Chart placeholders 28, 94

Chart slide master, creating 95

Chart tool 17, 104

using toaddachart 95

Chart types, changing 100
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Charts

2d special effects 104

3d special effects 104

changing viewing angle 105

adding graphics 104

adding scans 104

adding toslides 17, 94

converting from earlier versions of

Persuasion 10

data formats 98

entering data 96

formatting 100

text 102

highlighting 158

importing 138

data 98

modifying components 102

organization. See Organization charts

resizing 100

textin 103

reversing data series or

categories 101

special effects 104

“Choose master elements” dialog

box 32, 138

Chooser

using to select a printer 205

using to select an output device 15

using to specify a film recorder 205

Circle, drawing 81

Clip art, importing 136

CMY color model 124

CMYK color model 124

Collapsing outlines 70

Color

applying
toatextblock 121

to objects 120, 121

totables 114

to text 121

to the background of apattern 120

to the foreground of a pattern 120

calibration hardware

Radius PrecisionColor 132
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Color annotation tool

Color models

RasterOps Calibrator 132

copying in Aldus Chart 103

custom, creating 124

editing values to create custom

colors 124

effect of output medium 129

factors that affect display 132

in Aldus Persuasion 118-132

incharts 102

of bullets, changing 53

of placeholders, changing 29

proofing on 35mm slides 206

reproducing and printing in

overheads 202

solid

applying to shadows 120

applying to text 120

testing for 35mm slides 204

variations among monitors 132

194-195

changing 124

CMY 124

CMYK 124

HLS 124

HSV 124

RGB 124

Color picker 125

Colorscheme 118

creating

by editing the color-scheme

grid 126

using copy and paste 126

naming working set colors from 126

replacing swatches in 127

when touse 119

Color spectrum

overview 118

when touse 119

Color swatches

on the color palette 90, 119

replacing individual 127

Color system

Black and white 129

Custom systems1 and2 129

editing 128

Grayscale 129

Inverse grayscale 129

NTSC 129

overview 128

PAL 129

replacing 130

Standard 129

Color scheme

overview 118

replacing 126

using to create custom colors 124

when touse 119

Colors palette 114, 118

collapsed 120

in Aldus Chart 102

overview 118

Column margins in tables 115

Columns

in chart datasheets 96

of text 60

Commaz-separated value (Csv) data

format 98

Complete installation 8

Computer

needed to run Persuasion3.0 4

needed to run Player files 184

Constraining shapes when drawing = 81

Content

proofing 19

editing inthe outline 62

Control bar

displaying and hiding 181

in Player 180

navigating in Player files 191

Control palette, in Aldus Chart 102

“Convert sound" dialog box 168

Converting

a presentation to 35mm slides 203

OLE-linked graphic files to Persuasion

format 79

Persuasion 3.0 files from earlier versions

of Persuasion 10



Persuasion 3.0 files to an earlier version

of Persuasion 11

PICT files to Persuasion format 79

Copy and paste

using to import chart data 98

using to import table data 112

using to share Persuasion

information 134

"Copy colors..." command

Copying

backgrounds 34

between applications, advantages

of 135

fills between chart objects 103

objects between presentations 135

objects between slide masters 135

objects between slides 135

QuickTime video movies 173

slide masters 34

slides between presentations 135

slides in the slide sorter 38-39

“Create presentation” command 42

"Create publisher..." command 147

“Create show list" dialog box 196

"Create show list..." command 196

Creating

a chart slide master 95

a PostScript file 208

127, 131

apresentation 14, 40

a slide master from aslide 30, 33

an agenda slide 68

an export file 208

graphics 81

handouts 76

multicolumn text 60

new backgrounds 34

new slide masters 34

organization charts 106-109

Player files 186

tables 111

tallslides 34, 36

text formats 54

Csv data format 98

Cursor, turning on and off 181

Custom 1 and 2 color systems 129

Custom colors, creating 124

Custom installation 8

"Custom line size” dialog box 84

Custom line weights 83

Custom-sized slides, designing

AutoTemplates for 44

Data

in charts

changing position of 100

entering 96

reversing series or categories 101

Data formats, for charts 98

Data page. See Data sheet

Data ranges in charts, specifying 96

"Data reversal" command 101

Datasheet button 17, 97

Data sheet, in Aldus Chart 96

Default AutoTemplate

modifying 43

replacing 43

when upgrading to version3.0 6

"Default AutoTemplate” file 7, 42

"Default AutoTemplate Selection” dialog

box 9

"Define bullets" dialog box 52

*Define formats...“ command 55

"Define masters" command 27

"Define masters" dialog box 27

“Define outline styles for selected levels”

dialog box 71

"Define text formats* dialogbox 55

Delay between slides in Player files 188

"Delay" popup menus 164

Deleting a heading in the outline 65

DeltaGraph, importing presentations

from 138

Demoting a level in the outline 65

Depth

of organization chart boxes,

modifying 109

of table cells 110

Design. See Presentation design

proofing 38

"Design AutoTemplate" command 44

Designing

AutoTemplates 44

presentations 40-45

Desktop printer, using to proof 35mm

slides 206

Dialog boxes

"Add org chart placeholder” 108

"Adjust graphics* 26, 30, 36, 45,

179, 203

“Adjust Photo CD image" = 136

"Align objects” 89

“Anchor content to placeholder“ 59

"Autoanimate” 161

"Autojump" 162

autolayer 159

“AutoTemplate selection...“ 9

“Choose master elements” 32, 138

“Convert sound” 168

“Create show list" 196

“Custom line size" 84

“Default AutoTemplate Selection® 9

“Define bullets" 52

“Define masters" 27

“Define outline styles for selected

levels” 71

“Define text formats” 55

"Edit colors” 122, 124

“Export” 141, 187, 208

import 99, 112, 139

"ImporttCD"” 136

"Import movie” 172

"Install Files" 9

“Interchange master selection” 152

“Layer delay" 164

“Default AutoTemplate Selection” 9

“Movie information” 171

“New background" 34-35, 37

new chart 17, 95

“New slide master“ 33-35, 37, 109

open 15, 41
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"Page setup" 179, 205 "Edit colors" dialog box 122, 124

“Paste special" 145 “Edit sound..." option 169

“Personalization” 9 Editing

“Presentation setup" OLE-embedded objects 144

41, 45, 179, 205 presentations using the slide

Print 201, 207, 209 sorter 38

“Publisher to" 148 text formats 55

saveas 10, 179 text in the outline 62

“Select options to be installed" 9 Edition file

"Set slide background fill" 34 breaking the link with the

"Settings" 189 subscriber 148

"Slide show" 178, 186 opening application of 147

"Spelling” 61 publishing 146

"Subscriber to" 148 saving 147

“Table format” 110 subscribing to 146

"Text autolayer"” 158 to import chart data 98

"Text format” 113 "Editions" command 99, 147

"Transitions" 164, 166, 169 Effects, multimedia, playing 180

Dictionary Ellipse tool 81

spelling, replacing when upgrading 6 using to draw shapes with variable line

user! 61 widths 84

Dimensions, specifying custom 203 Emphasizing information

Display options using animation 160

for Player files 188 using autojumps 162

Distributing objects 88, 92 using color 120

Drawing using highlighting 158

apolygon 82 using multimedia effects 3

adding points 82 using QuickTime movies 170

constraining shapes when = 81 using slide layers 156

shapes from the center 81 using sound effects 164, 166

shapes with variable line widths 84 Endcaps

tools for 81 tools for editing 83

Drawing programs, importing graphics transferring between platforms 150

from 136 Entering

“Duplicate" command = 85 chart data 96

Duplicating text inthe outline 16, 64

an object to create a pattern 85 EPS graphics

graphics 85 displaying on-screen 78

text 85 importing 78, 135, 137

proofing 206

E transferring between platforms 150

, Eraser annotation tool 194-195

Earlier versions of Persuasion Exiting slide shows 186

removing 6 Expanding outlines 70
upgrading from 6
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"Export" dialog

box 141-143, 187, 208

Export file

creating 208

"Export..." command 141, 187, 208

Exporting

a slide show as a Player

file 184, 187, 197

advantages of 135

note pages 143

outlines 141

PICT images 208

Scrapbook images 208

slides 134, 142

Extensions, turning off when

installing 4

Eyedropper toolin Aldus Chart 102

Features, new for Persuasion 3.0 2

File extensions for Windows Player files

-ppf 187, 190

psl 196

File formats

conversion examples 78

EPS 78

for importing outline text 62

for Player files 187

OLE-linked 78

PhotoCD 78

PICT 78

File-compression software 204

Files

converting from earlier versions

of Persuasion 10

Player, creating 187

saving 3.0 files as earlier versions 11

sending to film recorder

by creating an export file 208

directly 208

transferring between Macintosh and

Windows 150

“Fill background” command on color

palette 121



Fill button on color palette 90

Fill patterns, printing 204

Fills

applying to objects 121

background, assigning 34

copying between chart objects 103

gradient, applying to chart

objects 105

Film recorder

listing inthe Chooser 15

required slide dimensions for 204

sending files to

by creating an export file 208

directly 208

specifying device in Chooser 205

using to make 35mm slides 204

"First sound effect® command 39, 157

"First visual effect" command 39, 69

Flow of text, changing direction of 58

Font size, selecting from text palette 50

Font popup menus 51

Fonts

proofing for 35mm slides 206

selecting from text palette 50

transferring between platforms 150

Foot (unit) marks, displaying 51

Footnotes in charts, specifying 96

“Format outline...“ command 71

Formats

converting between 203

text, defining 54-55

Formatting

charts 100

note master 74

outlines for printing and viewing 71

presentations 40-45

slides 28

text 50

attributes retained when

importing 140

Frame, QuickTime movie 171

Frame sequences of QuickTime movies,

changing 176

Freeform shape, reshaping 82

Freeform tool 81

using to draw shapes with variable line

widths 84

Full-screen display of Player files 188

G

"Gallery..." command 26

Gradient fills, applying to chart

objects 105

“GradLn35* AutoTemplate 42

“GradLnOH” AutoTemplate 42

"GradLnSC* AutoTemplate 42

Graph. See Aldus Chart

Graphics

adding toaslide 17

adding tocharts 104

animating 160

arcs = 82

assigning to a slide layer 157

choosinga file format 78

converting to Persuasion format 79

creating in Persuasion 81

duplicating 85

EPS 78

proofing 206

transferring between platforms 150

file formats for importing 78

freeform 82

grouping 86

importing 78, 136

color issues 124

repositioning 137

resizing 137

modifying

complex 86

imported 78

moving

imported 78

several 86

offsetting 85

OLE-embedded 144

OLE-linked 78

Photo CDimages 78, 136

PICT 78

proofing 206

transferring between platforms 151

polygons 82

proofing

on 35mm slides 206

using a desktop printer 206

resizing

imported 78

several 86

subscribing to 135

Windows Metafile 78, 151

working with several atonce 86

"Graphics..." command 17

Graphing tool. See Chart tool

Graphs, creating. See also Aldus Chart

Grayscale color system 129

Grid lines 92

Group command = 86

Grouping objects 86

Guides 92

"Guides“ command 34

Handout master 72

defining contents 76

“Handout master® command 76

Handouts

creating 76

print options 202

printing 76

Handouts print option 76

Hardware

needed torun Persuasion3.0 4

needed torun the Player 184

Heading icon in outline 66

Headings

indicating when importing text 140

moving inthe outline 66-67

selecting inthe outline 67

Hidden graphics 86

“Hide big PICTs” command 78

Hiding slide layers 156

INDEX 221



Hierarchy, creating in organization

charts 108

Highlighting layered

information 158-159

HLS color model 124

Hotspot

for autojumping 162

recognizing position of 162

HSV color model 124

Images, Photo CD

importing 137

previewing 137

“Import* command = 17, 139-

140, 168, 173

“Import data..." command 99

import dialog box 99, 112, 139

“Import movie“ dialog box 172

“Import text..." command 112

Importing

advantages of 135

data from other applications into

charts 98, 112

EPS graphics 78, 137

from other applications 134

graphics 78, 136

into Aldus Chart 104

repositioning 137

resizing 137

ungrouping 78

outlines 62

Photo CD images 136

PICT graphics 136

PICTIl graphics §=136

presentations 138

QuickTime movies 172

slide masters 30

text 48, 140

WMF graphics 136

Inch marks, displaying 51

indent levels, bullet options 52

Independent text 48
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"Install Files" dialog box 9

Installation options

basic 8

complete 8

custom 8

Installer/Utility, Aldus. See Aldus

Installer/Utility

installing

AutoTemplates 9, 40

Persuasion 3.0 4, 8

preparations for 4

interchange format

saving filesin 150

for Macintosh to Windows

transfer 152

"Interchange master selection” dialog

box 152

Inverse grayscale color system 129

J

Jumping automatically

between Player files 196

specifying destinations 162

to other applications 163

to Player presentations 163

toslides 163

Jumps. See Jumping automatically

"Key caps“ command 52

Keyboard shortcuts 212-214

for on-screen presentations 181

for running Player presentations 192

Layer assignments. See Slide layers

"Layer delay” dialog box 164

"Layer" list box 167

Layermenu 157

Layering slides 156-159

Layers. See Slide layers

Layout grid, using 92

Leading options on text palette’ 51

Levels, in organization charts,

changing 108

Lighting, how it affects color

display 132

Line button on color palette 90

Line ends, modifying 83

Line palette 83

Line spacing, specifying 50

“Line spacing...“ command 50

Line tool 81

Line weights, modifying 83-84

Lines

adjusting when transferring between

platforms 151

modifying in tables 114

tools for editing 83

"Link/No Link/Unlink" command. See

Charts, importing data

Looping a slide show 178

Macintosh

files, transferring to Windows 150

running Playeron 184, 193

Magnification tool 81

Magnifying glass tool. See Magnification

tool

Manual slide advance 178

in Player presentations 186

Margins, of tables 114

Marker annotation tool 194-195

Master. See Slide masters

Master slides. See Slide masters

Master title. See Title placeholder

Master Title object. See Title placeholder

Masters

Handout 72

Note 72

Media

and presentation design 15

selecting 9, 15



Memory (RAM)

needed to run Persuasion 3.0 4

needed to run Player files 184

recommended for running QuickTime

movies 170

Menu bar

displaying and hiding in an on-screen

presentation 181

inthe Player 192

using for navigation in an on-screen

presentation 180

“Merge" command = 115

Merging table cells 115

Microsoft PowerPoint, importing

presentations from 138

Microsoft Word, publishing a slide

in 146

Misspelled words, correcting 61

Modeling a slide master after another

slide 32

Modifying

AutoTemplates 45

default 43

chart components 102

complex graphics 86

like objects 86

line weights 84-86

organization charts 106

placeholders on slide masters 29

Monitors

changing slide size to match 179

displaying Player fileson 188

needed to run Player files 184

showing on-screen presentations on

different sizes 178

specifying dimensions of 178

using two to present a Player

presentation 188

variations in how they display color 132

MooV file format 170

Movie formats, considerations using

Player 184

Movie frames

movies

171. See also QuickTime

"Movie info..." command 174

“Movie information” dialog

box 171, 174

Movies. See QuickTime movies

“Movies” command 173

Moving

headings in the outline

multiple graphics 86

objects on and off slides 161

objects on slides 36

things in and out of a

presentation 134-153

Multicolumn text 60

Multimedia effects, playing 3, 180

Multisided shapes, creating 82

66, 174

Navigating

in a Persuasion on-screen

presentation 180

in Player 190-193

through a presentation 180

Nesting slides under an overview

slide 68

"New background" dialog box

New chart dialog box 17, 95

New features for Persuasion 3.0 2-3

New slide button 16

"New slide master” dialog

box 33-34, 37, 95, 109

"No Link/Link/Unlink" command. See

Charts, importing data

“No-fill” swatch on color palette 90

Nonprinting guides, rulers, and grid

lines 92

Note master 72

formatting 74

“Note master“ command 74

Notes

adding textto 74

34, 37

creating 74

exporting 143

printing 202

NTSC color system 129

Nudge palette 25, 88, 91

Oo

Object linking and embedding. See OLE

Object shadows, transferring between

platforms 150

Objects

adding color 120

aligning 32, 88

animating 161

applying a fillto 120

assigning to slide layers 156

distributing 88

grouping 86

highlighting 158

in charts applying gradient fills to 105

modifying similar 86

moving on and off slides 161

moving on slides. See * Adjust graphics“

dialog box

OLE-embedding 144

OLE-linked 78

positioning relative to each other 88

scaling

onslides 36

to fit new slide shape 31

selecting within a stack 87

Stacking 86

Offset between graphics 85

OLE (object linking and

embedding) 144

OLE badge popup menu —s-:1144

OLE badges

forcharts 101

fortables 111

OLE-embedded objects

creating 144

editing 144

OLE-embedding 144

advantages of 135

an existing object 145

charts in Persuasion 94

when creating an object 145
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OLE-linked graphics 78

converting to Persuasion format 79

OLE-linking between Aldus Table and

Persuasion 110

On-screen presentations

converting to 35mm slides 203

designing AutoTemplates for 44

preparing 178

presenting using the Player 190-192

previewing 19

printing badges for 201

running 180

Open dialog box 15, 41

“Open presentation...*

button 15, 41, 43

Opening

Aldus Chart 94

Aldus Table 111

AutoTemplates 41

Persuasion 15

Operating system

needed to run Persuasion 4

needed to run QuickTime video

movies 170

needed to run the Player 184

Options for printing 200

"Org chart“ command 107

Organization chart

placeholders 106

slide masters 106

creating 109

Organization charts 106-109

adding to AutoTemplates 107

creating 106-107

customizing 108

highlighting 158

inoutline 106

levels of 106

modifying 106-107

placeholders 28

resizing 108

transferring between platforms 150

ungrouping 106
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Organization of a presentation,

proofing 19

Orientation

of backgrounds 26, 36

of slide masters 26

of slides 36

Other applications. See Applications

Outline 62-71

adding notesto 62, 73

adjustments when transferring between

platforms 151

assigning slide masters in 69

assigning transitions in 69

collapsing 62, 70

editing 62, 66

entering text 64

expanding 70

exporting 141

formatting for printing and

viewing 71

headings, moving 65-66

importing 62

importing text 140

moving textin 65-67

organization charts in 106

printing 201

rearranging information 66-67

selecting partsof 67

using ashandouts 72

using to enter text 16

viewing 62, 65

Output

35mm slides 135, 204

designing AutoTemplates for 44

Player presentations 135

slides

for use in another application 135

to PostScript devices

importing graphics when

using 78, 136

Output device

changing 203

selecting 15

selecting color system for

selecting file format for

Oval tool. See Ellipse tool

Overhead transparencies

color 202

converting to 35mm slides

129

78

203

designing AutoTemplates for 44

printing 202

Overlapping graphics, changing the

Stacking order 87

Overview slide

creating 68

nesting slides under

Package movies

P

68

for an on-screen presentation 178

187, 193

Page number placeholders

“Page setup" dialog box

“Page setup..." command

for Player files

45, 179, 205

28

179, 205

PageMaker, publishing a slide in 146

Paint programs, importing graphics

from 136

PAL color system

Palettes

3dview 104

129

color. See Color palette

in Aldus Table

table 114

text 113

line 84

nudge 25, 88,91

SFX 104

special effects

text 50-51

104

Paragraph alignment

Paragraph anchoring

Paragraph spacing, setting using text

palette 51

Parts of a slide 25

51

58



Paste. See Copy and paste

“Paste special” dialog box 145

“Paste special..." command 94, 145

Pasting QuickTime movies 173

Patterns

adding to objects 120

applying color to background 120

applying color to foreground 120

creating by duplicating objects 85

Pausing

in an on-screen presentation 180

in Player presentations 191

“Personalization” dialog box 9

Perspective

changing in 3d charts 105

Persuasion

drawing in 80

hardware and software

requirements 4

installing 8-9

moving things in and out of

new features for release 3.0 2-3

opening 15

printing in 200-208

saving 3.0 files as earlier versions = 11

Starting 15

Startup screen 42

ungrouping imported graphics 78

upgrading 6

using colorin 118-132

working with imported graphics 78

Persuasion Player 184-197

definition 184

keyboard shortcuts 192

navigatingin 190-192

presentation, running 190-193

slide show speed, setting 189

"Persuasion Prefs” file 7

Persuasion startup screen 42

Persuasion support folder 42

user dictionary 61

Photo CD images

adjusting depthof 136

adjusting resolution of 136

134-153

importing 78, 136

rotating 136

viewing 137

PICT graphics 78, 136

and OLE-embedding 144

converting to Persuasion format 79

importing 135, 137

proofing 206

transferring between platforms

150-153

PICT Ilgraphics 78

importing 136

"Pictures" command 104

"Placeholder prompt text" 95

Placeholder prompt text 16, 28

Placeholders

adding to slide masters 28

adjustments when transferring between

platforms 151

anchors on, changing

animating 160

assigning to slide masters

body text 28

making tablesin 60

changing

colorof 29

text attributes 29

chart 28, 95

copying 29

entering textin 48-49

highlighting 158

on handout master 73

onnote master 73

on slide masters

adding text to

modifying 29

organization chart 106

overriding style with text formats 54

page number 28

repositioning 29

58-59

29, 35

28, 49

resizing 29

text 49

title 28

using to format slides 28

Platforms, transferring

between 3, 150-153

"Play" (movie) command 174

Play sequence, of sounds

editing 169

Playbar, for QuickTime movies 175

Player. See Persuasion Player

Player files

annotating 194

changing settings for 188

creating 186

definition 186

file formatfor 187

jumping to automatically

naming 187

previewing 186, 188

running 190-193

running multiple 196

setting the speed of 189

setting up jumpsto 197

settings forrunning 186

testing 188

Player presentations

controlling the speed of 189

162, 196

pausingin 186, 191

preparing 190-193

restarting 186

running 190-193

on two monitors 188

Point size option on text palette 51

Pointer tool 81

Points on graphics 82

Polygon

creating 82

reshaping 82

tool 81

using to draw shapes with variable line

widths 84

Portable presentations

Portrait slides 34, 36

Positioning objects

relative toone another 88

using alayout grid 92

184-197

INDEX 225



Poster frame

for QuickTime movies

designating 174

setting 175

PostScript file, creating 208

PostScript file format. See Encapsulated

PostScript file format

PostScript interpreters 208

PostScript slide output 204

PowerBook, setting up Player files

for 188

PowerPoint. See Microsoft PowerPoint

PowerPoint viewer. See Persuasion Player

ppf fileextension 187, 190

PrecisionColor Calibrator 132

“Preferences...” command 78

Preparing 35mm slides 204-208

Presentation agenda, showing on an

overview slide 68

Presentation design

proofing 18

relative to output device 15

"Presentation setup” dialog

box 15,41, 45, 179, 205

Presentations

adding speaker notes 72

changing slide masters 27

converting to 35mm format 203

created using the Player 184-197

creating an edition file from 148

creating efficiently 24

creating supplemental material for 72

designing 40-45

editing using the slide sorter 38

formatting 40-45

importing from other applications

138

moving to Persuasion from other

applications 135

navigating through + = 180

portable 184-197

previewing 178

as Player files 186

printing 200-208

“
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publishing 147

running on-screen 180

save reminder 18

saving 18

as anAutoTemplate 41

settingup 15

slide 26-28

steps in developing

transferring

from Macintosh to Windows 152

from Windows to Macintosh 153

“Preview current slide" command

159, 161

Previewing

an on-screen presentation 19

special effects 178

Previewing QuickTime movies 174

Print dialog box 201, 207, 209

"Print..." command 207, 209

Printers

black-and-white

using to print overheads 202

using to proof graphics 207

color

for overheads 202

desktop

using to proof 35mm stides 206

using to proof graphics 206

selecting using the Chooser 205

Printing 200-208

35mm slides 208

a PostScript file 209

badges 201

cover pages for an outline 201

fill patterns 204

handouts 76

notes 202

overheads 202

overview 200

presentation title on outline

pages 201

slides with background fills 201

test slides 206

14-18

thumbnails on handouts § 76

transparencies 202

Processor

needed to run Persuasion 4

needed to run QuickTime video

movies 170

needed torun the Player 184

Progressive disclosure slide. See Layering

slides; “Autolayer..." command;

Highlighting layered information

Promoting a text level on the outline

Prompt text 49

in placeholders 26

Proof print 129

Proofing

35mm slides 205

color 206

fonts 206

graphics 206

ona desktop printer 206

text 206

design 38

organization 19

presentation 18

presentation content 19

text flow 206

using test slides 206

using the slide sorter 38

psl file extension 196

Publish and Subscribe in Aldus

Chart 98

“Publish" command 147

“Publisher to” dialog box 148

Publishing

aslide 149

to other applications

advantages of 135

Publishing file 146

134, 146

65



Q

QuickTime movie badge

menu commands 171

QuickTime movies 170-177

advancing 175

changing frame sequences of 176

controls, turning on and off 174

copying 173

editing 174

frames 191

importing 172

in Player files 186, 190-197

packaging 187

partsof 171

pasting 173

playbar 175

turning on and off 174

poster frame for, setting 175

previewing 174

recommended configuration for 170

selecting a sequence to create a new

movie 177

sequence of play 170

sequences, removing 177

sound-only 168

displaying on a different

computer 178

transferring between platforms 150

using to preview Photo CD

images 137

Quitting a slideshow 186, 192

Radius PrecisionColor Calibrator 132

RasterOps Calibrator 132

"Re-create from slide..." command 33

Re-orienting slides 36

Rearranging slides using the slide

sorter 38

Rectangle tool. See Square-corner tool

“Redraw” command 101

“Regroup" command 86

Rehearsing a slideshow 178

Removing

backgrounds 27

earlier versions of Persuasion 6

slide masters 27

Renaming

backgrounds 27

slide masters 27

Repetitive patterns, creating 85

Replacing

color schemes 126

color systems 130

default AutoTemplates 43

one slide master 31

slide masters 30

Replacing color system edits"

command 130

Repositioning

imported graphics 137

placeholders 29

“Reshape” command 82

Resizing

charts 100

imported graphics 137

placeholders 29

text in charts 103

Resolution, of 35mm slides 204

Restarting

Player presentations 186

“Restore original size" command 174

Reversing data series or groups 101

RGB color model 124

"Roil credits" animation 161

Rounded-corner tool 81

Row margins in tables 115

Rows, incharts 96

Rule tool 81

using to draw shapes with variable line

widths 84

Ruler on text placeholders. See Text ruler

"Ruler units" command 92

Rulers 92

Rules 83

"Run Show" command. See "Slide

show” command

Running

an on-screen presentation 180

multiple Player files 196

Player presentations 188, 190-193

Running an on-screen presentation 180

Save as dialog box 11, 179

"Save Reminder" command 18

Saving

apresentation 18

files for 35mm output 204

presentations as AutoTemplates 41

Scaling

object text when converting presenta-

tions 203

objects on slides 36

to fit newslide shapes 31

when changing slide orientation 36

Scanned images, importing 136

Scans, adding to charts 104

Scrapbook format, importing presenta-

tionsin 138

Screen display for Player files 188

"Select all" command 86

“Select options to be installed”

dialog box 9

Selecting like objects 86

Selection tool. See Pointer tool

"Send" command 87

Sequence, movie frame. See QuickTime

movies

Serial number

finding and recording 4

when upgrading 6

Service provider

slide 204

using to produce 35mm slides 205

“Set layer" command = 157

Set name..." command 174

"Set poster frame" command

“Set slide background fill” dialog

box 34

174-175

INDEX 227



"Settings" dialog box 189

SFX palette 102-105

Shadow button on color palette 90

Shadow offset, changing 91

"Shadow offset..." command 91

Shadows

applying toa text block 91

applying to an object 90

applying to text 91

changing offsetof 91

moving 91

tools for 90

transferring between platforms 150

Sharing information with other applica-

tions 135

Shortcuts, keyboard 212-214

for on-screen presentations 181

“Show all slides..." command 187

“Show guides" command 34

Show notes icon 75

“Show playbar” command 174-176

“Show poster frame" command 174

Show-list file, creating 196

Sketches, adding to Player files 195

Slide advance options in Player 186

"Slide background fill...“ command 35

Slide dimensions

changing 36

for film recorders 204

Slide divider icon, in outline 64

“Slide Draw Delay..." command. See

Slide layers; Transition effects; “Slide

show" command

Slide layers

applying transition effectsto 165

assigning graphics to 157

assigning textto 157

displaying all 181

displaying texton 158

exporting 187

hiding 156

highlighting informationon 158

how touse 156-159

jumping to automatically 162
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moving between in Player 191

removing in Player files 187

setting sound transition effects

for 167

transition effects for

"Slide master" command

34, 37, 95

156, 164, 166

26, 33-

Slide masters

adding 30

one 31

placeholders to 29

adjustments when transferring between

platforms = 151

assigning 39

backgroundsto 22, 26, 35

placeholders to 28, 35

assigning in the outline 62

chart 26

creating 95

creating

acopyof 34

fromaslide 30-33

from scratch 34

importing from other

presentations 30

modeling froma slide 32

modifying 26, 34

new

assigning toaslide 27

creating 34-35

displaying 26

new, assigning toaslide 69

organization chart 106, 109

removing 27

renaming 27

replacing 30

one 31

text 26

formatting 50

title 26

using to create aslide 32

Slide order, proofing 18

Slide presentations 24-28

created using Player 184-197

Slide service bureaus 204

Aldus Authorized 204

preparing files for 204-208

requirements of 204

Slide shapes

and output devices 44

converting 203

Slide show

ending 178

exiting 181

"Slide show" command

161, 165, 187

"Slide show" dialog box 178, 186

"Slide show" file, used to preview Photo

CDimages 137

Slide show file format

for Player files 187

Slide show mode

Automatic 178

Manual 178

Slide sorter

assigning slide masters in 31

copying slidesin 31

using to edit presentations 38

“Slide sorter" command 31

Slide thumbnails

onhandouts 72, 76

on speakernotes 72

Slide titles, viewing in outline 62

Slides

adding chartsto 17, 94

adding graphics to 17

adding toapresentation 16

applying transition effects to 165

assigning backgrounds to 26

composition of 22

copying from another

presentation 39

entering text 16, 48

exporting 142

formatting 28

importing textto 140

jumping between automatically

layering 156-159

162



names of slide elements 24

nesting under an overview slide 68

partsof 25

printing with background fills 201

publishing 146

rearranging using the slide sorter 38

setting sound transition effects

for 167

size, changing 179

text 50

transition effects for 164, 166

using to create a slide master 32

viewing using slide sorter 38

"Snap to Grid“ command 92

Software, requirements for

Persuasion3.0 4

"Sound effect" popup menu —- 167

"Sound on" command = 174

Sounds

adding to slide presentations 164

importing from other

applications 135

play sequence, editing 169

transferring between platforms 150

"Sounds..." command 168

Space-separated (Ssv) data format 98

Speaker notes

adding to outline 62

creating 74

Special characters 52

Special effects

incharts 104

in Player presentations 186

previewing 178

Special effects palette 104

Speed of Player presentations 189

Spell checker. See “Spelling...“ command

"Spelling" dialog box 61

Spelling dictionaries, replacing when

upgrading 6

"Spelling..." command 61

Spreadsheets, subscribing to in

Persuasion 135

Square, drawing 81

Square-corner tool

using to draw shapes with variable line

widths 84

Ssv format 98

Stacked objects

changing stacking order of 87

selecting 87

Stacking ungrouped objects 86

Stand-alone show. See Persuasion Player

Standard color system 129

Starting an on-screen presentation 180

Startup screen 15, 42

Stopping a presentation 180

Storyboard, creating using Handout

master 76

Stylesheets. See Text formats

“Subscribe to..." command 99, 147

“Subscriber to" dialog box 148

Subscribing

toanedittion 98, 147

to files from other

applications 135, 146

advantages of 135

Subscribing file 146

updating 149

Subselecting an object in a complex

graphic 86

Subtitles, adding to slides 62, 64

Supplemental material, creating 72

Support folder 7

Symbols, changing color of 53

System 7.0 sounds 168

Systems, color. See Color systems

Tab-separated (Tsv) data format 98

Table badge 111

Table columns

aligning using the text ruler 60

"Table format" dialog box 110

“Table format..." command 111

Table palette 114

Table tool 111

Tables 110-114

applying colorto 114

borders, changing 114

bringing in from other

applications 112

converting from earlier versions of

Persuasion 10

creating 111

onslides 60

dimensions of 110

features 3

importing data. 112

lines, modifying 114

margins, changing 114

merging cells 115

partsof 110

sizing 110

text in, modifying 113

Tabs on text ruler, using to create

tables 60

Tall slides, creating 36

Templates. See also AutoTemplates;

Masters

Test slides, using to proof 35mm slides

206

Testing Player files on-site 188

Text

addingtoaslide 16, 48

adding tonote pages 74

adding to placeholders on slide

masters 28

adjusting for new slide dimensions 34

aligning 51

animating 160

applying colorto 121

assigning slide layersto 156

assigning toa slide layer 157

editing in the outline 62

entering

in placeholders 48-49

inthe outline 16, 48, 64

outside placeholders 48-49

format for importing 140

formatting 48, 50, 55
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highlighting and dimming 158

importing 140

tooutline 140

in charts

modifying 102

resizing 103

in tables, modifying 113

independent 48

multicolumn 60

placeholder prompt text 49

proofing

on 35mm slides 206

special characters 52

Text attributes

defining using placeholders 28

“Text autolayer“ dialog box 158

Text blocks

applying colorto 121

assigning attributes 54

highlighting 158

manipulating 48

Text button on color palette 90

Text files, importing as tables 112

Text flow

controlling direction using anchor

points 58-59

proofing for 35mm slides 206

"Text format" dialog box 113

"Text format..." command 113

Text formats

applying 55

defining 54-55

editing 55

using on several slide masters 54

Text justification 51

Text page. See Outline

Text palette 51

in Aldus Chart 102, 113

Text placeholders. See Body text

placeholders

Text ruler 49

hiding 49

on text placeholders 49

using tabs to create text columns 60
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Texttool 81

Thumbnails

onhandouts 72

onspeakernotes 72

printing onhandouts 76

viewing 26

TIFF graphics, transferring between

Macintosh and Windows = 151

Timing of Player presentations 189

Title object. See Title placeholder

Title placeholders 28

Titles

in charts, specifying 96

onslides 26

Tool palette 25

Tools

chart 102

drawing 81

arc 81

ellipse 81

freeform 81

line 81

pointer 81

polygon 81

rounded-corner 81

square-corner 81

for applying shadows 30

for editing lines and endcaps 83

for working in Aldus Chart 102-103

magnification 81

pointer 81

table 111

text 81

Tool palette 144

Transferring between platforms

adjustments in presentations 150-153

Macintosh to Windows 151-153

methods 135

Windows to Macintosh 151, 153

Transition effects

assigning inthe outline 62

assigning in the slide sorter 39

for slides and slide layers 156,

164-166

sound

applying to slides and slide layers

167-168

transferring between platforms 150

Transitions

assigning in the outline 69

"Transitions" dialog box 169

for sound effects 166-169

for visual effects 164

"Transitions..." command 165, 169

Transparencies

printing 202

Tsv data format 98

Type styles options on text palette 51

Typographer's quotes 51

U

"Ungroup" command 79

Ungrouping

imported graphics 78

organization charts 106

"“Unlink/Link/No Link" command. See

Charts, importing data

Updating the subscriber 149

Upgrading to Persuasion 3.0 4, 6

“Use typographer's quotes"

command 51

User dictionary (user1) 61

User1 user dictionary 61

Vv

Variable line weights 84

Version, of Persuasion

converting from 3.0 to earlier 11

converting from earlier to3.0 10

Vertical information, displaying using tall

slides 36

Video display, of QuickTime movies

turning on and off =174

Video movies. See QuickTime movies

"Video on” command 174

wyeee



Viewing

only slide titles 62

Slides in the slide sorter 31

thumbnails 26, 31

Viewing angle of 3d charts,

changing 105

Virus-protection utilities, turning off when

installing 4

Visual effect menu 164-166

Visual effects 164

Volume, of QuickTime movies,

controlling 175

Ww

Wide slide orientation 26, 36

Width

of organization chart boxes,

modifying 109

of table cells 110

of table lines, changing 115

Window display of Player files 188

Windows

files, transferring to Macintosh 150

running Playerin 184, 193

Windows Metafile file format 78

WMF graphics

importing 137

Word-processing files

exporting elements to 141

importing to the outline 62, 135

sharing information with 135

Working palette. See Working set

Working set

adding colors to

from the color scheme 122

from the color spectrum =: 122

creating 122

renaming colorson 122

when touse 119

Working with imported graphics 78

Zero point on layout grid 92

Zoom in/out buttons. See Magnification

tool

Zooming 81

Zz
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